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1. About Avizo and this Tutorial

1.1. Introduction

The 3D data visualization software Amira was developed primarily for the
visualization of medical, chemical or biological data. A typical application: on the
basis of computer tomography data, physicians can interactively extract and render
3D representations of skin, bones or tumors.

In order to better deal with application field specific requirements, the system was
later divided into two branches: a life sciences product line, Amira, and a line more
focused on physical sciences and industrial applications called Avizo.

Starting in 2007, Avizo was extended for applications in earth sciences — initiated and
coordinated by the German Climate Computing Centre (DKRZ). As a result, an
extension package called Avizo (Climatology Profile) (or formerly Avizo XGreen,
Amira Climate Viz) is now available for the visualization of observed or simulated
data in meteorology, oceanography or other earth system sciences. Among other
new features, the Green edition includes the capability to directly read NetCDF CF
data files and interactively visualize the data - with different map projections, using
different visualization methods and, in combination with the geographic context, the
earth topography and texture or continent outlines.

1.2. Contents of this Document

This document specifically describes the different visualization tools useful for time-
dependent gridded climate model or satellite data available within the Avizo Climate
Profile (formerly XGreen extension).

You can also find a short version of this tutorial in the Avizo help section.

In contrast to the tutorial document available within the £
software, this document is completely updated and R
extended by Several Chapters: Modules | Porls | FiloFormats | DataTypes | Ediors | Tulorlals | Examples

e asection about data pre-processing with cdo and\ '

reading metadata with ncdump (chapter 2.2),

e a section about 3D vector field visualization
(chapter 6)

e a section about producing mpegl films from your
animations including camera paths (chapters 7).

e It also works with datasets with more time stepsin | S e
order to produce more interesting animations. % e
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1.3. Tutorial Data and other Prerequisites

Registered users of the DKRZ high performance computing system Mistral will find
all tutorial data files and example projects in the folder:

/work/kv0653/Tutorial_AvizoGreen/

All atmosphere data sets used in the tutorial were acquired through the World Data
Center for Climate (WDCC) Database. Please bear in mind that these data may be
used freely for research only. Commercial use of the data is not allowed. Detailed
information on the terms of use of the World Data Center for Climate (WDCC) data
can be found at:

e http://cera-www.dkrz.de/WDCC/ui/docs/TermsOfUse.html

Additionally, some Atlantic Ocean datasets from MIT General Circulation Model runs
performed by Prof. Detlef Stammer and Dr. Nuno Serra (Institute of Oceanography,
University of Hamburg) are included. We thank Prof. Stammer for his authorization to
use these data in this tutorial. Of course, commercial use is not allowed either. You
can find further information on this ocean circulation model at:

e http://mitgcm.org/

Unlike with many other visualization applications, Avizo - as well as all other
interactive 3D-Applications based on OpenGL - needs a 3D-graphics card on the
system where the application is started. For DKRZ users, the visualization nodes of
Mistral are available to use Avizo virtually on your own workstation. This is
accomplished by means of Remote-3D-Rendering (in our case with VirtualGL and
TurboVNC, see http://www.virtualgl.org/ ), a technique where the rendered content of
the 3D window is continuously read back from the graphics card and sent to the
client workstation.

More detailed information on the DKRZ visualization server on Mistral can be found
here:

e http://www.dkrz.de/Klimarechner-en/visualisierungsserver
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2. Data Input and Pre-Processing

2.1. NetCDF file format and related software

One of the most important features of Avizo’s Climatology Profile is the NetCDF
reader module, which allows for direct work with gridded simulation data stored in the
NetCDF file format, or, more specifically, NetCDF files which follow the NetCDF CF-
1.0 metadata convention (“Climate Forecast”). Detailed information on NetCDF and
the NetCDF library can be found at:

e http://www.unidata.ucar.edu/software/netcdf/index.html

Other file formats used by the community, such as WMO’s GRIB format, can also be
read by the module, but in this case the data file is first automatically being converted
to NetCDF (and has to be stored on the hard disk), before the data can be visualized.

Avizo uses the publicly available tool “cdo” (“Climate Data Operators”) for this implicit
data conversion. This powerful tool is developed by the Max Planck Institute for
Meteorology with the aim to simplify the processing and analysis of climate model
data. With cdo, you can also convert data from IEG, EXTRA, SERVICE, or HDF5 file
formats into NetCDF. Besides file conversion, cdo offers many other important
features such as regridding, arithmetic, statistics and so on.

Downloads, documentation, and access to the mailing lists of cdo (= Climate Data
Operators) are available at:

e https://code.zmaw.de/projects/cdo

e On DKRZ systems, cdo and NetCDF are available by default. When you work
on other systems, it might be a good idea to install NetCDF and cdo.

There is another set of operators to manipulate NetCDF files which is called NetCDF
Operators (nco). You might find its attribute editor (ncatted -a) especially useful in
some cases. The nco documentation is available at:

e http://nco.sourceforge.net

2.2. NetCDF Metadata with ncdump

The NetCDF metadata convention being used with Avizo is NetCDF CF-1.0 (CF =
Climate Forecast). In order to display NetCDF metadata, you can use ncdump, either
with the -h option, if you only want to explore the header with the dimensions,
variables, and global attributes, or with the -c option, which additionally includes the
grid coordinates:

ncdump -h Ffrlename.nc
ncdump -c Filename.nc
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Questions:

How many and which variables are included in the NetCDF file
ECHAM5_OM_A1B_2001_2D?

How many time steps are covered in ECHAM5 _OM_A1B_2001_2D? Which
time period do they represent exactly?

In which unit is the data of the variable containing the vertically integrated
water vapor of the atmosphere in ECHAM5_OM_A1B_2001_2D?

Which cdo commands were used latest to process or produce
ECHAM5_OM_A1B_2001_2D?

How many vertical levels are available in ECHAM5 _OM_A1B 2001 2D and
ECHAM5 _OM_A1B 2001 3D, respectively?

Answers

2.3.

Data pre-processing with cdo

In order to visualize climate model data with Avizo, you may first have to do some
data processing. In this paragraph we list some cdo commands that we found very
useful with respect to the pre-processing — depending on the climate model type and
area of interest. For more information please refer to the cdo documentation
mentioned above. Detailed examples of NetCDF pre-processing with cdo can be
found in the annex of this tutorial (chapter 8).

NetCDF format: Conversion from IEG, GRIB, or other climate data formats to
the NetCDF file format is done by the -f nc option:

cdo -f nc copy <rnputfile> <outputfile.nc>

Missing values: Missing values are used to mask out grid cells that should
not be visualized, such as grid cells on land in case of ocean model data.
Since Avizo cannot read NaN values (Not a Number), make sure that missing
values are defined differently, e.g., by using a missing value of -9.e+33.

Substitute an old by a new missing value:

cdo setmissval ,miss <inputfile> <outputfile>
Declare a constant as missing value:

cdo setctomiss,c <inputfile> <outputfile>

Relative time: If your NetCDF file was stored with absolute time values ("day
as %Y%m%d.%f"“), you will need to convert it to relative time (e.g. "days since
1989-6-15 12:00“ or “hours since 2001-01-01 0:00”) by using the —r option.
Otherwise, Avizo won't be able to annotate the date and/or time in the viewer
window.

cdo -r copy <inputfile> <outputfile>
Geographic coordinates of global data: Global data in geographic

coordinates with longitudes in the range [0°; 360°] (standard output of the
ECHAM model) should be transformed into the range [-180°; +180°] by using
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the selection operator selindexbox with the following parameters for the
western and eastern longitudes:

lonl (number of longitudes / 2) +1

lon2

number of longitudes / 2

Example for the T63 grid:

cdo selindexbox,97,96,1,96 <inputfile> <outputfile>

Hybrid model levels: For the vertical axis of atmospheric models, Avizo
supports height and pressure levels. If the vertical axis of your data is
described by hybrid model levels (terrain following vertical coordinates at the
bottom, pressure levels at the top, interpolated in between), the data must be
interpolated onto HEIGHT [m] or PRESSURE [Pa] levels before reading it with
Avizo. The number and values of those height or pressure levels can be
defined explicitly (plevels, hlevels). During this process you may receive
missing values (Grid cells with no data), e.g., in areas with mountains in case
of atmospheric data.

cdo mi2pl,plevels <inputfile> <outputfile>

cdo mi2hl ,hlevels <inputfile> <outputfile>

Levels of ocean data: Ocean circulation models like MPI-OM, MITgcm,
GECCO or ECOHAM provide output files with positive levels, which are
understood as “depth in meters” in the oceanographers’ community. However,
Avizo would interpret those levels as heights and would visualize the 3D data
above-ground (in the atmosphere) rather than subsurface (in the ocean).
Therefore, we have to change the sign of all ocean level data from positive to
negative before loading the NetCDF files into Avizo.

cdo setzaxis,zaxis.txt <inputfile> <outputfirle>

Time interpolation for smooth animation: Depending on the type of data
and the time interval the data has been stored with, the spatial patterns and
peak values of some quantities can differ drastically from time step to time
step. In order to achieve a smooth animation, a bilinear interpolation along the
time axis might be useful. In addition, a time interpolation makes sense if your
output variables differ in their time resolution (e.g. particle concentrations in a
1 hour resolution, wind: 6 hourly), but shall be visualized in the same
animation. This can be done by the cdo operators intntime and inttime:

cdo -intntime,n <inputfile> <outputfile>

cdo -inttime,date,time, increment <inputfile> <outputfile>

Special treatment of vector components

Interpolation to scalar grid:
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Often scalar output data is represented by values in the center of the grid
cells, as shown in gray in the figure below, while, in contrast, vector
components are defined on the outer faces of the grid cells. In the example
(Grid of the curvilinear MPI-OM Ocean Model) below, u is defined on the right
face (blue), v on the front face (green) and w on the top face (red).

j-1

® FEAR,
i (D

0 L Os6ib -0

| | 0
O V(ijk) X
&=

j+1

© Scalar Point \

‘ . . U-Point
J © V-Point k+1
k @ W-Point

MPI-OM: Grid definition for scalar and vector quantities

For the representation of vector fields with Avizo, all three vector components
of a grid cell need to be defined at the very same geographic coordinate. If
your data does not fulfill this condition, you may want to interpolate the vector
components onto the “scalar grid” (cell centers). This is imperative for the 2D
display (combination of the horizontal wind components u and v only) as well
as for the 3D display (combination of all wind components u, v and w).

cdo offers several horizontal interpolation methods as well as some generic
descriptions of regular or gaussian grids, which will often be sufficient for
visualization purposes. Bilinear interpolation (remapbil) or distance weighted
interpolation (remapdis) might be a good starting point, but keep in mind what
the chosen method does with your data.

cdo remapbil, <scalarGrid> <inputfile> <outputfile>

For the interpolation of the vertical velocity component to the central point of
your grid cells use the intlevel operator and the vertical coordinates of the
according scalar grid:

cdo intlevel, levels <inputfile> <outputfile>

e Rotation of horizontal velocity u, v:
For all curvilinear (e.g. MPI-OM, MITgcm) and rotated (e.g. REMO, CLM)
model grids, a rotation of the horizontal velocity components has to be applied
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to turn the vectors from the local model grid onto the geographic grid, so that u
gives the zonal component (W-E-direction) and v the meridional component
(S-N-direction) of the velocity vector.

UM PI-OM

Rotation can be done by the cdo commands rotuvb and mrotuvb (the latter is
not yet documented). mrotuvb combines the horizontal interpolation to the
scalar grid with the rotation in one operator.

For REMO:
cdo rotuvb,u,v <inputfile> <outputfile>

where u and v are the vector components located in the inputfile.

For MPI-OM:
cdo mrotuvb <inputfirlel> <inputfirle2> <outputfile>

where the inputfiles should each contain only one variable — with the first
vector component variable in inputfilel and the second in inputfile2 (on two
different grids).

e Units of vertical velocity w: If the vertical wind velocity component of the
atmospheric model is only available as the pressure change per time in Pa/s
(ECHAMS: variable “vertical velocity” omega, code 135), it is essential to
compute the vertical wind speed in m/s in order to obtain the same unit as for
the horizontal wind components. Only on that condition can the three wind
components be combined to a resulting 3D spatial vector. The new cdo
operator vertwind (also not yet documented) can help you do this. In your
inputfile you need the following variables:

code description

130 temperature [K]

133 specific humidity [kg/kg]
134 surface pressure [Pa]
135 vertical velocity [Pa/s]

cdo vertwind <rnputfile> <outputfile>

e Interpolation to rectilinear or regular grid:
For 3D visualization packages like Avizo, it is computationally easier to work
with rectilinear or regular grids compared with curvilinear grids. Additionally,
several Avizo modules do not work with curvilinear grids yet, especially the
vector modules. Therefore, interpolation onto rectilinear or regular grids is

Avizo Green 9.0.1 — Tutorial V2.0 DKRZ / CIiSAP Climate Visualization Lab



12

recommended — especially for vector components.

cdo remapbil, <rectilinearGrid> <inputfile> <outputfile>

See annex chapter 8 for detailed examples of NetCDF pre-processings.
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3. Avizo (Climatology Profile): Getting started

3.1. Avizo’s User Interface

We assume that you have started a VirtualGL/TurboVNC session on one of the
visualization nodes of DKRZ’s high performance computing system Mistral. Open a
Terminal window (right click on the empty desktop background and - Open
Terminal), and load the latest Avizo module by typing module load avizo. For an
overview of all modules currently loaded, type module list. Having loaded the module,
start the most recent version of Avizo (here described: Avizo Version 9.0.1) by typing
avizo in the Terminal window and pressing enter. If you run Avizo for the first time,
you will have to accept the “terms of use”, otherwise the startup screen of Avizo will
open directly. There you can either open data, an existing project or start from
scratch with a blank project. In order to get familiar with Avizo’s GUI and to get in
touch with the 3D navigation in the viewer window, we start by loading an existing
example project.

Before you can get started with visualizing climate data for the first time you need to
enable the Climatology profile. To do this, select Blank Project on the startup screen.
In the Avizo GUI, navigate to the main toolbar and open Edit — Preferences. In the
General tab, at the top on the right, you'll find the Current profile section. Toggle
Climatology profile and click ok.

e Avizo - Climatology Profile Preferences x
General Layout | Onexit ;. .: LDA.: :. Henderlng-}- Performance | Unm;.: Range Partiioning | Auto Dispiay |

Project modules and data objects Current profile

+| Use 2-pass firing algorithm
V| Auto-select new objecls Default profile

| Deselact previously selected objects
Geophysics profile
Use Legacy Demo Maker

' Draw viewer toggles on icons

' Draw compute indicator

Save Project
Include unused data objects
Inciude window sizes and positions
Include viewer background settings

« Overwrite existing files in auto-save

Policy: ;‘Always ask

Web News

Do not show news

Online Documentation

| Display only available features.

Preferences and Settings

! Restore Defaults... | | Load preferences... | ‘ Save preferences... ‘

| [BlHer |

(@ Climatelogy profile

Maximum number of recent documents

Recent files: [7 -

Recent projects:

Ll
*

! .J,qppw H_agance\ ‘[ @QK l

+ To load an existing project, click on File > Open Project and select the project
called TUT_GettingStarted.hx in the tutorial folder. This will take a few seconds.
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Avizo - Green Edition - TUT_GettingStarted.

B o Project  Create | Miew | Wingow  XPane  XScreen  XTearn | Heg ;
(S openpaa - crvr el mew roject -l - | cie [l Gragn View <[] Wee view | [ e Fanels | 5] Main Fanel -] Properses -[x] Console ] Cotormap <[ Animacen Frogucer. »

D@80 & G- HF & v ) Do 508

Man Fanel

Froject View |}

{openoma]
B Conou Bmsisutacs (oo | e rosd

(CBECHANE O, T TR vl pion

T orawsnyte:  [rages 7] more optons -] Lnewiam [0 B outne coter
¥ coormap: CITEYTI 126038 Ean |

T Culling Mode: & no culing © backface  front face
T thresnola A | CE——|

T options: P compactey I dowr

F mito-refrein

Avizo presents you four areas within one large window:

* Inthe Viewer area (or window) you see a 3D visualization of the relative
humidity as an isosurface (for 90% humidity) from the ECHAMS5/MPI-OM
global model (IPCC-scenario A1B for the year 2001).

= Top left: The Main Panel shows the project with loaded data sets, colormaps,
the Earth, Projection and some visualization modules and their data
connections.

= Bottom left: In the Properties area you can set and vary the parameters of the
module that is currently active in the Main Panel. For example, if you click on
the module Isosurface in the Main Panel, its related properties are displayed in
the Properties area.

= Bottom right: The Console gives feedback from the processes Avizo is
currently performing and can also be used as a command line to interactively
type in TCL-commands. You can switch the console window on and off by
clicking on the Console button in the lower right corner below the viewer or via
the toolbar by selecting Window — Console.

Help information can be found in a separated viewer by
a) typing help in the console,
b) clicking Help = User’s Guide,
c) pressing the F1 button,
d) clicking on the question mark ? of a selected module in the Properties area.
This will lead you to the help page concerning the active module (in the above
figure e.g. help information of the Isosurface module).

D=

The main viewer can be divided into two visualization windows, which are tiled

vertically 5 or horizontally , or could even be divided into four tiles. With
two or four tiled viewers you can either watch your data from different angles or see
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different variables at the same time. Alternatively, you could use the tiles to show
different time steps in parallel. To change the visibility of an object in all viewers by

changing the visibility of an object in one viewer, you can use =.

The icon = provides a full screen mode. In order to finish the full screen mode and
get back to the original layout, you have to do a right-click in the viewer window and
uncheck FullScreen.

3.2. Spatial Navigation

Get familiar with the navigation bar above the viewer. The different glyphs change
between different navigation or interaction modes.

M § - Q2 O a N

+ With the Trackball % active (default value), you may turn the visualization
intuitively and explore the visible objects from all viewing angles. If “Spin
animation” is activated: when pressing the left mouse button, accelerate the
mouse (left button still pressed) a bit and release the button while it still moves,
the objects in view will continuously keep turning. You can easily halt it by clicking
again.

+ With the Translate Tool % activated, you can translate the objects up, down, or
left and right respectively.

+ When you move your mouse downwards with the Zoom tool Q. activated, you
pull the objects to yourself, so that you zoom in. Moving your mouse upwards is
like pushing the figure away which results in zooming out. The Zoom tool does not
react to mouse movements in left or right direction.

+ By clicking the Rotate tool 2 your objects rotate a fixed angle clockwise around
the normal axis of your screen.

+ The Seek tool € allows you to click on a target point in order to tell Avizo to fly to
that point and bring the target into focus.

+ Use the Home tool # to get back to a certain view you had defined earlier with
the Set Home tool.

+ You might use the Set Home tool # to define a certain view you like in order to
quickly come back to it later.

&P w B G

+ You will need the left button (View All) to get an overview of the viewer content if
you are lost during spatial navigation or if nothing is visible anymore.

+ Clicking the third button (XY) provides you a top view of your data.

+ The second (XZ) and fourth button (YZ) provide lateral views.

+ With this button you can switch the virtual camera between orthographic mode
and perspective mode — similar to a telephoto and wide angle lens.
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+ To pick any shape in any shape viewer in order to select the corresponding

module in the Project Viewer use the % button while either the Interact or
Trackball tool is activated.

Up to now you only did spatial navigation through the very first time step of your data
stream. In this case this is the simulated relative humidity for January 15!, 2001 at
0:00 am. In the following chapter, we will spend some time on the temporal
navigation.

3.3. Time Animation

+ In the Main Panel click on the NetCDF-Control module. In the corresponding
Properties, you will find that the NetCDF file contains 1460 time steps (= 365 days
* 4 time steps).

Properties

¥ Info: 1460 titme steps (time range 18628..18992.8)
¥ Mode: g & time step O physical time

X Time: el il [ L B =
$ Animation Rate: i+ afap O delayed (0O msecs

+ Keep the Mode port on time step. The physical time stands for the days since the
reference date and is hardly useful here.

+ Move the Time slider rightwards and watch the evolution in the viewer. With the
“Step forward” button _’I next to the Time slider you can go through the year 2001

step-by-step. By clicking the “Play forward” button L’J you can run the whole
animation. Both buttons are also available for the reverse direction.

+ Right-clicking in the Time slider provides you with a context menu that offers
playing the animation once, playing it in repeat mode (Loop) e.g. for exhibitions or
fairs and even playing it forward and backwards alternately (Swing).

+ Slow the animation down to one time step per 3 seconds by changing the
Animation Rate from afap ("as fast as possible” ©) to 3000 msecs delayed.

3.4. Toggle modules on or off

In the Main Panel, you may have noticed the second ECHAM5-MPI-OM data set in
the project called tsurf (= surface temperature), which is, however, not visualized in
the Viewer. That is because loaded data sets can be activated and deactivated by
pressing their toggles:
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+ In the Main Panel you can activate the data set of the temperature by clicking on
the small gray box for the variable tsurf*. Alternatively, you might click the gray
toggle box in the Slice Properties.

+ As the temperature data are visualized on the same level as the underlying earth,
switch the earth off by clicking on the orange box of the Earth module.

+ You can also switch off or on the orange Bounding Box, the white grid at the back
plane (module Grid Lines) or the Isosurface module.

3.5. Find metadata

Metadata of the whole NetCDF file

+ In the Main Panel, activate the module ECHAM5 OM_A1B_2001_3D.nc and click
on the Data Parameter Editor in the Properties.

" Data Parameter Editor - .'Wl
. Eile . Edit.. Database  Help

meters

col Climate Data Interface version 1.0.8

cDo Climate Data Operators version 1.0.9 avail...
Conventions CF-1.0

Filenarme fworkikw 0653 Tutorial_AvizoGreen/fECHAMS .
LoadCmd load -nc fworkfkv 0653 Tutorial_AvizoGreen. ..
histary Fri Fel 29 11:01:21 2008: cdo merge ECH...
institution Max-Planck-Institute for Meteorology

source ECHAMS.2

Farameters

Apply Cancel | oK |

In the Data Parameter Editor you may find information on the server path of the
NetCDF file (Filename) and — very useful in practice — on the cdo processing
steps applied before (history) in a descending chronological order (from new to
old).

+ Close the Data Parameter Editor with OK.

Metadata of individual variables

+ Activate the variable rhumidity* in the Main Panel window. In the Properties
window you will now find the dimension of the variable, its min and max values
and the underlying grid type.

The grid of the atmospheric data has 192 x 96 x 17 grid points, meaning there are
data for 17 levels. The min value of the current (!) time step is -0.142144, the max
value is 1.26039. The grid is rectilinear.

+ For a comparison click on the variable tsurf* in the Main Panel window. As is
visible in the Properties, this variable consists of the same amount of horizontal
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grid points but is supplied for one vertical level only. Min and max values of the
first time step are 221.787 and 313.941.

Please note that an identical number of grid points along the x and y axis does not
necessarily mean that the two data sets match together. They might cover a
completely different area or differ in the distance between the grid points. Even if they
are identical concerning coverage area and grid sizes, the data values might possibly
stand for the grid cell center or one of the grid cell corners or even erect as vector
components from the grid walls. In our case they actually match spatially, but keep
those problems in mind.

+ In the Properties of tsurf*, click on the Data Parameter Editor button . In the
Data Parameter Editor you will find additional metadata of this variable, e.g. its
long name (“surface temperature”) and its unit (“K” - Kelvin).

W Data Parameter Editor |\x3
Eile .. Edit.. Databaze . Help

Name Value

Farameters
Content 162x96x17 float, rectilinear coordinates
Long_name temperature
Units K

=

Close the Data Parameter Editor with OK.

Have a look at the Global data window port in the Properties window. As min and
max values you will find the same values as displayed behind Info (representing
only the current time step). But for the design of a colormap e.g. we will need the
min and max values of all 1460 time steps together.

=

Properties 8 x|
e EF || 5 8] 2]
I Lattice info: 192 x 96 » 1, rectilinear coordinates
¥ Data info: grayscale, 32-hit float. min-max: 221.787..313941
X Shared Colormap: Edit .
¥ Dimeansions Info: * =[lon] yw = [lat]
¥ Transform: & inherit O local transform

¥ Global Data Window: | Active min p21.787 max pL3.941

+ To compute them, scroll down the properties of the activated NetCDF-Control
module, and click on Start at the Compute Min/Max port. In the bar below the
Console window you can keep track of Avizo going through all time steps and
comparing all current min and max values with the lowest and highest value found
before.

$ Compute Min/Max: Start...

+ Go back to the Properties of the variable tsurf*. In its “Global data window” fields
you will now find the min and max values that have just been computed. The
lowest surface temperature which occurred during the 1460 time steps is 193.649

Avizo Green 9.0.1 — Tutorial V2.0 DKRZ / CIiSAP Climate Visualization Lab



19

Kelvin, the highest value is 331.441 Kelvin. Activate the Global data window now.

Properties g x
¢ Em— FEENE

¥ Lattice info: 192 £ 95 x 1, rectilinear coordinates

33 Data info: grayscale. 32-bit float, min-max: 221.787..313.941

Z_C Shared Colormap: Edit .

$ Dimensions Info: * =[lon] ¥ = [lat]

¥ Transform: & inherit  local transform

R Global Data Window: | Active min [93.649 max f31.441

3.6. Colormaps and Colormap Legends

Colormap file format

A colormap is a sequence of RGBA-tuples, where every tuple specifies a color by a
red, green and blue value in the RGB color model. Each value ranges from 0.0 to 1.0
and is represented by a floating point value. A fourth value, the so-called alpha value,
defines opacity. It also ranges from 0.0 to 1.0, where 0.0 means that the color is fully
transparent and 1.0 that the color is fully opaque. A colormap usually stores 256
different RGB-tuples, but other sizes are possible, too.

The standard file format for saving and reading colormaps in Avizo is currently Avizo
“.am”. However, older colormap files of type “.icol” can still be read but not saved
by Avizo. Here is an exemplary snippet from a current colormap file:

temp2D.icol.am:
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# Avizo 3D ASCII 2.0

define Lattice 256

Parameters {
ColormapEditorCache {
ColorKeys {
KeyO "0 #00003b #000000 0.5 LINEAR",
Keyl "0.162344 #1f00ad #000000 0.5 LINEAR",
Key2 "0.280632 #3600ff #000000 0.5 LINEAR",
Key3 "0.407115 #1dff3b #000000 0.5 LINEAR",
Key4 "0.474308 #bbffa6 #000000 0.5 LINEAR",
Key5 "0.557312 #fefffe #000000 0.54 LINEAR",
Key6 "0.646104 #fcffe4 #000000 0.5 LINEAR",
Key7 "0.786561 #ffa357 #000000 0.5 LINEAR",
Key8 "0.887987 #ff3700 #000000 0.5 LINEAR",
Key9 "0.952922 #{f3645 #000000 0.5 LINEAR",
Key10 "1 #ff35¢c8 #000000 0.5 LINEAR"
}
AlphaKeys {
Key0 "0 1",
Keyl"1 1"
}
CRC "1745628589"
}
MinMax 221.787 313.941,
ContentType "Colormap”,
Interpolate 1,
LabelField O

}

Lattice { float[4] Data } @1

# Data section follows

@1

0.000000000000000e+00 0.000000000000000e+00 0.000000000000000e+00 1.000000000000000e+00
0.000000000000000e+00 0.000000000000000e+00 2.313725501298904e-01 1.000000000000000e+00
2.959816483780742e-03 0.000000000000000e+00 2.422570437192917e-01 1.000000000000000e+00

5.919632967561483e-03 0.000000000000000e+00 2.531415224075317e-01 1.000000000000000e+00

8.879449218511581e-03 0.000000000000000e+00 2.640260159969330e-01 1.000000000000000e+00

1.183926593512297e-02 0.000000000000000e+00 2.749105095863342e-01 1.000000000000000e+00

The colormap file also contains the value range (minimum and maximum) of the data
to be displayed. The example colormap file temp2D.icol.am has a value range from
221.787 to 313.941 (in this case temperature in Kelvin). The number of colors is set
to 256 (Lattice).
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Pre-defined colormaps

& grayScale.am
4 temperature.icol
& physics.icol

B4 sefsmic.col

& glow.col

" volrenRed.col
& volrenGreen.col
£ volrenWhite.am
=

Constant color

Load Colormap

In the properties window of the Display type, e.g. Slice, click on the button on the
right side of the Colormap line Edit - Options - Load colormap. Now, you can
select a colormap file, e.g. /work/kv0653/Tutorial_AvizoGreen/temp2D.icol. Further
details on the Colormap Editor can be found in its menu bar by clicking on Help.

Main Paned a x| ,&$ e @; i 4
- - (L
hm..m,.-w 1 R i B b & & %
(Saisn ash| [Eontrast Contrel [cyinder Siicel Bual Ortho Sices |
HAME CHLALE 2001 201 <GHeICDR Conlii ) 3 “Lond Colarmap
" o CRTETE oy Lo0k N [FS mwannew torial_AvizaGreen
B omputar B
Lt B
Il k204045 _windmag_20 hx
n_HelghtReld 20 R
Properties 4 N
o & = Fle pame:  [colormaps
¥ Frame: ™ show widtn: |1 L]
Fies of type: [ Fies =) x| _gancel
T options: P adjustview [ fitto poirts T tghaing
¥ Colormap: zizec: [T 1. (5554 Edk |
T mapping Typa: Icac'map =
1 sampling: redium ¥] oo asa [ interp textwre I square texels I~ ma =S

Edit Colormap

The default colormap of Avizo is set to grayscale. To change an existing colormap,
Avizo provides the Edit colormap feature, allowing the user to define colors and their
appropriate data values. In the Properties Window click on the Edit button on the
right side of the Colormap line Edit - Options - Edit colormap.
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Colormap Editor - Slice 5 x

ﬂﬂ Colormap: & grayScale am_ | Data: [tsurr -] ﬂﬂJJ ﬂ
221.787 230 240 250 260 270 250 200 300 30 [313941
=

Efalue 221793: Color- | Opacity| 0 Eli % /_' . ' 50 @

You can see a histogram with the value distribution of the variable, which can be
graphed either on a logarithmic (default) or linear scale. The colormap is provided
with colors defined by the boxes below and opacity defined by the line across the
histogram. New colors could be inserted by left mouse click under the color
histogram. The color key squares could be moved to the desired color or value.

Colormap Editor - Slice & X

3 :
H ﬂ Colormap: B 1 Colormap, | Data: [tsurf -] :J ﬂ 5 J ﬂ
221.787 230 240 250 280 270 280 290 300 310 |313.941

B 0 osesstlee 0 [

Efalue 221.?932 Col Opacity| 100 Eli 0| A * ' 50 Eﬂ

-

Set extreme values manually

Just change the minimum and maximum values on the top left and right hand side in
the Colormap Editor to the desired values.

Adjust the range of the data

Colormap Editor - Siice:

Click Adjust range ﬂ in the Colormap B 2] coormap: 2 Coomap| ea et J2).2l Wi 21

999.999 | Count

Editor in order to adjust the domain of your
colormap to the domain of your data set
(current time step only). See section 4.2
for the adjustment to the domain of all time
steps.

Create new color value (key value)

Click below the colorbar on one of the “key value” boxes and move the cursor a little
bit horizontally. You will notice that the “key value” changes gradually. When you
release the mouse button, a new key value / color pair is defined.

In order to change the color, click on the color on the right side of the Value field. The
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Color Dialog will pop up where you can change the color values by moving the
sliders or by clicking into the color field.

Color Dialog
. Edit. . Options

& H 5—_ 0.000
¢ s N |0.000
¢ v MEERNTT [0.000

Current Color Cld Color

Custom Colors

N EEw
Help | Reset | Apply | Qancel| OK |

Delete color value (key value)
Move the mouse onto the key value which you want to delete and right click.
Save Colormap

To save the colormap for your dataset, click on the | button. Select “Avizo (*.am)”
for the data format. The default location, where Avizo tries to save colormaps, is
currently the “colormaps” subdirectory of the Avizo system installation - where you
shouldn’t be able to write anything. So make sure to choose a directory owned by

you!

Create your own Colormap

In the Main Panel, right-click on an empty space Create Object - Other -
Colormap - Create.

Configure your colormap and save it as an “.am” file.

Colormap Legend

The Colormap Legend, also known as Color Labelbar, displays the colormap with the
appropriate data values as an icon in the Viewer. To append a colormap legend,
right-click on the Colormap module in the Main Panel Annotate - Colormap
Legend = Create. A new module will be added to the Main Panel window.

The Colormap Legend could be displayed in a horizontal or vertical direction. The
default setting is horizontal; to change the direction to vertical, activate the vertical
toggle.

Properties g X
tyy (Colorrnap Legend ) B gl ?
I oprions: W custorntext W vertical T rel size W transp.bg W font m| bg color

¥ Font Settings: Nimbus Sans L (16 pt.} Select J
& position: x [30 y [220]

I size: length [400 width [18

?3 Custom Text: FFD 293.15/20 313.15/40 328.15/'55 deg C'

T Title: \
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You can modify the default Colormap Legend annotation (the minimum value, the
maximum value and the values in between) to any other alphanumerical annotation
by activating the “custom text” toggle in the Options port.

For example:

223.15/-50 253.15/-20 273.15/0 293.15/20 313.15/"40 deg C"
[and press ENTER!]

This results in five instead of three entries. Each entry consists of a data value, a
slash (“/*) and the text that shall be visible at the corresponding position. If you want
to add the units at the top entry of the colormap, you might set the text “40 deg C” in
quotation marks to indicate that blank characters are included. Special characters
like ° (degrees) are not accepted by Avizo, unfortunately.

Hint: Of course there are also other ways to achieve a °C instead of K annotation, for
example:

a) use cdo subc to subtract the constant value 273.15 from the temperature
data before visualizing the data

b) use the Avizo module “Arithmetic” to do the conversion on the fly. But be
careful, this may slow down the animation since the operation has to be
done again and again for every new time step.

3.7. Caption, Annotation and Display Date

Date and time display

The date and time of the simulation data could be displayed in the Viewer window: In
the main panel, right-click on the NetCDF-Control module and then click Annotate -
Display Date - Create. A new module called Display Date is added.

Properties 8%
@ Gmpayose ) @ | 8] 2]
¥ Position: x |30 ¥ |-30
I colors: 1| text m| foreground | background O frame
g Font: Nimbus Sans L (28 pl.} Select
I Options: I frame I solid
i Display: M date W time

iz E‘ Date Format: ‘Custom format j |dd.MM.yyyy
$ Time Format: ‘Use date format j |hh:mm
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If Avizo produces an error (“Invalid date”), your NetCDF time format might be given in
absolute time format instead of relative times (see chapter 2).

You can change the date format or omit the display of the weekday. In the Properties
of the Display Date module, click on Custom format in the Date Format port and
enter dd.MM.yyyy for the German data format or MM.dd.yyyy for the English data
format (don’t forget to press ENTERY!).

In the Time Format port, also choose Custom format and keep the default setting
hh:mm.

In the Position port you may vary the position of the time display in the viewer
window. Test some values to arrange the time display in the top left corner. You can
also use negative values.

Captions

To create a text field to act as a title, subtitle or any text string, you can use the
caption feature of Avizo. In the Main Panel, right-click Create Object - Annotations
- Caption - Create. Avizo will add a new module called Caption in the Main Panel.
(BEDisplay Datel>)

ElProjectionl=
OB Caption L ternp2D.Icol] OB Colormap Legendl:)

The default annotation text is the current date and time.

Properiies =) (%]
T [Capton ] IEH ) Iz|
3 Background: | transparent (& colos

¥ Position Type: @ in pixels in normalized screen coordinates (0..1)

I ongin: !-Iowerleft e

¥ offsets [px]: from let |20 | from botiom |20

$ Alignment: @ Left Center Right

3L Vertical Alignment: (| Top ( Center (@ Bottom

¥ Text: | Surface Temperature

¥ Font: Nimbus Sans L (36 pt.) !_Selecli |
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3.8. Projections

Avizo provides a wide range of geographical projections, but only the common

projections are mentioned here.

First you have to load your data and select a Display Type, like Slice. In the

| )
properties window of the Slice Display Type click on the Button which appends

the Projection module to the Main Panel.

fMain Panel

[ Project View ]

Open Data...

Eﬂ\nimate F'Of‘tS] [Synchronize F'orts]

{(CBECHAMS OM

{E0tsurt*
[(EProjectionl=)
Froperties g X

("] _rProjection

¥ Types: [SPHERICAL |
¥ Radius: [ T f14e+osj
¥ Z-factor: b\ 1 J
¥ oualiy: [F 71 .

8] 2|

Click on the Projection module, move the mouse to the Projections Properties
window and click on the Types selector to choose the projection type.

List of the most common Projections in Avizo

None

SPHERICAL

EQUAL_AREA CYLINDRICAL

ECKERT (I 11 T IV V VI)
EQUIDISTANT_CYLINDRICAL
LAMBERT_EQUAL_AREA_CONIC
MERCATOR

MOLLWEIDE

ROBINSON

UNIVERSAL POLAR_STEREOGRAPHIC

Tip: Don’t forget to project!
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Example plots of projections

SPHERICAL

EQUIDISTANT_CYLINDRICAL

ROBINSON

3.9. Preferences

a) When starting Avizo for the first time, it makes sense to switch off some

b)

potentially confusing ports in the properties windows:

Edit > Preferences - Layout in the Project View section switch OFF “Show
connection ports in Properties Area”

If you decide that you need the trackball in the viewer window you can switch it
on:

Edit &> Preferences - Layout in the Viewer gadgets section switch ON “Show
the camera trackball”

In case you wish to have the viewer window as a separate window, you can do so
in the Preferences as well:
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Edit > Preferences - Layout in the Windows section switch ON “Show viewer
in top level”

d) If you want Avizo to save the viewer positions and sizes within the Avizo project in
order to start with the same window layout when reopening the project, then:

Edit > Preferences - Layout in the Windows section switch ON “Save window
layout on exit”

e) To enable the spinning function (letting the Earth turn automatically when giving it
a kick):

Right-click in the viewer window - Preferences - Spin animation (on)

Let’s stop this preface and go straight into details. We will now load data on our own,
visualize them, and build our own projects, with both 2D data and 3D data.

2D 3D
Scalar data chapter 4 chapter 4
Vector data chapter 5 chapter 6
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4. Visualization of 2D and 3D Scalar Data

4.1. Surface temperature as Slice

+ In the Main Panel click Open Data and load the NetCDF file
ECHAM5_OM_A1B_2001_2D.nc.

+ The Variables Editor opens and lists the variables available in the NetCDF file. In
the Variables Editor choose the variable tsurf (surface temperature) by clicking
Add and confirm with Ok.

Variables Editor

|[ECHAMS_OM_a1B 2001 2D.nc x| I flat

precip tsurt
uLo
w10

qwi
slp =- Remowve
Combine

Ok | Cancel |

Avizo loads the selected variables of the data set, reports this in the Avizo Console,
and represents the data set with green modules in the Main Panel window — in this
case one for the NetCDF file as a whole and one for the tsurf* variable. [Tip: You can
access the Variables Editor later, e.g. to select other variables, by clicking on the

green NetCDF file module in the Main Panel window and then on the button in

the according Properties panel.]
Additionally, Avizo automatically connects each loaded NetCDF file to a red NetCDF-
Control module, which you might use e.g. for navigation through time.

Questions concerning metadata:
= How many time steps are available?
= What are the min and max values in the first time step and over all time
steps?
=  What kind of grid is it?
=  Which cdo commands were used last and when to process the file?
= In which physical unit is the temperature provided?

Answers
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+ To visualize the temperature, right-click on the variable and then click Display -
Slice and select Create.

In the Main Panel, Avizo connects the variable tsurf* with the new Slice module.

In the viewer, a first visualization of the global surface temperature is visible — up
to now only in black and white (gray scale).

Froperties

T
o EE—— 8]0 2]
i ¥ Frame: show  width: [1 :

T optiens: P adjust

¥ colormap: 221 7868 mﬂ 313941 it |

o points T lighting

5 mapping type:  [cowmap 7]

% sampling: medium =] Fou vata T interp, teature T square tewels T move low res.
& Transparency: & None © Binary © Alpha

¥ wrignness: 0k .|

¥ contrast: [ el |

$ Number OF Filters: |1
|

4.2. Defining a Colormap

+ In the Properties of the Slice, the Mapping Type should be Colormap.

+ In order to create your own colormap, right-click into the Main Panel and select
Create Object - Other - Colormap and select Create. To connect the new
colormap to the Slice module, click on the little white square on the left side of the
Slice module and select “Colormap”. Move the mouse cursor to the Colormap
module you have created and click into it. Now a connection between both
modules is established, and the Slice turns white.

[Hint: Alternatively, you can select your newly created colormap as a shared
colormap for the variable you're about to visualize. Click on the white square of
the tsurf module, select “shared colormap” and then click on your new colormap
module. All visualization modules connected to tsurf will now use the same color
mapping.]

+ You may want to edit the colormap: define combinations of physical values and
the respective colors. In the Slice Properties right-click on Colormap and select
Options - Edit colormap. The Colormap Editor opens.

+ Click Adjust range ﬂ in the Colormap Editor in order to adjust the domain from
your colormap to the data range of your variable. You may also fill the two boxes
for extreme values: on the left hand side choose black, on the right hand side
choose pink. When clicking Adjust range, Avizo has only loaded the min and
max values of the current time step and it may so happen higher or lower values
occur in other time steps. Such values above and below the selected data range
will be visualized with the respective colors of the two boxes.

[Tip: Alternatively, you may compute the absolute min and max values of all time
steps in the Properties of the NetCDF-Control module, note them (Global data
window of tsurf* module) and enter them manually in the Colormap Editor as
limiting left and right values.]

+ Click below the colorbar on one of the “key value” boxes and move the cursor a
little bit horizontally. You will notice that the “key value” changes gradually. When
you release the mouse button, a new key value / color pair is defined. In order to
change the color, click on the color on the right side of the Value field. The Color
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Dialog will pop up where you can change the color values by moving the sliders or
clicking on the color field.

Color Dialog

. Edit.. Options

@ H T |0.000
C s N |0 000
C v M [0.000

Current Color Cild Color

Custom Colors

HE "N EEN
Help | Reset | Apply | L‘:ancel| DK |

+ For example, choose a white color for 273 Kelvin (= 0°C), then Green-Blue-
Purple-Black for values below 273 K and Yellow-Orange-Red-Pink for values
larger than 273 K.

+ Move the line of opacity upwards to the top to visualize all colors with full opacity
(100%) [default]. To get more transparency, move the line downwards and see
what happens.

+ Save =] your colormap as temp2D.am in the Avizo data format. The default
location, where Avizo tries to save colormaps, is currently the “colormaps”
subdirectory of the Avizo system installation - where you shouldn’t be able to write
anything. So, make sure to choose a directory owned by you!

Colormap Editor - Slice g X

3
H ﬂ Colormap: B Colormap, | Data: |tsurf j ﬂ ﬂ J J ﬂ
221787 230 240 250 260 270 280 290 300 310 |313.941

100i| ﬁ
0

= -
A a o

Efalue 221 79 = Color pacity[100 e &+ 50 Eﬂ

24

+ Close the Colormap Editor.

The network in your Main Panel window should look something like this now:

HOtemp2D.icol =

#+ The module Slice shows the temperature as grid cells. Zoom close to the surface
to view the individual pixels.
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+ In the Properties window you may [ 5x
change the sampling resolution |7 =28 M) ) ) 2
(from coarse to finest) or even ¥ opions O sausven Crwpons Cigwos
choose an interpolated texture B R
resulting in a less pixelated % Sampling: medam 2] F intero data T inter. texture. I sauare texels T~ move fow res
visualization. You should be
aware, though, that Slice does not display the original grid sampling of the data.
You may also notice that the rendering speed will decrease with increasing
resolution used.

§ rransparency: # Hone: © Binary 1 Alpha

4.3. Saving your Project

Avizo can save the visualization application you have just compiled as a “project”: a
script file with the extension *.hx, which enables you to later reopen the very same
application again.

#+ Click on File > Save Project As where you may choose the file name
temp_2D.hx.

In case of any problems or uncertainties you can find a similar project in the tutorial
folder under the name TUT_temp_2D.hx.

4.4. Using Projections
Up to now, no geographic projection has been applied to our visualization. Avizo,
however, offers a huge number of projections of your choice:

+ In the Slice Properties click the projections buttonﬂ. Avizo uses a spherical
projection (globe) as default.

Ellfsug* ] O Slicel=) HProjectionk

+ For orientation reasons click View All in the navigation bar.
+ Explore the earth from all sides. What is striking?
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Since the ECHAM5-OM1 global models grid cell centers lie in the range between
88.6°N to 88.6°S, you will have “holes” at the north and south pole. Unfortunately,
they cannot easily be closed by means of interpolation or extrapolation.

Additionally, Avizo does not close the gap at the model borders in the Pacific Ocean

as it does not know that the first column of the data (at ~ -180°) and the last column

(at ~ +180°) are topologically direct “neighbors”. This problem can easily be solved:

= At the bottom of the NetCDF-Control Properties activate the copy first longitude
toggle of the Misc port.

& Misc: v copy first longitude

+ In the Properties of the Projection module test MOLLWEIDE projection (,a
recumbent egg", left figure) and the ROBINSON projection (right figure) of the
Types port.

= You may also want to test the EQUIDISTANT_CYLINDRICAL Projection. What's
the difference between this projection and the unprojected visualization? Answer.

= Save your project in this Equidistant Cylindrical Projection since we want to
continue with this projection in the next chapter.
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4.5. Legend: Display Date, Colormaps and Annotations

Date and time display

+ In order to display the date and time of the simulation data in the viewer window,
right-click on the NetCDF-Control module and then click Annotate - Display
Date - Create.

E0ternpZD.icoll=

+ Test it by starting the animation in the NetCDF-Control Properties. If Avizo
produces an error (“Invalid date”), your NetCDF time format might be given in
absolute time format instead of relative times (see chapter 2).

+ You may want to change the date format or abstain from the display of the
weekday. In the Properties of the Display Date module click on Custom format in
the Date Format port and enter dd.MM.yyyy for the German data format or
MM.dd.yyyy for the English data format (and press ENTERY!).

+ In the Time Format port also choose Custom format and keep the default setting
hh:mm.

Enlarge the Point Size from 14 to 36, choose font Nimbus Sans L .

In the Position port you may vary the position of the time display in the viewer
window. Test some values to arrange the time display in the top left corner. You
can also use negative values.

¥+ #

Properties & X]|
3 (Display Date M ﬂ
X Time: [NetCDF-Control ~| <
¥ Position: x |30 Y |-3CI
I colors: O text m| foreground m| background [| frame
¥ Font: Nimbus Sans L (36 pt.) Select
Il options: ™ frame I solid
Il Display: W date W time

I Date Format: |Custom format j |dd.MM.y§,r3.ry

I Time Format: |Custom format j |hh:mm

Colormap Legend

+ In the Main Panel window right-click on the colormap module temp2D.icol and
then click Annotate - Colormap Legend > Create.

BHtemp2R.icoll> (ﬁmColormap Legendl=)
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+ In the Colormap Legend Properties activate the vertical toggle in the Options port
to change the display from horizontal to vertical. This might be suggested here as
the temperature mainly alters with the latitudes.
You can change the default colormap annotation (the minimum value, the
maximum value and the value in the middle between both numbers) to any other
alphanumerical annotation by activating the “custom text” toggle the Options port.
The default entry in the input field for the custom format results in the annotation
“Low — Medium — High“. This can be changed to absolute data values, and you
could also use “Degrees Celsius” instead of “Kelvin” - which might be more

comprehensive for non-meteorologists. Enter the following text in the Custom
Text port:

223.15/-50 253.15/-20 273.15/0 293.15/20 313.15/"40 deg C"
[and press ENTER!]

This results in five instead of three entries. Each entry consists of a data value, a
slash (“/*) and the text that shall be visible at the corresponding position.

Since the colormap is a bit too short for five entries, we shall enlarge it by entering
a length of 400 in the Size port.

Properties [

Colormap Legend ) I
. )

¥ Dpata: temp2D.icol h

¥ Options: ¥ custom text W wverti

I™ rel.size ¥ transp.bg W font m|bg

ju

¥ Font Settings: yimpus Sans L (16 pt.)

$ Position: x |30 y |180

I size: length |400 width |18

X Custom Text: [20273.15/0 293.15/20 313.15/40 deg C"
I Title: [

+ You may want to enlarge the annotation text by activating the font menu and
change the settings to font Nimbus Sans L bold and 16 pt. size.

Display of Captions

+ To complete this legend with an annotation, click Create Object - Annotations

- Caption - Create in the menu bar. In the Main Panel, Avizo adds a new
module again.

meﬁDls [E8Cispiay Datet)
(EOECHAMS_OM_ALE 2001 _2Dnck

{(ERtsuf* LS HPfrojectionk
UE Caption

OB Colormap Legendb}

+ The default annotation text is the current date and time. In the Caption Properties
you may change it to “Temperature” in the Text port.
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+ Move the Caption to the bottom of the colormap by changing the position
parameters in the Properties area (drag & drop is not possible in the main viewer).
Please note: The Caption module is not connected to the Colormap module and
in the case of repositioning the legend, you will have to move both elements
separately.

Properties
',l‘ | Caption . . |E| |E| |E|
Il Background: /| transparent (& color
¥ Position Type: @ in pixels in normalized screen coordinates (0..1)

T origin: IIowerteﬂ =

R Offsets [px]: from left |20 | from bottom |20 |
?3 Alignment: @ Left 1 Center Rignht

IL Vertical Alignment: | Top ( Center @ Bottom

I Text: | surtace Temperature |
X Font: Nimbus Sans L (36 pt.) | Select | |'—|

The main Viewer should now look something like this:

01.01.2001 00:00

40degC

Surface Temperature

+ Save your project as temp_layout_2D.hx (File > Save Project As).

In case of uncertainties you will find the current project in the tutorial folder under the
file name TUT_temp_layout_2D.hx.
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4.6. Precipitation as Bar Chart Slice

+ Add the precipitation data set by clicking on the i Variables Editor
NetCDF file module B [prec
ECHAM5 _OM_A1B 2001_2D.nc again, and open g‘\;
the Variables Editor in the Properties window. < Remove|
Then add the variable precip to the list on the right e
side and click Ok. | o

(818 Cancel

The second variable is added to the NetCDF module in
the Main Panel:

EhetCDE-C anitroll OB Display Datel=

HFrojectionl

O Colormap Legend l>)

O3 C aption =

+ Turn off the Slice with the temperature data, the colormap and the annotation by
clicking their toggles. (How? See chapter 3.4)

Now, we want to visualize the precipitation as a 3D bar diagram with different bar
lengths representing the precipitation value in each grid cell. This visualization
method is especially intuitive for variables which only can take positive values. In the
case of rainfall it reproduces our perception of a ,height of precipitation®.

+ In the Main Panel window, right-click the variable precip*, then click Display =2
Bar Chart Slice - Create. Avizo adds it as a new module.

+ In the Bar Chart Slice Properties, click on the projection symbol dj Avizo then
connects the Bar Chart Slice module to the existing Projection module.

OB Display Datels)

HOprecip*

OB Captionl=

(E0termp2D.icol =)

{08 Colormap Legendl)

{OBEar Chart Slice =

+ In case you have a perpendicular XY-View of your data in the viewer window,
incline it a bit with the trackball to make sure the bars erect from the earth surface
as wished.

Unfortunately, up to now, the “bars” only look like flat squares, even from an inclined

view. You will have to apply a reasonable vertical scaling:
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+ In the Bar Chart Slice Properties, move the Scale slider to 1. This scaling seems
to be insufficient since the “bars” are still flat.

+ To enlarge the value range of this slider, click on the field on its right hand side.

+ In the opening

Slider Dialog, enter the Max value 100 and confirm with OK.

Properties

<p (Bar Chart Slice

JJJJ

¥ Draw Style:
$ Colormap:
i
N

Texture Wrap:

Culling Mode:

i i 3 i i -
?3 Orientation: Yy =z Wz T ’Di
$ Slice Number: ﬂFﬂ o] J g ) ,r
¥ Scale: h a J At ’%gi
3;; Filter Show: ® all © OnData ¢ Off Data

outlined more options | Line width: Outline color
| Edlit

* no culling © backface  frontface

™ Show sub-range buttons

LCancel ‘ oK |

+ Move the slider to the right again. Now the range is sufficient to scale our bars.
Set the scale to 60.

+ Additionally, change the Draw Style from outlined to shaded.

Properties

<p (Bar Chart Slice

-

g Draw Style:
g Colormap:
X

Texture Wrap:

Culling Mode:

| | 8|2

Dutline color

o] more options 7| Line width: l_
Clamp

& no culling ¢ backface  frontface

Orientation: & xy © xz  yz

Slice Number: ﬂh— ﬂ’D—J
I" A 60 |

@ Al OnData ¢ Off Data

Scala:

HE HE He HE HE

Filter Show:

+ Precipitation is now represented by red bars. Blue would be more suitable for rain.
Change the bar color into blue by double-clicking the red colormap in the Bar
Chart Slice Properties.
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L Color Dialog
. Edit. . Options

¢ 1 I (053
c s [T (0729
c v I [ 000

A N [osod

Current Color Old Color : ]

CUStom Colars

N HEN
Help ‘ Reset | Apply l Qancel\ oK |

The height of precipitation is now visualized by blue bars.

In practice, you probably would not use such a monochrome diagram. You can also
create a colormap and connect it to the Bar Chart Slice module in order to add color
mapping. Here, we are going to take a pre-defined colormap: right-click into the
colormap, select Options - Load colormap, open the tutorial folder and select

precip.icol.

If you move forward to time step 16, your visualization will look like this:
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04.01.2001 18:00

Global Data Window

Up to now, the heights of the bars have only been comparable at different locations
within one single time step. Bar heights of different time steps are not comparable
because their maximum and minimum heights depend on the data range of the
individual time step. If you want to compare the bar heights of different time steps,
you must define a Global data window in the Properties of the corresponding variable
(here: precip), that covers the whole data range of all time steps.

In case of multivariate data, a very useful option is the use of a colormap to visualize
a second variable. For example, a Bar Chart Slice showing the absolute precipitation
could be colorized by the percentile change of precipitation relative to a certain time
period (ColorField). In this case, we could colorize the bars by using a bipolar
colormap (e.g. Brown — Orange — White for negative percentages, White - Light Blue
— Dark Blue for positive percentages).

In our tutorial we are not going to visualize such anomalies, but, in order to
demonstrate the feature, we would rather use the loaded temperature variable to
colorize the Bar Chart Slice.

4.7. Bivariate Bar Chart Slice: Precipitation and Temperature

= Switch the temperature colormap and annotation on again. (How? See chapter
3.4)

4 In the Bar Chart Slice module, click on the small white box, there on ColorField
and connect the arising line with the tsurf* module.

+ By clicking on the white box again, connect the Colormap port of the Bar Chart
Slice with the colormap temp2D.icol. The precipitation colormap is unconnected
now.

=+ In the Bar Chart Slice module, right-click on the colormap and click on Adjust
range to - tsurf.
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#+ Add a second annotation (Create = Annotations - Caption - Create). Enter
the text “Bars: Precipitation” in the Caption Properties and arrange the
annotations like this:

04.01.2001 18:00

= Start the time animation in the NetCDF-Controls Properties.

= Save your project in your own folder as temp_prec_2D.hx (File > Save Project
As).

This project can also be found in the tutorial folder (filename

TUT_temp_prec_2D.hx).

4.8. Sea Level Pressure as Isocontour Slice

+ Load the mean sea level pressure as a third variable: Click on the NetCDF file

ECHAM5_OM_A1B 2001_2D.nc in the Main Panel window, then press to
load the Variables Editor, where you can add the variable slp (= sea level
pressure).
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Variables Editor

Ul slp
w10 : i |precip
i d [tsurf

=- Remowve

Comhbing

Ok ‘ Cancel

Switch off the Bar Chart Slice and its corresponding Caption 2 via their toggles.
Switch on the Slice again with the temperature data.

Right-click the variable slp*, then Display = Isocontour Slice = Create. This
time, Avizo adds two coupled modules to the Main Panel window — an empty
Clipping Plane and an Isocontour Slice module.

As usual, you will have to project the new Isocontour Slice module first before you

can see its visualization properly. Click the projection button ufq to connect it to
the Projection module.

H0temp2huicol =

{Om Colorap Legendl:)

OB Caption =

Bl FProjectionl

In the Isocontour Slice Properties change the color from red to black (double-click
in the colormap).

Enlarge the resolution to 600. This will enhance the isoline resolution, but
decrease the render performance.

Keep the line width at 2.

Set the number of isolines (num in the Values line) to 12. Now Avizo evenly
divides the value range by this number. As a result, the Isolines are chosen at
evenly distributed hPa-values.
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Properties g %
@ | @] 2|
’; Spacing: & uniform © explicit
T values: [e67152  [105384  num [17]
¥ Quality: T low ¢ medium © high & custom
h le Parameters: resolution (600 line width |2
3; Options: ™ update min-max [ resample
J;‘ Colormap: o] ‘ L Edit

#+ You can explicitly define the values for which you wish to have isolines on your
own by switching the Spacing port from uniform to explicit.

# In the Values port enter 13 pressure levels in Pascal (not hPa!) from 99000 to
105000 separated by a blank. You will have to press ENTER at the end before
Avizo can apply them.

Properties g %
@ | @] 2|
’; Spacing: " uniform @ explicit
J-;: Values: |99000 99500 100000 100500 101000 101
+¥ Quality: T low ¢ medium © high & custom
?-_.; Parameters: resolution (600 line width |2
3; Options: ™ update min-rmax [ resample
J;‘ Colormap: o] ‘ L Edit

In the viewer window, temperature and sea level pressure should be visible
somewhat like this (time step 1):

This visualization clearly shows where pressure gradients are high or low. But you
won't be able to quickly see if there is high-pressure or low-pressure in a certain
region. Therefore it might be suitable to colorize the Isolines.

# Right-click on the colormap in the Isocontour Slice Properties and there click
Options - Load Colormap. Load a pre-defined colormap called

Avizo Green 9.0.1 — Tutorial V2.0 DKRZ / CliSAP Climate Visualization Lab



44

sea_level_pressure.icol from the tutorial folder. High-pressure is displayed in red
colors, low-pressure in blue colors, while 1013.25 hPa is displayed in white.

Properties

& (lsocontour Slice )

?3 Spacing: = uniform & explicit

$ Values: blOBODO 103500 104000 104500 105000
_¥ Quality: " low " medium  high & custom
¥ Parameters: resolution |600 line width 2|

¥ Options: [T update min-max [ resample

X colormap: [964452 {E : : Sﬁ 106080 Edit .

+ Add a legend for the sea level pressure in the viewer window by right-clicking on
the sea_level_pressure.icol module in the Main Panel window; then click
Annotate - Colormap Legend - Create.

+ You may annotate the second colormap with custom text, e.g. “High” for 107000
Pa, “normal” for 101325 Pa and “Low” for 91500 Pa.

Properties

ty (Colormaplegend2 ) [

I Options: W custorntext [ vertical I rel size W transp. bg [ font
X position: x | 200 v |50
X size: length | 300 width |18

X custom Text: [91500/Low L01325Medium 107000)High

#+ You may also add an annotation to the legend again (Create Object >
Annotations - Caption), e.g. “Isolines: Sea Level Pressure”.

+ Move the position of the two colormaps and its annotations according to the
following figure.

01.01.2001 00:00

Surface Temperature

40 deg C
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Your project structure has become quite complex already, but on the other hand,
some of the modules are currently inactive:

OE Display Datet})

EDternp2D.icoll=)
{0BColormap Legendl:)

OB C aption =

{B0sea_level pressure.icoll:
(OB Colormap Legend 2[=)

{OE Caétion 3[=]

+ Save your project as temp_slp_2D.hx (File > Save Project As).
This project version is called TUT _temp_slp_2D.hx in the tutorial folder.

4.9. Continental and Political Outlines

Until now, in our visualization you could not easily figure out the geographic context
of the visualization. For example, coast lines would help to show the geographic
mapping of the data. This might be important to compare the temperature and
pressure patterns onshore and offshore.

+ You can easily add a standard Earth module to your project by clicking Create
Object > Other - Earth - Create from the main menu bar.

+ As always, connect the Earth module to the Projection module by clicking the
projection button.

+ In the Earth Properties, switch off the terrain (Terrain > Display Mode > None), but
switch on the coast lines (Border > Display Mode > Line Set).

+ Change the Color of the continental outlines from blue to dark gray (click in the
color rectangle of the Earth Properties).

+ [f you also like to see the political outlines (borderlines), click Border > Type > All.

Change the Line Width of the borders from 1 to 2. In order to do so, you will
again have to configure the maximum value of the slider (click on button on the
right side next to the line width value).

-
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Properties
@ (Earh ) B ilﬂ
Terrain:

T z scale: o |

T 7 offser: o ]

1—;{ Display Mode: Mone  Adaptive ¢ Constant

Sl H

X Quality: Low  Medium € High

¥ Orography Qualiny: Low 7 High

s n

;F Texture Brightness: Normal © Ocean Brighter ¢ Ocean & Land Brighter

5

7—;{ Orography: Ocean & Land © Oceanonly © Land only

Border:

¥ Display Mode: " None ™ Line Set © Texture

3—;‘ Type: " Caontinental & All

l—rl; Z Scale: h 10—‘J
X Line wWidth: E ﬁlz—_J
X color: |

?—F Continental Borders: Plfdatafear‘thDBIbordersfshcrelines.slf Browse

_Browse |
_Brouse |

?—F All Borders: |lfdatafear‘thDijordersfall_borders.slf Browse

+ Change the flat earth into a globe, that is, change to spherical projection (click on
the Projection module and change the Types entry to SPHERICAL, then click
View All in the navigation bar).

+ If not yet done, fill the Pacific gap by activating Copy first longitude in the Misc
port of the NetCDF-Controls Properties.

+ Save your project (File > Save Project).

This project version is called TUT_temp_slp_Earth_2D.hx in the tutorial folder.

01.01.2001 00:00

Surface Temperature

40 deg C
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4.10. Topography & Bathymetry

The same Earth module that we just got to know in chapter 4.9 can also be used to
construct a background topography and bathymetry for visualizations.

<+ Start with an empty project and click Create Object - Other - Earth = Create
in the main menu bar.

#+ Project the earth by clicking the Projection button H’E

+ In the Projection Properties, set the Z-factor port to 1.

+ In the Earth Properties, set Terrain > Z Scale to 60000. To do this, you will have
to increase the default max value of the slider e.g. to 100000 (click on the button

right to Z Scale, the Slider Dialog will appear). Topography (onshore heights) and
bathymetry (offshore depths) become visible.

Properties

Q & o) |

Terrain:

?; Z Scale: |I A WJ
1; Z Offser: h IO—J
?—F Display Mode: " Mone * Adaptive © Constant

X Quality: & Low € Medium € High

+ If you further increase the Z Scale, the earth begins to look like a hedgehog. In
this figure, the Z Scale is 200000.
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+ Keep the Display Mode on Adaptive resolution.

+ Zoom & closer. Depending on the display scale, three different resolutions for
the topography and bathymetry are loaded.

+ The adaptive resolution technique will cause a delay whenever the next level or
another tile of the high resolution topography data is loaded while you navigate.
Therefore you may want to change the Display Mode to Constant > Low
resolution for cases where you don’t need the high resolution of the topography
data, or Constant > High resolution for videos with smooth Camera Paths close to
the earth’s surface.

4.11. Velocity Magnitude as Embossed Slice

Let’s build a completely new project now and work with velocity data from an ocean
circulation model called MITgcm. You can find further information about this model at

e http://mitgcm.org/

By means of the Embossed Slice module, we can visualize slices through scalar data
with a combined color and bump shading. As a result, the maxima and minima of the
2D data slice will look like a colorized relief structure, like mountains at high data
values and valleys at low data values, although the rendering is still only based on
2D slices through the data field. The Embossed Slice module efficiently utilizes the
capabilities of the visualization server’s 3D graphics card - with the result of a quite
high rendering speed.

+ Start with an empty Avizo project, load the NetCDF file MITgcm_current_1960.nc
from your tutorial folder and select the variable SPE100M (current speed in 100
meter depth).

Variables Editor

|MITgcm_current_196CI.nc j I flat

SPELOCM

=- Remowe

Combine

d

Ok ‘ Cancel ‘

+ Right-click the SPE100M* variable Display - Embossed Slice > Create
+ Project the Embossed Slice by clicking the Projection buttonﬂ.
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+ Load a pre-defined colormap called current_speed.icol from your tutorial folder
and connect it to the Embossed Slice module.

+ Keep the Mapping Type Colormap.

+ Add the earth topography by clicking Create Object - Other - Earth = Create

from the main menu bar and project the Earth module as well. In its Properties
window, set its Z scale to 30000 so that topography arises and bathymetry is
pushed down to better see the Embossed Slice.

+ Up to now, the Embossed Slice does not show any bump shading yet. Add the
bump shading effect by shifting the Depth slider in the Embossed Slice
Properties. Positive and negative values will result in shadowing from different
sides. You might choose a Depth value of 25 for this example.

Properties
) (Erboseasice ) [
¥ Mapping Type: [Colormap ~]

X colormap:  [00z @ KNz Eait
¥ Depth: [r il

3 Transparency:  Mone & Binary  Alpha

LI

+ Finally, add time information to your viewer window by right-clicking the NetCDF-
Control - Annotate - Display Date - Create. This time choose a custom date

format MMM yyyy which results in “Jan 1960”, for example.

+ You should take some time to look through all the time steps in the NetCDF-
Control module by pressing the play button there:

Froperties

3 (Netcorcontrol

$ Info: 122 time steps (time range 3652..4015)

I Mode: * time step  physical time

X Time: |- F':& Z | m[s0 J

The following figure shows the resulting visualization of time step 69:

Avizo Green 9.0.1 — Tutorial V2.0 DKRZ / CIiSAP Climate Visualization Lab



50

+ Save your project as current_Embossed_Slice_2D.hx.
The pre-defined project is called TUT_current_ Embossed_Slice_2D.hx.

4.12. Sea Surface as Height Map Slice

The Height Map Slice module works similar to Bar Chart Slice, which we have used
in chapters 4.6 and 4.7 to visualize precipitation. Both use the 3D height to visualize
2D scalar data. The main difference: the Height Map Slice module renders a
smoothly elevated surface (according to the values of the 2D Input field), whereas
the Bar Chart Slice module displays the data as 3D bars. Both modules can be used
in a uniform color, colorized according to the input field or with a second variable.

We want to continue to work with the ocean data from the MITgcm model. In this
exercise we want to construct a Height Map Slice from the variable sea surface
height (SSH) and assign either sea surface temperature (SST) or sea surface salinity
(SSS) as a ColorField. In this way we can visualize two variables (either SSH and
SST or SSH and SSS) at the same time and examine their interrelation.

#+ Click Open Data from your Main Panel | il Slizus
window, select the NetCDF file [MTgerm_2007nc =] I fat
MITgcm_2007.nc from your tutorial SST
folder and add all three variables (SST, o
SSS, SSH) to the right side. Confirm E—
with Ok. ——

+ In the Main Panel window, right-click
the variable sea surface height (SSH),
then click Display - Height Map Slice
- Create.

Ok Cancel
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4+ Click the white small rectangle of the new Height Map Slice module, select the
input ColorField (via the white rectangle on the left side of the module) and
connect the line to the SST variable of the NetCDF file. The Height Map Slice
module should now be connected with two variables.

+ Project the Height Map Slice module by clicking A and choose the Type
MOLLWEIDE from the Projection Properties.

+ In the Height Map Slice Properties, keep the shaded Draw Style. To assign a pre-
defined colormap, click Edit - Options - Load colormap and choose sst.icol
from your tutorial folder. In the Height Map Slice module click on the colormap
and Adjust range to - sst.

+ Display the date information by right-clicking the NetCDF-Control module in the
Main Panel window Annotate - Display Date - Create. Choose the date
format of your choice but deactivate time information since we only have 10
datasets per month and do not need time information to distinguish the time
steps.

Your Main Panel and viewer window should look similar to the following figures now.

OB Height Map Slice )

BlProjectionl=

As you can see, our NetCDF file only covers the Atlantic Ocean and the Arctic
region. All other oceans
and all land areas are
filled with missing values,
which are visualized here
in gray. When you change
the Height Map Slice
settings to a transparent
Draw Style, the gray areas
would turn transparent.
But let’s keep the shaded
Draw Style for this
exercise.

+ For better orientation, you might add the coastal shorelines by clicking Create
Object > Other - Earth - Create from the main menu bar, then selecting
Terrain > Display Mode > None and Border > Line Set from the Earth Properties.
Choose a black color for the shorelines and a Line Width of 4. Don’t forget to
enable the Projection for this module as well.
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Properties

Terrain:

$ 7 Scale: Ai |D J
I 7 offser e [ J
bid Display Mode: @& None  Adaptive ¢ Constant

X Quality: & Low € Medium € High

$ Orography Quality: & Low ¢ High

E‘ Texture Brightness: & Norrmal ¢ Ocean Brighter ¢ Ocean & Land Brighter

pid Orography: & Ocean&Lland € Oceanonly © Land only
Border:

pid Display Mode: " None @ LineSet € Texture

;‘ Type: & Continental © All

$ Z Scale: \ A |l J

I Line width: T e J

$ Color: ﬂ

+ Up to now, the Height Map Slice rendering is flat — which you might have noticed
when navigating through your visualization with the trackball. To make use of the
central advantages of the Height Map Slice module, configure the Scale port of
the Height Map Slice Properties to a Max value of 10 and choose a scale of 5.

Properties
< (Height Map Slice N | ﬂ

T praw Style: shaded ~| more options ¥ | Line wicth: |0 % Outline <olor

X colormap: 2 d_-_._-h 34 Edit |
pis Culling Mode: @ noculling © backface  frontface

I Orientation: & ay O oxz O oyz

J; Slice number: ﬂFﬂ 4] J

$ Scale: | A 5‘ J

+ Add a colormap legend to your viewer window by right-clicking the sst.icol module
in the Main Panel window: Annotate - Colormap Legend - Create. You could
set the colormap annotations to steps of 4 degrees and set the parameters as
follows:

Properties

Ly (Colormap Legend ) B

b Options: W custorntext [ vertical [ rel size M transp. by I font | bg color
Z‘ Position: # |40 y |40
I size: length [400 width [18

3 custom Test: [6/16 20120 24124 26128 32/32 36/ Heg C”

T Title: [

+ Take the trackball and turn the visualization to a perspective view from the
Caribbean Ocean to Europe, with the eddies in the Gulf of Mexico in the very
front, and a straight view along the Gulf stream and its continuation to the north
east, the Northern Atlantic stream.
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16.12.2007

a4 8 12 18 20 24 28 32 degC

0
K = I

Global Data Window

Similarly to the situation with the Bar Chart Slice, the heights of the Height Map Slice
are only comparable at different locations within one single time step. Maximum and
minimum heights depend on the data range of the individual time step. If you want to
compare the heights of different time steps, you must define a Global data window in
the Properties of the corresponding variable (here: SSH), that covers the whole data
range of all time steps.

= At this point, you should take some time to animate your visualization. In the
NetCDF-Control Properties, click the Play button of the Time port. As you will
realize, this is computationally quite intensive compared to the Embossed Slice
method: now the frame rate is quite slow. We would first have to export an mpeg
movie in order to later look through all time steps quickly enough to be able to
directly see the seasonal changes.

Properies

$ Info: 111 time steps (time range 20834.5.21168.5)
;I Mode: & tirme step © physical time

T Time: a4 >[4 =

With this project once set, you can easily change the coloring from sea surface
temperature (SST) to sea surface salinity (SSS):

+ Simply take the connection between the Height Map Slice and the SST variable
and connect it to the SSS variable instead.

= Due to the different data range and meaning you will have to assign a different
colormap: Click Open Data, select the colormap sss.am from your tutorial folder
and connect the Colormap port of the Height Map Slice module to sss.am.

=+ Switch off the sst.icol colormap, display the sss.am colormap instead and define
the parameters in the Colormap Legend 2 Properties as follows:
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ty Cobrap e |

I options: ¥ customtext [ vertical [ rel.size W transp.by [ font | bg color

X Pposition: % [a0 v [40
X size: length [400 width [18

J;S Custom Text: EBE 34/34 35/35 36/36 37/37 38/38 39/39'

T Title: [

16.12.2007

Adjust the range to SSS: in the Height Map Slice module right-click on the
colormap > Adjust range to > SSS and set the minimum value to 33.

Properties
< eight Map Slice L] A
X Draw Style: [snagea +| more options | Line width: [0 @ Outline color

I colormap:

3 Culling Mode: @ no culing ¢ backface ¢ frontface

Tip: When rendering a Height Map Slice, Avizo also displays an orange boundary

line, which may disturb you depending on the chosen projection. To remove this line,
type into the console:

“Height Map Slice” frame off
= Save your project as MITgcm_Height_Map_Slice.hx.

As usual, you will find this project pre-defined, called
TUT_MITgcm_Height_Map_Slice.hx in the tutorial folder.
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4.13. 3D Temperature on a movable Slice

+ Start with an empty project and load the NetCDF file
ECHAM5 OM_A1B 2001 _3D.nc (Open Data button).

+ In the Variables Editor select the variable t (temperature). As usual in the Main
Panel window, three modules are added: one for the NetCDF file, one for the
variable t* and one NetCDF-Control module.

Ok Cancel

+ Right-click the t* variable module, and then click Display = Slice - Create.

+ Project the Slice by clicking uj Select the projection
EQUIDISTANT_CYLINDRICAL for this exercise and reduce the Z factor to 0.5.

+ Let’s colorize the Slice in the module’s Properties panel: As Mapping Type select
Colormap (default), then click in the Colormap entry on Edit > Options > Load
colormap and load the colormap temp3D.icol from the tutorial directory.

Eltermp3Duicol =

ElFrojectiont=}

Question: Why is the colormap temp2D.icol, which we have used in the earlier
exercises, not suitable for our 3D data? Answer

+ Take the trackball to move the camera to a more declined perspective and move
the slider of the Translate port to the right. You can move the Slice up and down
and visualize the temperature at 17 different pressure levels now.

+ When you add the Earth module (Create Object - Other - Earth = Create),
display date and time information (right-click the variable NetCDF-Control >
Annotate - Display Date - Create), add a colormap legend entry (right-click
temp3D.icol > Annotate - Colormap Legend - Create) and include an
annotation. (Create Object - Annotations - Caption - Create).

+ Your visualization should look like this:
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Save your project as temp_movSlice_3D.hx.

The example tutorial project is called TUT_temp_movSlice_3D.hx.

4.14. Bounding Box & Grid

*

In the Main Panel window, right-click t* and then Annotate - Bounding Box =
Create.

+ Project the Bounding Box with 'ﬂ‘ In the viewer window, orange boundary

outlines appear, representing the spatial extent of the 3D data set.

=+ Additionally, add a visualization of the grid by right-clicking t* and then Display >

+ &+ ##

Grid Lines = Create.

Apply the projection to the grid with al

In the corresponding Properties, choose the ik orientation instead of the default ij
orientation. The grid is now displayed at the front side of the Bounding Box.

You may move the grid to the back by selecting Slice 95.

If not yet done, move the Slice a bit down again in its slider in order to be able to
see the back side of the grid.

You can create a second grid for the left side with a second Grid Lines module
(Orientation jk, Slice 0). Don't forget the projection...
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Froperties Froperties
B (Grid Lines BN | I (Grid Lines 2 D H
X Orientation: © ij & ik C jk  all % Orientation:  ij C ik & jk © all

T Slice: A ] T siice: e IE =l

BNetCDE-C OB Display Datel=

= ClProjectionl>

OE Grid Lines 2[=

I
g
it

i

4.15. Ortho Slice, Slice, Embossed Slice — Comparison of 2D Slices

Avizo offers three different modules for 2D slices in 3D space. In chapters 4.1 and
4.13 we got to know the Slice, in chapter 4.11 the Embossed Slice. Additionally,
there is an Ortho Slice. What are the differences?

Ortho Slice and Slice are quite similar, as both of them can operate in three slice
orientations (xy, Xz, yz). But they differ concerning the grids they accept as input:
Ortho Slice can only be used in uniform (regular) grids and is thus not available at all
when your data grid is not regular (uniform coordinates). Slice is applicable for
rectilinear and curvilinear grids, as it internally executes a resampling to a regular
grid first.

Since our ECHAMS5-OM data uses a rectilinear grid, we cannot create an Ortho Slice.
Embossed Slice differs from Ortho Slice and Slice in some ways: First, only
horizontal slices (xy-direction) are supported. Second, it always interpolates the color
between the grid points. Its advantage is (third), that high gradients can much better
be visualized due to its shading technique. Also, the Embossed Slice shading
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efficiently makes use of the graphics hardware and is very fast compared to the other
modules.

Table 1: Comparison of Ortho Slice, Slice and Embossed Slice.

Module Spatial Remarks
Orientations

Ortho Slice Xy, Xz, yz “uniform coordinates” only (= regular grids, grid
cells are squares or cubes).

For non-uniform grids, Ortho Slice is not available.

Slice Xy, XZ, yz Applicable for “rectilinear coordinates” (grid cells
are rectangles or cuboids) and with ,curvilinear
coordinates” (grid boundaries are curved).

Automatic resampling on a uniform grid, optionally
in 4 spatial resolutions from “coarse” to “finest”.

In case of “uniform coordinates”, adoption of the
input-grid, no change of the spatial resolution

possible.
Embossed only xy Applicable for “rectilinear cords” (grid cells are
Slice rectangles or cuboids) and with ,curvilinear cords”

(grid lines are curved).

No display of single-colored grid cells but
interpolation between grid points with continuous
smooth color interpolation.

Possibility of Shading for height and depth reliefs.

4.16. Combination of several Slices

When you think it might help to understand your data, you can combine multiple
combinations of slices within one display, e.g. one slice for each 2D plane. We will try
this for the wind velocity and visualize the two west wind zones of the northern and
southern hemisphere this way.

+ Activate the NetCDF file ECHAM5_OM_A1B 2001 3D.nc in your Main Panel
window, open the Variables Editor, add variable var3 (wind speed) to the right
side list and confirm with Ok.

rhumidity var3

:
=- Remove
Combing

Ok Cancel
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+ Switch off the Slice of the temperature variable as well as its colormap and
annotation.

+ Create three new Slices connected to var3* and project them ﬂi' all. In their
Properties panels, select the following parameters:

Orientation Mapping Type Translate
Slice 2 Xy Colormap 4
Slice 3 XZ Colormap 67
Slice 4 yz Colormap 180

#+ To colorize them, load the pre-defined colormap wind_speed.icol from the tutorial
directory into your Main Panel window. Now click on the white square of the var3
module and select “SharedColormap”. Connect the rubberband line with the
colormap module. Notice that all Slice modules are now connected to the same
colormap.

+ Display the colormap wind_speed.icol as a horizontal legend entry (right-click
wind_speed.icol > Annotate - Colormap Legend - Create) with annotations
at 0, 20, 40, 60, 100 and 130 m/s.

+ Add the title Wind Speed [m/s] for the colormap (Create Object » Annotations
- Caption - Create), so that, finally, your Main Panel and Viewer windows look
like these:

OBDisplay Date [=

DlCcIcrmap Legend [z
DlCaptlon [>

(][] Boundlng Box [=
EIIGrJd Lines [»
I:IIGrld Lines 2 l>

DIColcrmap Legend 20

(OB Caption 2 [=)

<+ Try to get an overview of the 3D wind field by moving the three Slices up and
down, left and right, to the front and to the back. The jet streams in the upper
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troposphere of the Northern and Southern hemisphere are very eye-catching. In
the arctic stratosphere you can also see a polar eddy in this winter situation,
whereas wind speeds in the Antarctic stratosphere are lower.

01.01.2001 00:00

0 2 M &0 100

= Move the time slider of the NetCDF-Control Properties to a summer situation, e.g.
15t Jul 2001. Now the wind speeds in the arctic stratosphere are quite small,
whereas the Antarctic stratospheric eddy is extremely strong.

01.07.2001 12:00 01.07.2001 12:00

0o 20 4 60 100 20 40 60 100

o
=

= Save your visualization as windspeed_3Slices_3D.hx.

In the tutorial folder, TUT_windspeed_3Slices_3D.hx provides you with a current
version of the project.

4.17. Isosurface

Isosurfaces are the 3D equivalents to Isocontours in 2D. We are going to visualize
the relative humidity as an isosurface with varying thresholds.

= Switch off the three Slices of the wind velocity as well as the corresponding
Colormap Legend and Caption.

= Activate the NetCDF file ECHAM5_OM_A1B_3D.nc, open the Variables Editor
and add the variable rhumidity (relative humidity) to the Main Panel window.

= Right-click rhumidity*, then Display - Isosurface = Create and project the
Isosurface ﬁ‘
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In the Threshold port of the Isosurface Properties choose 0.9 to visualize the
atmospheric areas with a relative humidity of 0.9 or more (= 90%).

Click Apply to compute this Isosurface, or click auto-refresh to tell Avizo to
recompute it after each parameter change automatically.

You may change the default yellow color to white, which is closer to our idea of
cloudy areas (double-click into the colormap).

Try different Draw Styles, particularly, shaded and transparent.

- ¥+ ¥ ¥

Properties
@ O o

¥ Draw Style: shaded ~| more options ~| Line width: |0 @ Cutline color
X Colormap: o i Edit

)'F Culling Mede: & no culling ¢ backface ¢ frontface

I Threshold: . A 0

’;: Options: W compactify [~ downsample

+ Annotate with ,Isosurface at 90 % Relative Humidity” (Create > Caption).

@l CaEtibn 3C=)

+ Use the mouse to turn the figure to get a better 3D idea of the spatial distribution
of the relative humidity.

Isosurface at 90 % Relative Humidity
I
il
'\\\I‘l‘ﬂ‘u‘ﬂlu

il

Il

i
|
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At a glance you can see that a relative humidity of 90% only occurs in the
troposphere, as in the upper grid levels no isosurfaces are displayed at all.

+ Move the Threshold slider further to the right to 1.0 (100% humidity) and observe
that the isosurface is getting smaller and smaller.

+ In contrast, at a threshold of 50%, it gets quite large and you can even recognize
an isosurface in the stratosphere at the North Pole.

4+ Save this visualization as relhum_Isosurface _3D.hx.

The tutorial folder provides you with the corresponding project
TUT _relhum_lIsosurface 3D.hx

4.18. Bivariate Visualization: Isosurface & Temperature

Similar to the visualizations we have already done with the Bar Chart Slice and the
Height Map Slice modules, we can also colorize the Isosurface according to the
values of a second variable. We are going to visualize the temperature of the 90%-
isosurface here.

4+ |n the Main Panel
window, click into the
small white box of the
Isosurface module, then
on ColorField and
connect the arising line
with the variable t
(temperature).

+ Connect the colormap
port of the Isosurface
module with the colormap
temp3D.icol which is also
already loaded in your
project. Don't forget to
adjust the range. Switch
on the temperature
colormap and annotation again.

Isosurface at 90 % Relative Humidity

4+ Save your project (File > Save Project).

This stage of the project is provided as TUT_relhum_Isosurface_ColorTemp_3D.hx
in the tutorial folder.

4.19. Nested Isosurfaces

In 2D you can easily visualize a high gradient by displaying isolines for many different
values. By definition, the isolines don’t obscure or cross each other. Doing the same
with isosurfaces in 3D is a bit more complicated. Isosurfaces for different values of
the same quantity will enclose each other.
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Nevertheless, you can nest several isosurfaces if you reduce the opacity of the outer
ones. It also might be a good idea to use different colors for the different isosurface

values additionally. This technique helps in visualizing the spatial distribution of the
field for different values at the same time.

We are going to nest three isosurfaces for the wind velocity (variable var3) which
already exists in our project.

+ Switch off the rhumidity* Isosurface, its Caption, the temperature Colormap
Legend and its caption, and for this example also the Earth module.

+ Right-click var3* (wind velocity), create three Isosurfaces and project them u"j. In

the Main Panel window they are now called Isosurface 2, Isosurface 3 and
Isosurface 4.

+ Choose a threshold of 30 m/s for Isosurface 2, a transparent Draw Style and a

SlMett [3F- Zontroll OB Display Datel=

LOSlical- #E0temp3D.icoll=)

. {08 Colormap Legendl)
OB Bounding Box[» OB antion

EBwind_speeticol i)
{OBcColormap Legend 21=)

{DECaétion 2[=)

transparent green (double-click into the colormap). Then click Apply and auto-

refresh.

Properties

< |lsosurface 2 ‘E

_E—c Draw Style: transparent ¥ maore options | Line width: |0 | Dutline color
X colormap: 0 P ettt |1 Edit .

H Culling Mode: & no culling ¢ backface ¢ frontface

¥ Threshold: | [30 i

¥ Opticns: W compactify I downsample

+ Define a threshold of 40 m/s for Isosurface 3, choose the transparent Draw Style
and a transparent blue in the colormap. Again press Apply and auto-refresh.
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Properties

<p (lsosurface 3 )

/

J
$ Draw Style: transparent ¥ more options 7| Line width: [O B | outline color

X Colormap: o [ [ Edit _|
¥ Culling Mode: © no culling  backface  frontface

3 Threshold: HdO—J

I Options: W compactify I downsample

+ Isosurface4 shall include all regions with a minimum velocity of 60 m/s. Since this
isosurface will be the inner one in this case, choose the Draw Style shaded. After

double-clicking the colormap, select a purple with full opacity. Then click Apply
and auto-refresh.

Properties

3 Draw Style: shaded x* more options 7| Line width: ,07 % Cutline color

I Culling Mode: & no culing ¢ backface  frontface

<p (lcosurface 4 ) B

X Threshold: [[eo .
l, ¥ Opticns: W compactify [ downsample

+ Itis possible that the semi-transparent isosurfaces are not yet rendered correctly.
The semi-transparent surfaces enclosed by others may not be visible. Avizo has
different ways to handle transparency, and the default setting may not be suitable
for rendering semi-transparent nested isosurfaces. This can be changed very
easily: In the main window’s menu, select View - Transparency - Blend

Delayed. You may also try other transparency settings to find out which one
works best for the isosurfaces.

+ In a top middle position of the viewer window add an annotation (Create >

Caption) saying “Wind speed: Isosurfaces for 60 (purple), 40 (blue) and 30
(green) m/s*.
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Wind speed: Isosurfaces at 60 (purple), 40 (blue) and 30 (green) m/s
01.01.2001 00:00

High wind velocities in the northern and southern west wind zones are quite eye-
catching this way. Additionally, in the upper levels of the northern hemisphere, there
are some flat isosurfaces lying on top of each other. Wind velocity increases again
with height.

=+ Save your project as windspeed_IsosurfNest_3D.hx.

As usual, you’ll also find this project in the tutorial directory:
TUT_windspeed_lIsosurfNest_3D.hx

4.20. Annotated Isolines

In chapter 4.8 we have used Isocontour Slice already. Avizo Green offers a second
variant: Isocontour Annotated Slice. However, keep in mind that isoline annotations
are quite useful e.g. for screenshots in print publications, but absolutely unsuitable for
animations. Used within animations, annotations will change their position at each
time step, resulting in a kind of chaotic visualization.

We are going to add Isocontour Annotated Slice to the nested isosurfaces
visualization of the west wind zones of the last chapter.

# In the Main Panel window right-click var3* (wind velocity), then Display >

Isocontour Annotated Slice - Create and enable the Projection &! for the
new module.

= You may display the Isocontour Annotated Slice in the same colormap as the
Slices of chapter 4.16. Click into the white box of the module Isocontour
Annotated Slice, then on Colormap and connect the arising line with the colormap
wind_speed.icol. Make sure that wind_speed.icol is switched on (red box).
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Properties: Adjustment of the Isolines

#+ #

In the Isocontour Annotated Slice Properties, first change the Spacing from
uniform to explicit and enter the Values for which isolines shall be visualized.
Separate the values by blanks:

10 20 30 40 50 60 70 80 90 100 (ENTER)

Select Orientation yz to allow a side view into the west wind jet streams.

Move the Translate slider to the very right position on 192 and take the trackball
to turn the figure in the viewer window so that you can look at the right side of the
bounding box (see figure below).

In the Parameters port Properties

InCI’ease the I’eSO|UtI0n to & (lsocontour Annotated slice ) [] ﬂg
500 in order to smooth Csnow wigtn: [L
them The defaU|t ||ne ¥ Orientation: Xy | XZ | Yz ‘
Wldth Of 2 |S flne ZE Options: ™ adjust view W immediate [ setplane
$ Translate: ﬂ’iﬂﬂmJ
T Spacing: © uniform & explicit
¥ Values: |0 10 20 30 4050 60 70 80 80 100
& Paramerers: resolution ’F line width '2—
I Optionsz: ™ update min-rmax
$ Colormap: ,37 ﬂ:ﬁ ’].307 Edit )

Properties: Adjustment of the Isolines’ Annotation

*

*

In the Isocontour Annotated Slice Properties, make sure that active behind the
Annotations port is switched on. If turned off, no annotation will be drawn at all.

Test some value combinations for the three Annotations ports Font Size, Font
Factor and Gap. The combination of font size and font factor determines the size
of the displayed data figures. Annotations gap determines the distance between
two annotation entries along an isoline — a larger gap results in fewer annotations.
Unfortunately, in most combinations you'll either end up without any visible
annotation or with black isolines swamped by annotations. Some practice will
help. For the current
projection settings, the
following parameter

Il Annotations: W active [ texture text

?; Annotations Path: horizontal path ™

. . . T A ions Font Size: | 5
Comb|nat|on gIVeS a = nnotations Font 5ize Q J
. 3; Annotations Font Factor: |I A 39 J
reasonable annotation: _
¥ Annotations Gap: |' A 100000 J
J; Annotations Period: majar petiod |1 first period |1

¥ Annotations Colors: J text

In the Annotations Period port, set the major period to 1 in order to annotate

each of the isolines you explicitly entered. By keeping the default value 3, only
every third isoline will receive labels.

Test the Annotations Path: With horizontal path selected, all data figures are

shown parallel to the earth surface, which is parallel to the y-axis, with vertical

path, respectively, parallel to the z-axis, and in tangential path, annotations are
tangential to its isolines, resulting in a different orientation for each figure.
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Wind speed: Isosurfaces at 60 (purple), 40 (blue) and 30 (green) m/s 01.01.2001 00:00

0 20

| H\H HHHH\ Ml
H il |

#+ You might want to view this visualization in more detail and enlarge it to full

screen mode. To do so, use the fifth button of this series: [HH:E _E_E'@@
+ Remember, this presentation is unsuitable for video export, but you may want to

take a snapshot. You will find the snapshot button ‘& ‘ above the viewer window.
Pressing this button opens a window, where you can set the filename, format and
size of the snapshot.

=+ Save the current project as windspeed_Annolsocontour_3D.hx.

In case of any problems, you may want to have a closer look at the project
TUT_windspeed_Annolsocontour_3D.hx in the tutorial folder.

4.21. Volume Rendering

In the Volume Rendering method, the physical values for all grid cells (or “voxels”)
are mapped to opacity (alpha) and color values by using a so called transfer
function. In our case, the transfer function is defined by our Colormap, which
assigns RGBA (red, green, blue, alpha) values to the physical values. In the volume
rendering method, the viewing space is traversed, starting from the front to the rear,
and the composed RGBA result is projected on every correspondent pixel of the
frame buffer.

Ultimately, a smooth transition between areas with high and low opacity is typical for
this method, which is very suitable for the visualization of liquids or gaseous
phenomena.
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Please notice that Volume Rendering is only available for data with uniform or
rectilinear grids, but not for those with curvilinear grids!

Our data have rectilinear coordinates, so we can visualize, for example, the relative
humidity as Volume Rendering. This is an alternative to the Isosurface representation
shown in chapters 4.17 and 4.19. As mentioned above, this module can offer a more
intuitive visualization for liquids or gases which don’t show clearly defined interfaces.

+ Remove the Isocontour Annotated Slice, the three nested Isosurfaces and all four
Slices including the wind speed Colormap Legend and Captions from your Main
Panel window — we do not need them now. You might also use the Variables
Editor to completely remove the variable var3* (wind speed) from the NetCDF file
module. Make sure that the Bounding Box and Grid Lines are switched off and the
Earth is switched on.

+ Right-click rhumidity*, then Display - Volume Rendering = Create and project
|

= the new module.

OB Display Datel>

BDECHAMS O A1E 2001 3Dl
B0 rhurmidity*

OB Colormap Legend(>
OB C aption =,

{ DE!Caétion 3L=)

Ellyolume Rendering Setfings [>,
{OBVolume Rendering )

(EflvolrenRed? col =)

N

-4 CProjectionk

OB Bounding Box [>

DO Grid Lines 20

m

For each data value, its color and transparency is defined by means of a color lookup
table (colormap), which includes alpha values (transparency values) in addition to
RGB-colors. Avizo provides four predefined colormaps with alpha values. One of
them, volrenWhite.am, is assigned by default.

The 3D impression is generated by putting 2D slices back-to-back in series. The
more 2D slices displayed, the higher the resolution of the visual representation gets.
But the volume rendering also gets slower because more graphical objects have to
be rendered. For large data sets, this computationally intensive rendering might not
be suited for time animation and spatial navigation.

+ Rendering Quality: In the Volume Rendering Settings Properties, you may want to
enable the “Advanced Settings”. Then try the slider of the Sampling Quality port to
increase and decrease the resolution of the volume rendering. For a nice
rendering at screen resolution, a value of 1 might be a good start. If more detail is
needed, you can increase the maximum value of the Sampling Quality also to
higher values.

Since the 2D slices do not exactly run through the model grid points, its values must
be defined — either by taking the value of the closest grid point (nearest) or by linear
interpolation between the grid points (linear or cubic).
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+ In the Volume Rendering Properties, keep Interpolation Advanced setting linear.

Design of the Voltex Colormap

+ In the Volume Rendering Properties, click Colormap > Edit > Options > Edit
Colormap. In the Colormap Editor design a colormap which is completely
transparent (Opacity = 0%) for a relative humidity less than 80% and with an
opacity of 100% for the max value:

Relative Humidity | Opacity [%] | Color [mrmesememwms =
0.8 0 white ﬁ}rjlﬁiclurmap u:‘luwen_r:iwﬁ Dat: 4|rr..rr|41-nrIJ !b - . K| Jf‘#
0.9 10 yellow |/** —

0.95 20 green || real - tatat Paslisss @
1.05 30 Cyan [vatue(T o0 = calar opacty[30 - s ®
Max value 100 blue

4+ Save the colormap in your personal folder as volren_relhum.am.

XY Ortho View: Declined Perspective View:

Relative Humidity (Volume Rendering, Lookup = RGBA) 01.01.2001 00:00 Relative Humidity (Volume Rendering, Lookup = RGBA) 01.01.2001 00:00

AR S R R L

Variation of Lookup Tables

+ Our example is even more intuitive if we only use transparency values and
dismiss all colors. In the Volume Rendering Properties, change the Colormap
Lookup port from rgba (Red-Green-Blue-Alpha) mode to alpha mode. The
information of the three channels Red, Green and Blue is discarded now (all
pixels become white) and only the alpha channel is used for data representation —
for both absorption and emission. Regions with a humidity higher than 80% are
partly opaque now.

XY Ortho View: Declined Perspective View:

Relative Humidity (Volume Rendering, Lookup = alpha) 01.01.2001 00:00 Relative Humidity (Volume Rendering, Lookup = alpha) 01.01.2001 00:00

St LR LT

R R LR L R R R R ST s,
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+ In the Colormap Lookup port, you may test luminance alpha. This configuration
does not use any Red-Green-Blue channels information, either. The alpha
channel is used for absorption only, whereas for emission, the luminance is taken
into account (light intensity per area), a photometric term, that human beings
perceive as lightness. In our case, moist regions get gray. Change to the alpha
mode again.

+ With the Alpha Scale slider you can scale the transparency for the whole
visualization. Reduce the opacity from 1 to 0.3.

+ Compare your Volume Rendering results with the Isosurface you have created in
chapter 4.17 — check different Isosurface thresholds of relative humidity.

+ Save your project as relhum_volren_3D.hx.

For comparison, you'll find the current project in the tutorial folder: filename
TUT_relhum_volren_3D.hx.

5. Visualization of 2D Vector Data

5.1. Horizontal wind as vector arrows

Typical vector fields in climate research are the flow fields: the wind and the ocean
currents. In the 2D wind case, we may only be interested in the wind components u
and v, each in m/s. To visualize the horizontal wind as a vector, we need to combine
the two vector components u and v in the NetCDF reader.

+ Reopen your Avizo project TUT temp_slp_Earth_2D.hx from the tutorial folder.
This was the result of chapter 4.9. Save it as temp_slp_uv_2D.hx into your private
folder for this chapter.

+ In the Properties of your NetCDF file ECHAM5_OM_A1B 2001 _2D.nc, click on

the Variables Editor , remove the variable precip as we do not need it
anymore, and add the two 10 meter wind components ul0 and v10.
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Variables Editor

gwi Ul
precip |
d |sip

tsurf
=- Remove
Combing
Ok Cancel

+ On the right side of the Variables Editor, select u10 and v10 again and click the
Combine button. If ul0 is assigned to the X component and v10 to the Y
component, confirm with Ok. Otherwise swap their assignment.

(@  Combiner Editor X

* component

Y component [v10 T
Z component i

Ok | Cancel ‘

#+ Load the resulting horizontal wind vector u10+v10* into the Main Panel window by
clicking Ok in the Variables Editor.

Variables Editor

[EcHams_om_s1B_2001_2Dnc | I fat

precip UL

gvi 2R
Add =
<- Remowve
Combine

+ Now we want to visualize the horizontal wind field with vector arrows. To do this,
right-click u10+v10*, then click Display = Vectors Slice - Create.

#+ The wind vectors also need to be projected onto the globe, so click the small
white box of the Vectors Slice module, click Projection and drop the new

connection line on the Projection module. [Or simply click JE as usual.]

(] R Legendl
= — =1l :Eff‘._l'.:.'i.!‘i-‘\.."."‘ .".."
- O Caption >
Dlsocontour Slicel=
B0sea level pressureicoll
{OBColormap Legend 21>}
{08 Caption 30

ElFrojectionl

OB Earthl

+ In the Vectors Slice Properties, shift the Scale slider to the right until it reaches
the value 5. This value range seems to be too small again to display any vector
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arrows, so right-click into the 5, click Configure there and set the Max value in the
Slider Dialog to 50000. Confirm with OK.

Froperties

o (Mectors Slice

s

| 5] 8] 2]

P

X Resolution: x [50 v |50 Siider Dialog ——[X|

X scale: K ’5—J Min value: |0f

J; Scale Z: h 5219-06 J Max value: (50000

bis Options: ™ projection [T constant M arrows T points T absolute scal| Format: Yog

$ Colorize: ’W ™ Show sub-range buttons
Cancel | oK |

Move the slider further right. Now the arrows become visible on the globe.

Change the color of the arrows into a dark gray (double-click into the colormap of
the Vectors Slice Properties).

Deactivate the countries’ borders in the Earth Properties and choose a lighter
gray for the shorelines to avoid confusion with the vectors.

By default, Avizo displays 50 x 50 arrows on the globe (see Vectors Slice
Properties > Resolution). Set the resolution to 200 x 200 arrows. Note that Avizo
doesn’t display the vector arrows by using the original grid! Internally, an
interpolation onto a regular grid is done before visualization.

If you think the vector arrows are too thin, then you can broaden them by typing in
the console:

“Vectors Slice” setLineWidth 2

The default line width is 1.

Activate and deactivate the toggle constant in the Vectors Slice module. Switched
on, all arrows have the same length, meaning they only represent the wind
direction, but not the wind magnitude. When “constant” is switched off, the wind
magnitude is additionally represented by the length of the arrows.

Turn the globe with the trackball. Search for strong high-pressure and low-
pressure regions in the northern and southern hemispheres. As you might have
expected, in the northern hemisphere the wind flows into a low-pressure region
counterclockwise (wind backs) and out of a high-pressure region clockwise (wind
veers) — and vice versa in the southern hemisphere. Wind magnitudes are higher
in low-pressure regions than in high-pressure regions.

You may also want to add a legend entry for the wind vectors. Click Create
Object - Annotations - Caption - Create and choose the text “Arrows:
Horizontal wind” and arrange your layout elements similar to the following figure
(showing the north-western Pacific in time step 1).
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01.01.2001 00:00

Surface Temperature
40 deq C

20

Isolines: Sea Level Pressure
High

l normal

<+ Save your project (called temp_slp_uv_éD.hx).

This project can also be found in the tutorial folder (filename:
TUT _temp_slp_uv_2D.hx).

Colorizing of vector arrows

You might want to represent the magnitude of the vector field (the horizontal wind
speed here) not only by the length of the arrows but additionally by a color ramp.

+ Make sure that the Colorize port in the Vectors Slice Properties is set to
Magnitude (which is the default).

Right-click into some empty space of the Main Panel, then click Create Object 2>
Other - Colormap - Create.

*

<+ Design your colormap as you like it in the Colormap Editor, then save it in your
private directory.

*

Connect your designed colormap with the Vectors Slice module by clicking on the
white rectangle of the Vectors Slice module, then clicking Colormap and release
the new connection line over your new colormap module.

<+ Finally, adjust the data range of your colormap to the data range of the horizontal
wind speed data (e.g. Vectors Slice Properties > Colormap > Edit > Adjust range).

+ Maybe you want to switch off the temperature Slice and instead switch on the
Earth Terrain (Earth Properties > Display Mode = Constant, Quality = Low).

+ Save your project again.
In the tutorial folder this is project TUT _temp_slp_uvCol_2D.hx.
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5.2. Line Integral Convolution (LIC)

We are now going to represent the horizontal wind field by a dense directional
representation - similar to the display of many stream lines. We will use the Line
Integral Convolution (LIC) method, which yields a nice continuous representation of a
static 2D vector field by convolving a random noise texture along streamlines.
Experimentally, you could achieve an image similar to a LIC rendering by visualizing
a magnetic field with iron filings.

+ In the Main Panel window, remove the visualization modules depending on
variable tsurf*. However, keep the variable itself, as opening the Variables Editor

with the horizontal wind vector u10+v10* loaded will make Avizo crash.

Variables Editor x|

gvi ulO+wl0

tsurf hon | £ S
precip
=- Remowve

Combine

Ok | Cancel ‘

#+ Switch off all the modules except for Display
Date and the Earth to get a better idea of
what the LIC is going to look like.

+ Right-click the variable u10+v10*, and then
Display > Stream LIC Slice.

+ Connect the Stream LIC Slice module with the
Projection module.

....................

Clsgcontour Slicel=

essure.ico
OB Colortnap Legend 20,

+ At the bottom of the Stream LIC Slice Properties, click Apply to compute them.
You might also enable auto-refresh to tell Avizo to apply each parameter change
automatically without pressing Apply each time. But note — the LIC texture is
computed mainly on the CPU, which can take some time for any image update.

4+ Increase the resolution to 600.

EES
+| 8| 5] 8] 2]
¥ Frame: Foshow wigtn: [ &

T options: ™ adjust view I fitto points

¥ colorize: [Nore o

£ Lic: fiter length [20 resolution [600 seed [0

¥ Hide Undefined Values: ¥

+ Keep the filter length default of 20. The higher the filter length is, the more
coherent the grayscale distribution along the field lines. Therefore, larger values
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are more attractive. A filter length of O results in a noise pattern without any
directional information.

Movies including the Stream LIC Slice

In the Stream LIC Slice Properties you'll find a port called seed that allows control of
the generation of the noise pattern. This is useful in case you want to produce videos
with a time-dependent LIC. With a seed value of 0 (default), a different random noise
pattern is used for each rendered image. With a seed value different from 0, the
same noise pattern is used for the computation of each time step, yielding a
continuous and temporally consistent vector field visualization.

+ Change the color of the shorelines to white (Earth Properties).

=+ Add a legend entry (Create Object > Annotations - Caption - Create) with
the text “Horizontal wind (Line Integral Convolution and Arrows)” and again switch
on the Isocontour Slice and Vectors Slice modules as well as the Colormap
Legend and Caption of the sea level. Now you can easily explore the interrelation
between pressure and wind field. You may want to re-arrange the legend entries
as follows:

Horizontal wind field (Line Integral Convolution and Arrows) 01.01.2001 00:00

Sea Level Pressure (Isolines)

High

l normal

Low

Remark: In the spherical projection, you will notice that the Stream LIC Slice module
cannot smoothly connect the most western boundary of the data field with the
eastern boundary — even when you have activated Copy first longitude in the
NetCDF-Control. This is caused by the method itself.

= Save your project as slp_Isocontour_Slice_LIC.hx.

In the tutorial folder you can find a corresponding project called
TUT _slp_Isocontour_Slice_LIC.hx.
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5.3. Bivariate Visualization: LIC & Wind Magnitude

The LIC texture can also be colorized — as we did for the Bar Chart Slice in chapter
4.7. We are going to colorize the LIC with the magnitude of the wind velocity first.

+ In the Colorize port of the Stream LIC Slice Properties select Magnitude.

+ Right-click into the free space of the Main Panel window, then click Create Object
- Other - Colormap - Create. Connect the Stream LIC Slice module with this

new colormap.

+ In the Stream LIC Slice Properties, click ColorMap 1 > Edit > Adjust range first.
Then you may click Edit > Options > Edit Colormap to open the Colormap Editor

and create a colormap like this one:

. Colormap Editor - Stream LIC Slice g X

0 m/S Whlte Hﬂ Colormap: @ LIC windmag.icol,| Data: |None j ﬂ ﬂJ ﬂ ﬂ

5m/s nght ye”OW fo7os818 5 10 15 20 25 [26308a

10 m/s Light green _

15 m/s Cyan E J a a A I =
[\’Ialue,m coor[[l] I opacinfTo0 % 4 50

20 m/s Dark blue

25m/s Purple

+ Save this colormap as non-indexed with the filename LIC_windmag.am.

+ Close the Colormap Editor by pressing OK.

+ Add a legend entry for this colormap (Colormap Legend) in horizontal orientation
and include the units “m/s” in quotation marks at position 30.

ED Clipping Flane 2
O8Vectors Slice  [=

OB CaptionC=}

Froperties

ty (Colormap Legend ) [

J—F Options: W custorn text [ wertical [ rel. size ™ transp.bg [ font ®| bg color
X position: x |20 y [-110

X size: length |250 width |18

$ Custom Text: |0!0 55 10/10 15/15 20420 25425 30/"m/s"

T Tide: |
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= Adjust the date, text and colormap positions according to the following figure:

Horizontal wind field (Line Integral Convolution) 01.01.2001 00:00

20 25  mis

= Save this project as LIC_windmag_2D.hx.

In case of uncertainties you will also find a similar project in the tutorial folder
(filename TUT_LIC_windmag_2D.hx).

5.4. Bivariate Visualization: LIC & Sea Level Pressure

Alternatively, you may want to colorize the LIC with a different variable, e.g. with the
sea level pressure:

= In the Colorize port of the Stream LIC Slice Properties select ColorField.

= In the Main Panel window, click on the small white box of the Stream LIC Slice,
select ColorField and connect the arising line with the slp* variable of the NetCDF
module.

= Detach the connection between the Stream LIC Slice module and the colormap
LIC_windmag.am and connect it to colormap sea_level _pressure.icol instead.

In the Stream LIC Slice module ColorMap 1 > Edit > Adjust range to > slp
Switch off LIC_windmag.am and switch on sea_level_pressure.icol.

+ #
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+ Instead of a relative colormap annotation like “high — normal — low”, you can also
define min/max values and by hand convert the unit: 203000 Pa = 1013 hPa. In

the Colormap Legend 2 Properties, you can include the units with the help of
guotation marks:

Properties

Ly (Colormaplegend2 ) [

& options: W custorntext W vertical [ rel. size W transp. bg I font ™| bg color
X position: x |20 v |-320

T size: length [150 width |18

;; Custom Text: |9]_50C'f9]_5 101300/1013 1070000070 hF

T Tirle: |

Horizontal wind field (Line Integral Convolution) 01.01.2001 00:00

Color: Sea Level Pressure

1070 hPa

#+ Save your project as LIC _slp_2D.hx.

As usual, you can find the according project, TUT_LIC_slp_2D.hx, in the tutorial
folder.
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6. Visualization of 3D Vector Fields

In this chapter, we are finally going to visualize a 3D wind field of the North Atlantic
and European area up to a height of 300 hPa (9 levels) — using vector arrows in
space (see chapter 6.1), streamlines (see chapter 6.2) and trajectories (see chapter
6.4). To enhance our understanding of the complex meteorological situation in the
troposphere, we additionally visualize some scalar variables like pressure,
temperature, and humidity.

As a reminder: Streamlines are lines in a velocity field of a steady stream, whose
tangents locally always have the same direction as the velocity vectors. Trajectories,
however, describe the paths of a particle for the time-dependent case. For steady
vector fields, streamlines and trajectories are identical. For time-dependent vector
fields, e.g. 3D-wind fields, streamlines visualize the field (as if it was stationary) at a
certain point of time, whereas the trajectories show the dynamics within a certain
time period.

6.1. Vector Arrows in Space

+ Load the NetCDF file EH_OM_A1B_3Dvectors.nc and add all of the variables in
the Variables Editor:

o0 slp (sea level pressure) is a 2D scalar dataset,

o t(temperature), q (specific humidity), and rhumidity (relative humidity)
are 3D scalar datasets and

o u, Vv, W are the three vector components of the wind, which we will
focus on in this exercise.
On the right hand side of the Variables Editor, select u, v, W and click Combine to
load the Combiner Editor and construct the resulting wind vector u+v+W* there
(also see chapter 5.1).

G Variables Editor
e Variables Editor ariables ]

-
EH_OM_ALB_3Dvectorsnc =] I flat [eH_om_a18_3Dvectarsne =] I flat

slp

4
Add -> 0 Add > rhurnidity )
<. Rermove U =- Rermove(| |u+v+uy
Y component |v B

Carmbine

Z cormponent |W b

+ Add a date and time entry in your viewer window (Right-click NetCDF-Control >
Annotate - Display Date - Create).

+ Right-click the vector u+v+W?*, then click Bounding Box and project it via qﬂ

+ Load a standard earth (Create Object > Other - Earth - Create) and project
it. Select the EQUIDISTANT_CYLINDRICAL projection.

+ Display the sea level pressure as Isocontour Slice (slp* - Display = Isocontour

Slice - Create) and enable projection for this module du:
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Froperties

& (lsocontour Slice )

?3 Spacing: " uniform & explicit

g Values: blOZOOO 103000 104000 105000 106000
I Quality: T low © medium O high @ custom
¥ Parameters: resolution |500 line width |2

$ Options: I update min-max I resample

X colormap: [0 1 Edit .

+ To add a plane with vector arrows, right-click the u+v+W= variable, click Display

- Vectors Slice - Create and enable projection also for this module uq. Load
the colormap windspeed_300hPa.icol from the tutorial folder to colorize the
arrows, and use the following additional parameters:

Properties

% (Vectors Siice )N |

I Resolution: x |30 y |20

I Sscale: [T = 700

I Scale Z: [r 71

Il Options: [ projection [ constant W arrows [ points [ absolute scale
I Colorize: Magnitude -

In contrast to chapter 5.1, where we have introduced the vector arrows for the 2D
case, the 3D arrows are now not necessarily parallel to the x-y-plane since the
vertical wind component is also used.

With the Scale Z parameter of the module, the vertical vector component W can
be scaled with factors different from “1”, such as to the “700” chosen above. Be
careful, this leads to physically incorrect representations! A scaling of 0 would be
useful for cases where only the horizontal velocity is analyzed. Caution: In the
current version of Avizo, the default for the Scale Z parameter is 8.99321 E-06.

+ To get a better picture of vertical wind distribution, add two more vector planes,

each in xy orientation. Project each U'j of them, move them with the Translate
slider to 70, 45 and 20 and make sure that they are all connected to the same
colormap (windspeed_300hPa.icol):

= [1H Disélai Datel=)

-4 FProjectionl:
OB Earth =

= pping Flane =

Olsgcontour Slicel, (0|
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Properties Properties

O . @ 1y (EpphgrEresTD [l Jranea ) [l

¥ Frame: I oshow wigth: [L | X Frame: T show with: [1 = 2 Frame: ©oshow wigth [ 4
¥ Orientation: zy xz yz * Orientation: xy ‘ xz | yz ‘ ¥ orientation: 4 2z ye:

& oOptions I™ adjust view F immediaja={__set plane

¥ s ;Il:: ]

¥ options: [ agjust view ¥ immediatpL_set piane X oprions: I adjust view M smmemF set plane

¥ Transiate: :JI:_ ﬁ ___I ¥ Transtae: 47— 3 [

+ Since this representation gets quite confusing, let’s focus on a region of interest
(Roi), which shall be the North Atlantic and Europe. You don’t have to crop your
dataset outside of Avizo to do so, instead you can define your Roi in the NetCDF-
Control Properties:

Properties

3 (Wetcorcontrol )

¥ Info: 738 time steps (time range 18628..18658.7)

$ Mode: * time step O physical time

F Time: T {1 PR

¥ Animation Rate: * afap U delayed |0 msecs

_¥ Leading Mode: T =synchronous & asynchronous

¥ Caching Mode: ™ auto  disabled " enabled

¥ Prefetching: ﬂ|' A ﬂ 3 J

$ Memory Management: Max. memory allocated for datais) | 30 |Gigabyte5 j
i_r; Longitude Roi: V¥ Active min |-90 max |3CI degrees east

¥ Latitude Roi: W Active min |2CI max |?CI degrees north

’; Height Roi: ™ Active min |CI ax |D meters [positive up)

The bounding box, as well as all other visualizations of that data file, is limited to
the longitudes and latitudes you have defined. Unfortunately, Avizo currently
resets the Scale Z parameters while selecting the region of interest, so you will
have to set these parameters again (and again).
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01.01.2001 00:00

Remark: Due to a bug in the current version of Avizo (9.0.1), you cannot animate the
wind vectors with a z-scaling other than the default value. After progressing one time
step (and after reloading your whole project), you will have to reset your z scales
manually again, because Avizo automatically sets them back to the default.

Adding a wind speed scalar

<+ To underline the 3D impression of the wind velocity, we can add an Isosurface of
the wind speed. Since isosurfaces can only be computed from scalar data, we
have to compute the magnitude of our vector field first. This can easily be done by
right-clicking the u+v+W* variable, then clicking Compute - Magnitude ->
Create. Select the new module u+v+W.mag* in your Main Panel window then and

create an Isosurface. Project it 4E select a threshold of 30 m/s, press auto-
refresh and connect its Colormap port to the windspeed_300hPa.icol colormap.
Be sure to use the same colormap limits (O and 70 m/s) as for the 3 Vectors Slice
modules. Change the threshold between values of 30 and 60 m/s and watch the
isosurface growing and shrinking.

CiNetC DF-Controll &

DHEBounding Box [=
- v 0 A OUICHPRING flane s EFrojectiont=

CEDisplay Datel>

e—— e DEEarnG

peed 300hPa =

Olsocontour Slicels o
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Threshold = 50 m/s
XY View
Time step 1

Threshold = 15 m/s
Lateral view
Time step 1

01.01.200100:00

Adding temperature — the frontal system

#+ Once you have a good overview of the spatial features of the wind field, you may
want to add other variables to your visualization. Switch off the wind isosurface
and construct a new isosurface for the t* variable (temperature), which can give
you an idea about the frontal system when you change the threshold from 290 to
220 Kelvin. Import the colormap temp_300hPa.icol from your tutorial folder and
use it for coloring the isosurface.

DEEH CM. ALE. 3Dvectorsncls (O NetCDF-Cantoll=j (0B Display Datel>)

= I Projectionl=
OB Earth[>

{OBcColormap Legend=)

B0 Clipping Flar

Olspcontour Slice

OH|sosurface 2= Efternp 300hFa.icol b=
{OBColormap Legend 2=}
i
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The following four screenshots show the frontal system from a northwestern
perspective (from Greenland to Africa): Temperature Isosurfaces at 290 K, 280 K,
270 K and 250 K.

01.01.2001 00:00

50 degC

01.01.2001 00:00

50 degC

01.01.2001 00:00

50 o 50 degC

01.01.2001 00:00
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Adding Humidity

+ Up to now we have visualized three scalar variables — sea surface pressure, wind
field and temperature. Let's add a volume rendering of the specific humidity g (in
kg/kg): right-click g* - Display - Volume Rendering - Create, project it and
choose Sampling Quality = 500 in the Volume Rendering Setting module (Note,
you will again have to enable “Advanced Settings” in order to access this
parameter!). Load the colormap g_volren.icol from your tutorial folder and connect
it to your Volume Rendering module.

45 -'I:IEDisEIaE Datel:)

Flane Z = ElFrajectionl>
OB Vectors Slice [

OB Earthl>

S Clipping Plane

\|
:\\. O8Vectors Slice 2, [=
: o

S8 Clipping Flane 4 [
OB Vectors Slice 3 [
{OBColormap Legendl=)
nel=,

\ Olsocontour Slicel= /
(EEVolume Rendering Settings l>\/

‘ {08 valume Rendering [>

= E‘Es}indsn.e.e;:}_jo.o_hl’a.jcol.l?.a)

E8g_volren.icol
{OBColormap Legend

OB |sosurface 20 Eltermp 300hFa.icol

{OBColormap Legend 2%

In the following screenshot you can see that warm and humid air masses are
transported from the south west to the cyclone over the Atlantic. The north and
north eastern regions of our Roi are quite dry.
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4+ Save your project as vectorArrows_3D.hx.

A similar script called TUT_ vectorArrows_3D.hx is located in the tutorial folder.

6.2. Illluminated Streamlines

In this exercise, we want to replace the three vector arrow planes by streamlines.

+ You can either go on working with your project from chapter 6.1 or load the pre-
defined project TUT_vectorArrows_3D.hx and save it in your folder (you do not
have writing access in the tutorial folder). Remove the three Vectors Slice
modules and their empty planes. Switch off the temperature isosurface and the
volume rendering of the specific humidity — we won’t need them until the end of
this exercise.

+ Right-click the u+v+W* vector, then click Display = llluminated Streamlines =
Create and project the resulting module by clicking dﬁ as well. To colorize the
streamlines by the wind speed magnitude (scalar), connect the ColorField port of

the llluminated Streamlines module with the u+v+W.mag* variable and the
Colormap port with windspeed_300hPa.icol.
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(EneiCDE-Controll:) DB Display Datel
OB Bounding Box [>

(DB Bounding Boxl=)
-:,.‘ /
Vet _ _
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3

B0 Clipping Flane [,
Dlsocontour Slicels,

Elvolurne Rendering Settings [
(DBVolurne Rendering ° D)-—(Elﬂq volren ic_o_\D)

{08 Colormap Legend 30}
Bfternp_3000Faicol [
08 Colormap Legend ’Iﬁl

OBIsosurface 20>

+ In the llluminated Streamlines Properties you can define the number of
streamlines that shall be visualized. Set Num Lines to 5000.

+ Each streamline shall have a Length of 10.
+ The streamline shall be completely visible (Opacity = 1).

+ In the Options port, activate the fade and deactivate the lighting options. By
fading out the streamlines, you get an intuitive impression of the stream direction
since they get grayer and more transparent at their ends.

+ With the fade mode active, an additional port called Fade Factor appears, which
you can use to define how quickly the opacity shall be reduced along a
streamline, or in other words, how quickly the transparency shall increase. The
first streamline segment always has the opacity value you have defined in the
Opacity port. The opacity of the second segment is the same value multiplied by
the fade factor; that of the third segment is the opacity value of the second
element multiplied by the fade factor and so on. You may set the fade factor to 0.9
in our example, so that the transparency of each segment increases by 10%
relative to the previous one.

Remark to fading: You won'’t be able to see any fading effect when using short
streamlines (of only a few line segments) combined with a small reduction of opacity,
because the last line segment will still have a very high opacity then. So, generally
speaking, the smaller the length of your streamlines, the smaller the fading factor
should also be.

+ Choose a very small Step Size of 0.002. This is important for the animation of the
streamlines later.

+ In the Distribute port change the distribution of the seed points from
homogeneous to proportional. Thereby, seed points are distributed proportional to
the magnitude of the vectors, so that more streamlines are passing through
regions with high wind velocity than regions with lower wind velocity.
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Froperties
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You may also want to change the Line Width of the streamlines from the default
value of 1. The Width can either be set in the Properties window or by typing the
following command in the console:

“lIlIluminated Streamlines” setLineWidth 2

In the Options port, test the lighting mode. Each streamline gets illuminated now,
increasing the 3D impression (but from some viewing angles it gets too gray and
dark this way).

Switch on your temperature isosurface and the volume rendering of the specific
humidity again including their colormaps to observe the interrelation of the four
displayed variables.

Alternatively, the streamlines could be coloured by the temperature variable: In
the Main Panel window, right-click the Illuminated Streamlines module, connect its
ColorField port to t* and its Colormap port to temp_300hPa.icol.

Animation of streamlines

+

+

*
*

The streamlines can be animated for a fixed time by clicking animate in the
Options port. The result looks like the advection of particles in a steady wind field.

If the streamlines move too fast, you can decrease their velocity to the minimal
value of 1 by entering a Console command (speed depends on the Step size):

“Illuminated Streamlines* setAnimationSpeed 1

To slow the animation down further, you may reduce the Step Size e.g. to 0.001.
Save your project as streamlines_3D.hx.

The corresponding project in the tutorial folder is called TUT_streamlines_3D.hx
again.
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6.3. Using a Surface to seed Streamlines

You might have thought that streamlines are quite interesting, but that you cannot
easily locate their position in space: which streamlines are in the front and which are
further in the background of your visualization? When too many streamlines are
concurrently visible in the scene, they will occlude each other and make it even more
difficult to understand the structures. Additionally, the interactive graphics
performance decreases because a large amount of geometric information has to be
processed and rendered.

In this chapter we are going to use a so-called Seed Surface in order to “filter the
data” before rendering by means of a data-driven streamline placement method. A
Seed Surface is a surface that is used to define the area where the streamlines are
started (“seeded”). With a cleverly selected Seed Surface, the quality of streamline
visualizations can be drastically improved, because the amount of visual clutter in the
scene is minimized while the important structures are highlighted.

Seed Surfaces can be derived from isosurfaces or Height Map Slices. As an
example, let us have a closer look at the wind field close to the frontal system of the
5°C temperature isosurface. In order to use this isosurface as a Seed Surface, we
first have to convert it into Avizo’s internal surface format with the help of the Extract
Surface function.

Extraction of an Avizo Surface
+ Set your temperature isosurface to a threshold of 278.15 K (= 5°C).

+ Right-click the Isosurface and press Extract Surface. This is a red module that
can construct a surface in the Avizo surface format with the extension *.surf.

+ In the Extract Surface Properties click Apply to compute this surface. The
computed surface is the green data module called ExtractedSurface in your Main
Panel window.

Application of a Seed Surface

+ In order to compute streamlines of the wind field with seed points across this 5°C
surface, right-click the llluminated Streamlines module in your Main Panel
window, select Seed Surface and click Create. The new Seed Surface module is
attached to the Illuminated Streamlines module and is automatically connected to
the first surface found in your project — which is the ExtractedSurface module:
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+ In the Seed Surface Properties, choose e.g. 1000 lines with a length of 10 line
segments to be distributed on the surface. If the distribution mode “At Vertices” is
chosen, the lines start at each vertex of the surface. If “On Surface” is chosen, a
user-defined number of streamlines are placed across the surface. The latter is
what we need here.

+ Retain the default balance value of 0, which results in streamlines that are equally
long in forward and backward direction. A value of -1 would indicate that the
streamlines extend in a backwards direction only, whereas a value of +1 would
indicate that they extend in forward direction only.

Tip: A balance value of +1 might be very useful if you need a screenshot for a
print publication because you cannot animate your streamlines in order to show
their direction. But if you want to examine your data interactively or produce a
video, then animation (with balance = 0) is the better way to show the direction of
the streamlines.

+ Click Apply and auto-refresh in the Seed Surface Properties to compute the new
streamlines.

Froperties

F»  (Seed Surface

X Num Lines: [ ~Jiooo |

$ Length: |'f_\ lCI| J
$ Balance: |I A 4] J

33 Distribute: On Surface ™

+ The streamlines of the Seed Surface are being constructed in addition to the
streamlines of the llluminated Streamlines module. So, if you want to visualize
only the streamlines seeded by this surface, you will have to set the number of
lines (Num Lines) in the llluminated Streamlines module to 0.
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+ In the llluminated Streamlines Properties animate your streamlines now. This
gives you a vital overview of the wind system close to the 5°C frontal isosurface.

+ In the red Extract Surface module activate auto-refresh. Now you can change the
threshold of the temperature isosurface, e.g. to 283.15 (= 10°C, see figure below)
and both the ExtractedSurface and the Seed Surface will be refreshed on the fly.

01.01.2001 00:00

-50 0
T

+ Or you might be interested in the wind field from the southern side of the front.
Below you can see the southern view on the 273.15 K (= 0°C) surface.
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+ Save your project as streamlines_SeedSurface_3D.hx.

The corresponding project in the tutorial folder is called
TUT _streamlines_SeedSurface 3D.hx.

Tip: If you want to reuse one of these extracted surfaces again in another project,
you can save them in the “HxSurface binary” format *.surf. To do this: right-click on
the green ExtractedSurface > Save Data As.
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6.4. Trajectories

As described above, trajectories are defined as pathlines of “weightless” particles in
time-dependent flow fields. The 3D velocity field is used to compute the advection of
these particles.

In Avizo, the Particle Pathlines module allows us to visualize the advection of
particles and their trajectories. For the visualization of the particles itself, two options
are available: cones (default) or spheres. Cones have the advantage that they can
show the local wind direction, similar to the wind arrows of the Vectors Slice module,
and in contrast to the vector arrows, the cone glyphs are 3-dimensional. The path of
the particles can be rendered as simple lines or tube-like structures.

+ Load the project TUT_streamlines_3D.hx from the tutorial directory and save it as
trajectories_3D.hx in your own folder. Delete the llluminated Streamlines module
and switch off the temperature and specific humidity modules.

+ Right-click the vector u+v+W?=*, then click Display = Particle Pathlines - Create
il

and enable projection =% for the module. Your Main Panel window looks like this
now:

(ENetCDE-Controll-je »(OBDisplay Date =)
OB Bounding Box[>
= ZProj ect|onl>

Elendspeed 300hFadcol )

]| Colormap Legendl=

B0+ mag* = DDIsosurfaceD S

Dlsocontour Slicel>,

EllVolume Rendering Settings =
{OBvolume Rendering I=m—« B8 g volrenicoll=)

{OBColormap Legend 2=

O8|spsurface 20

{OBColormap Legend 30)

+ In the Particle Pathlines Properties, choose a Scale Factor of 80. This factor
determines the diameter of the cone base area.

+ Choose a Size Factor of 120. It regulates the height of the cones, which should
be a bit bigger than their diameter.

+ Keep the Value Factor to 1. The particle velocity is multiplied by this factor when
particles are advected (by pressing the play button in the NetCDF-Control
module).

+ Set the number of cones to 10 x 6 x 5 (Resolution).

+ In the Options port keep the default setting for Glyph (Cone) and Direction (Use),
but set the Interpolation to Runge-Kutta (which is more complex than the Euler
method). Keep the Direction mode “Use”, which means that the particles (here
cones) are oriented according to the local velocity vector.

+ In the Trajectory port, select the Trajectory Shape Style Line and activate Keep
trace.
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+ Change the colour of the cones from yellow to opaque white (double-click in the
colormap) to increase the contrast to the underlying earth.

Properties

@ (Farticle Fathlines oy | ﬂ M
X Scale Factor: h ’EH)—J

¥ Size Facror: h WJ

X value Factor: 15 ’l—J

¥ Resolution:  x |10 y|s e

& Reser: Reset

% oOprions: Glyph [cone  ~| interpolation [Runge-kutta ~| Direction [use ~ *]
l_rC Border: ™ continuous I Clamp

¥ Trajectory:  Shape Style m W Keep trace

¥ Colormap: ,07 | lli Edit .

| % Display Box: [ Active [ visible  Reset

In your viewer window you should see 10 x 6 x 5 = 300 small cones, showing the
wind direction of the current time step (here: base time step 1).

01.01.2001 00:00

+ In the NetCDF-Control Properties move forward from time step 1 to time step 2.
The cones will move according to the local wind direction and velocity. After 10
hours, that is at time step 11 (01.01.2001 10:00), the cone particles have moved
along these trajectories:
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+ Save your project as trajectories_3D.hx.
The corresponding project in the tutorial folder is called TUT _trajectories_3D.hx.

+ As is possible with most methods, cones and trajectories can be colorized: In the

Main Panel window, click on the white square of the Particle Pathlines module,
connect the ColorField to the wind speed magnitude u+v+W.mag*, and connect
the Colormap port to windspeed_300hPa.icol.

{ODEH. OM. ALB 3Dyectorsncl;

+ OBDisplay Datel>
_ T ——— HFrojectionl=

HfVolume Rendering Settings =
{OBvolume Rendering [ o "

OB|spsurface 20

HOtemp_300hPa.icol [=

{OBColormap Legend 30

+ You will have to reset the cone particles in the Particle Pathlines Properties first

and go through the time steps again to colorize the lines of the cones.

+ If you also switch on the slp Isocontour Slice, the temperature isosurface and the

specific humidity volume rendering again, you'll get the following figure:
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The current project can also be found in the tutorial folder with the filename

TUT _trajectories_3D_Trj.hx. You may also have a look at the video
V_trajectories.mpg in the videos subfolder, showing the movement of the trajectories
from time steps 1 to 11.

Avizo Green 9.0.1 — Tutorial V2.0 DKRZ / CliSAP Climate Visualization Lab



98

7. Animations and Videos

If you want to produce a simple video with a visualization of time-dependent data with
a fixed view, you will only need the MovieMaker.

More complex animations or series of animations can be set up with the Animation
Director module. The Animation Director, previously called Animation Producer, was
first introduced with Avizo 7.1 and replaces the deprecated DemoMaker module.
With the Animation Director, you can combine and synchronize time animations,
camera rotations, and movements of 2D slices etc., as well as switch modules on or
off. Basically, all ports (parameters) of the active modules can be changed. Even
complex animations, like time animation combined with rotation of the view or a
moving camera position can be accomplished by using the Camera Orbit (see
chapter 7.1) or the Camera Path (see chapter 7.2) modules.

After you have finalized the choreography of your animation in the Animation
Director, the result can be saved in form of an MPEG-1 video or as a sequence of
single image files (see chapter 7.4).

The Animation Director module is activated or deactivated by pressing the Animation
button ES ANMATON i the toolbar or by selecting

Window = Animation. 6 7 / 5 4
/ / { /
Animation Producer / /
" v 4
S R R r._:___:_._.__..E;._‘I .
T‘-E' & '\_./‘ ; \.:/ &2 > C= [00'00'00‘ —|| [22:00 00:14 00:28
el LLL L L LU PR IR P RPNl
rrent Animation: | Newanimation | [# {4 Add special event | «f £
- MetCDF-Control | A
Time: value Y e ®
r

Control bar 3 /

(Animation Director) toolbar
Event list

Timeline

Master Time Slider

“Movie Creation” Menu
“More Options” Menu

N Ok

A new widget becomes visible, hosting the
Animation Director’s user interface. R B 8 — —
Clicking on the stopwatch button in the Lttt Sonpets e et e
Properties of a module creates a new IS -
keyframe in the Animation Director timeline |t= oosooo ] | 1285 | & W@ |
and the event is listed in the left panel of b |
the user interface. If you hold the mouse

cursor above the small orange diamond symbol # in the timeline panel, it will
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activate a small input field where you can adjust the time and the accompanying
value for the port that it's associated with.

In order to adjust the schedule, you can simply drag the diamond icon to the desired
position on the timeline.

Time Management: In order to define s roce

the length of your animation storyboard, |®@® < (» @& e | 01:00.000 [%]
you can open the “More Options” menu . [——m e o EXTETEE | o))
(7.) and set parameters such as the start | ™= o r
and end time and number of frames per Bdtee: ovmao | SeseaResutm: o0 [om
second. el ——— L}l

. T —

7.1. Toggle Modules on/off and Camera Rotation

We are going to animate our project of chapter 4.7 (Bar Chart Slice of precipitation
colorized by the temperature field) for the summer months June to August 2001. In
this animation, we will start with the temperature Slice only in an XY view (top view),
then rotate it 45° backward and at the same time switch on the Bar Chart Slice and
finally watch oblique views from the left and right side. For a better orientation you
may want to view the final video in advance in a Media Player: prec_temp_2D.mpg.

+ Open the project TUT temp_prec_2D.hx from your tutorial folder.

+ Switch off the Bar Chart Slice and its Caption 2 and switch on the Slice including
its colormap and Caption.

Put the Slice into XY View.
Open the NetCDF-Control Properties panel.

#+ +

+ From the toolbar, click on the Animation Director button &2 ANMATON  \We want
to animate the months June to August within the whole time period, that is, time
steps 605 (01.06.2001 0:00) to 972 (31.08.2001 18:00):

= In the NetCDF-Control Properties panel click on the stopwatch button left of
Time and choose Time: value. A new keyframe appears in the left panel of the
Animation Director user interface, called NetCDF-Control -- Time: value.

» |n the Animation Director user interface, move the mouse above the orange
diamond icon # and set the second value to 605.

= Move the mouse on the timeline to 60 seconds; double-click in the line of the
NetCDF-Control Time: value, which will insert a new keyframe. Move the
mouse above the new keyframe and change the second value to 972 (the first
value should be t=01:00:000).

= Move the Master Time Slider back to the start (t=0) and click on the play
button in the control bar.
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Animation Producer
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+ During the time 00:00 and 00:15 the Slice should be inclined 45° backwards.

In the main menu bar, click Project - Create Object > Animations And
Scripts > Camera Orbit - Create.

In the Camera Orbit Properties

Properties, you may test | 5 4 EETETT® @O

the five offered 360°
rotations. Finally, select | * & Time A" >[r]ss .|

x-axis, set the size of the | ¥ @. Action: recompute| [x-axis -]

Viewer Window and its
contents as you like, and click recompute.

In the Camera-Orbit Properties click on the stopwatch left to Camera-Orbit
and choose Visibility in viewer 0.

In the Camera-Orbit Properties click on the stopwatch left to Time and
choose Time: value.

In the Camera-Orbit Properties click on the stopwatch left to Action and
choose Action.

In the Camera-Orbit Properties click on the stopwatch left to Action and
choose Action: recompute.

In the Animation Director user interface event list, move the mouse above
the first orange diamond icon of the Camera-Orbit Time: value keyframe.
The first value should be 00:00:000 and the second 0.00. At 15 seconds,
double-click in the timeline event list and move the mouse above the new
keyframe icon to set the first value to 00:15:000 and the second value to
45.0.

Move the mouse above the orange diamond icon of the Camera-Orbit Action
entry. The second value must be x-axis.

Move the Master Time Slider back to the start (t=0), click recompute in the
Camera-Orbit Properties, and click on the play button in the control bar.

Anirmation Producer

]
Ix

e - T ﬁ+ M ] =
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Carnera-orhit T C C
Visibility in viewer O < w |
Time: value Sy oo Y
Action: recompute 3 | |®
Action < W |
4 | ?

4+ After 10 seconds of the rotation, we want to switch on the Bar Chart Slice and its
Caption and switch off the Slice. We must add four events to do so:
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= In the Caption Properties click on the stopwatch left to Caption and select
Visibility in viewer 0.

= In the Animation Director user interface event list move the mouse above the
first orange diamond icon of the Caption keyframe. The first value should be
00:00:000 and the toggle should be set to on.

= At 10 seconds, double-click in the timeline event list and move the mouse
above the new keyframe icon to set the first value to 00:10:000 and set the
toggle to off.

» Respectively, you can switch off the Slice using the stopwatch left of the
Properties of Slice — Visibility in viewer 0. Go on as previously described.

= In the Caption 2 Properties, click on the stopwatch left of Caption 2 and
select Visibility in viewer 0.

= In the Animation Director user interface’s event list, move the mouse above
the first orange diamond icon of the Caption 2 keyframe. The first value
should be 00:00:000 and the toggle should be set to off.

= At 10 seconds, double-click in the timeline event list and move the mouse
above the new keyframe icon to set the first value to 00:10:000 and set the
toggle to on.

= Respectively, you can switch on the Bar Chart Slice using the stopwatch left
to the Properties of Bar Chart Slice — Visibility in viewer 0.

= Now, play the animation. Don't forget to click recompute in the Camera-Orbit
Properties before you start the animation.

Animation Producer
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Caption o P
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Visibility in viewer 0 *F T |9 &
Caption 2 ] :
Visibility in viewer 0 er @ (@ &
Carmera-Orhit 0]
Visibility in viewer 0 @ @ [
Time: value *F T | L g
Action: recompute < o |«
Action < W e
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+ After the inclined view on the Bar Chart Slice is reached by the time 15 seconds,
we want to change the camera position again and watch the animation from both
sides. To do so, we rotate the figure around its z-axis about 40° to the right, go
back, and then rotate it by 40° to the left.

In the Animation Director’s user interface:

» Insert a new keyframe to the Camera-Orbit Action (double-left-click) at
t=14s. The second value must be x-axis.
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» Insert a new keyframe to the Camera-Orbit Visibility in viewer 0 at t=14s
and toggle it off.

» Insert a new keyframe to the Camera-Orbit Action (double-left-click) at
t=15s. The second value must be z-axis.

= Insert a new keyframe to the Camera-Orbit Visibility in viewer 0 at t=15s
and toggle it on.

» Insert a new keyframe to the Camera-Orbit Time: value at t=15.040s and
set the second value to 0.0.

» Insert a new keyframe to the Camera-Orbit Action (double-left-click) at
t=19s. The second value must be z-axis.

» Insert a new keyframe to the Camera-Orbit Visibility in viewer 0 at t=19s
and toggle it off.

= Insert a new keyframe to the Camera-Orbit Time: value at t=19s and set
the second value to 40.0.

» Insert a new keyframe to the Camera-Orbit Action (double-left-click) at
t=20s. The second value must be z-axis.

= Insert a new keyframe to the Camera-Orbit Visibility in viewer 0 at t=20s
and toggle it on.

» Insert a new keyframe to the Camera-Orbit Time: value at t=20s and set
the second value to 360.0.

» Insert a new keyframe to the Camera-Orbit Action (double-left-click) at
t=25s. The second value must be z-axis.

» Insert a new keyframe to the Camera-Orbit Visibility in viewer 0 at t=25s
and toggle it off.

= Insert a new keyframe to the Camera-Orbit Time: value at t=25s and set
the second value to 320.0.

e}
x
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+ Watch the whole animation by pressing the play button. If the rotations differ from
what you have intended, make sure that you have put the view into starting
position (View XY) and that you have clicked recompute in the Camera Orbit
Properties in advance.

+ Save your project.
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You can find this project in your tutorial folder: AnimProd_temp_prec_2D.hx. To
export this animation to an mpeg video file, see chapter 7.4.

7.2. “Flying Cameras”: Using Camera Path

The Camera Path module allows you to move the virtual camera through space,
while the Camera Orbit module, which we got to know in the last chapter, only allows
rotating the camera around the center of the viewing space.

We are going to use the Camera Path module for our visualization of chapter 4.11->
(Current speed as Embossed Slice). We will set up a camera path, starting from a
European view flying to a perspective view onto the Gulf of Mexico.

4+ Open the project TUT current_ Embossed Slice_2D.hx (result of chapter 4.11).
Choose a view onto Europe to start with.
#+ Click Create - Animations And Scripts - Camera Path - Create.

#+ To define a path, open the Camera Path Editor IEI from the corresponding
Properties panel. A new viewer, Viewer 5, opens. This could be used to visualize
the positioning of your main camera (viewer 0) relative to the objects in your
visualization. Move it aside, so that you can completely see your main Viewer.

+ Zoom in a little bit, so that the whole Earth fills the viewer, and choose this view
as the first keyframe of your Camera Path by clicking add in the Properties panel.
Avizo adds a red vertical line in the Camera Path time slider at position 0.00 and
jumps to the next position (10.00).

;Eo::a':m_‘_m:e--!-ﬁ-ﬁz;mw.:m;“:” mwum oject I3l 5 Oraph View [ %ee View | [Ihide Panets [ Main Paned - [] Properts -] Cansate ] Cslormusn - [ Anenation Producer - [ Help

- Olo e s 08|

T Camera Pathc 0 kayfraenas net catad). fotal tens 0.0
IF
¥ <l ) < m| o) 5|5

F aca | remove | circu pan| constvescey|

R e R )

#+ Then, use the navigation tools (Trackball, Translate, Zoom, ...) to add two further
views as keyframes.

=  One view across the Atlantic Ocean.

Avizo Green 9.0.1 — Tutorial V2.0 DKRZ / CliSAP Climate Visualization Lab



104

ﬂokunmuommwmnnwwﬂmmnkam s
iagmno_au e ool wow project il open Project - B Save project - EalPreterences | | [ craphview () Wee view | [ bide Panats | [55] Main Panel -_,_]Pmum [ consowe - ] Colorman mmmmm« um

e T e T

e
1 G Wl

§ Camera Pathc 3 uayframes inct ciosed). total e 200

BF

vﬂJJJ_I_iJ

X D | Dremota)| vt anatmci]

e OB0 e ah 8Os Woere OB

= View on the Caribbean Sea

e Eot Prowcl Create Wew Window  Xfare f(Screen Kleam ke /
Efopenbata [Tcoeo | ElNewpoect Bl openfroject B save roject I Preterences | [<aiGopn View [T Tee View | [ tade Panets | [==| Main fanel B Properties -] Conscle [} Coorman (7 anenation Producer [l Hep
x ;

N )
Bcuect soasdcolD)e” (o) o —

3 EFEEET [ rﬁgﬂﬁ

F camera Path: 3 keyframes (nol clased). total me 200

¥ {E
"' ﬂﬂﬂﬂﬂﬂﬂ

| | ot e weks)

oy [T 880 d D ® BB -0-8

Jan 1960

<+ |f you want to change one of your keyframes, you can use the forward and
backward buttons in the Properties window. Use these [ - _] to jump to the

last or next keyframe (red line). Use these L] [: to go forward and backward
in small individual time steps to watch the frames Avizo computes automatically

between the keyframes you have defined. Use the outer pair of buttons a»

to watch your flight as an animation that you could stop by clicking LI

+ You might realize that the camera moves faster between keyframes 1 and 2 than
keyframes 2 and 3. If you wish to get a constant flight velocity, click the button
“const velocity” — then Avizo computes a smoother flight.
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+ After closing Viewer 5, you can watch your flight again by clicking the play button
in the Camera Path Properties.

Properties

8 o
J; Camera Path: 3 keyframes (not closed). total time 20.0

T Time: <|<|FV|WJ

After defining the camera path, you should save it. To do this: click File > Save
Project and Avizo will prompt you to save the Camera Path. Choose
PathToCaribbean.civ as the file name.

Once the Camera Path is saved, you can include it in an animation. Click on
B ANMATION 19 open the Animation Director.

In the Camera Path Properties, select the stopwatch to the left of the Camera
Path module name and click on Visibility on viewer 0. Click on the stopwatch to
the left of Time and choose Time: value. In the Animation Director event list,
insert a new keyframe and set the first value to 00:20:000 and the second to 20.0

Anirnation Producer ZES

LIRS, \_’/ & 00:22.160 H 9:00 00:12 £0:24 00:36 00:48 o100 | &

— L Loy B IR il o

Current Animation: | Newanimation ~| [$ [ |+ Add special event_| - ¥ -

- Carnera-Path W v

Visibility in viewer 0 i¢ | & 2
Time: walue % |ofRE S @

After we have reached the Caribbean, we freeze the camera position for a short
time of 2 seconds and then play a time animation from time steps 1 to 30 (Jan to
March). Select the NetCDF-Control Properties. Click on the stopwatch left of Time
and choose Time: value. In the Animation Director event list, select the keyframe
of the NetCDF-Control entry and set the first value to 00:22:000 and the second
to 1.0. Move the mouse to 00:40 on the NetCDF-Control keyframe line and

double-left-click to create a new keyframe. Set the first value to 00:40:000 and the
second to 30.0.

Animation Producer

B8\ 4 \!/ 82 >C= 00:00.000 }Ei 59:00 0012 00:24 00:36 0043 o100 | &
=t | Litiaiiiniig Litiiiinaing Linviiniiiig Lobiuininiihps

Current Animatien: | Newanimation | [# [  + Add special event_| ke 2

- Camera-Path @ &
Visibility in viewer 0 * . # e
Time: valug b O\ &

NetCDF-Cantrol @

Time: value ¢r @ & o +

+ Save your project.

The pre-defined version is called AnimProd_current_Embossed_Slice_2D.hx. To
produce a movie from this demo, see chapter 7.4 for details.
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7.3. Moving 2D slices; changing Threshold and Transparency of
Isosurfaces

In this exercise you will combine four kinds of animation:
a) You will learn how to shift three differently oriented Slices of wind velocity.

b) You will be able to change the threshold of an Isosurface that begins by
representing a wind velocity of 60 m/s and “grows” to an Isosurface of 30 m/s.

c) Three nested Isosurfaces representing the wind speed at 30, 40 and 60 m/s will
be visualized, alternating between completely opaque and transparent.

d) Atthe end of this animation, take the time dependence of the data into account
again and show the change of wind velocity during the first 60 time steps in
January (1.1.2001 0:00 — 15.1.2001 18:00).

To get an idea of the animation, you may watch it in advance. Have a look at
V_windspeeds.mpg.

+ Open the tutorial project TUT_windspeeds_3D.hx (which is basically the result of
chapter 4.19 with a somewhat simplified and modified Main Panel window).

+ Enable the Animation Director user interface in your project (click on the
Animation button below the main toolbar).

a) Moving three Slices in xy, xz and yz orientation:

+ Create a new Caption (Create - Annotations—> Caption - Create) “Moving
Slices in xy, xz and yz orientation” on top of the viewer.

+ Switch on Slice 2 (the one in XY orientation) and Slice 3, Slice 4 and Slice off.
Switch off all Isosurfaces.

+ In the Slice 2 Properties click on the stopwatch left of Slice 2 and select Visibility
in viewer 0. Click on the stopwatch left to Translate.

+ Until the point of time 00:10, Slice 2 shall be moved to the top of the grid (level
16) and then back down to level 4 until the time 00:20. In the Animation Director
event list of Slice 2 Translate, move above the keyframe and set the first value to
00:00:000 and the second to 0.0. Move the mouse to 00:10, insert a new
keyframe (I-click) and set the first value to 00:10:000 and the second to 16.0.
Move the mouse to 00:20, insert a new keyframe (left-click) and set the first value
to 00:20:000 and the second to 4.0.

Animation Producer & X|

|l O | .
SN/ d./ \:/ & '-"-0 = 00:00.000 H 0300 00i14 ooiza 00i42 00‘56 o ®
............................................................. i
Current Animation: |NewAnimatiun j ¥ W+ Addspecial event_| o {} i}
=l Slice 2 o 2
Visibility in viewer 0 < w9 7
Translate *F wW|e & &

+ Go on as described before and add the Slice 3 in XZ orientation and move it from
rear side (position 95) to position 70 during the time period 00:20 to 00:25.
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+ Now, switch on the Slice 4 in YZ orientation and move it from the left wall to

position 175 during time interval 00:25 to 00:30.
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s d e o= - + o
WL < \!/ &2y li&l 00:34.680 000 0014 00:28 0042 00:56 o &,
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b) Growing isosurface

+ Change the titles visible in your Viewer window — switch off the Caption saying
“Moving Slices in xy, xz and yz orientation” and create a new Caption (Create ->
Annotations - Caption - Create) saying “Growing Isosurface: Wind Speed
Threshold falling from 60 to 30 m/s”.

Animation Producer =]
B e [—00_34 680 E‘ o
S NAN AN S oA T =] o000 00:14 00:28 00:42 00:56 ol @

A Lienincnien b beiceg oo e b s
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- Slice 2 w 2 ]
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Caption 5 il
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+ Additionally we create a new Isosurface, set the Draw Style to shaded and the
colormap to a single yellow color. Reduce its threshold during time period 00:30
to 00:40 from 60 to 30 m/s. Don’t forget to set auto refresh in the new Isosurface’s
Properties.
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'*- Test the anlmatlon_ At tlme Growing Isosurface: Wind Speed Threshold falling from 60 to 30 m/s

01.01.2001 00:00

00:40 your viewer window
should look something like this:

+ In the Animation Director, switch
off the yellow Isosurface and its
Caption at time 00:40.

c) Nested Isosurfaces

<+ Switch on Caption 4 and change it to “Nested Isosurfaces at 60 (purple), 40
(blue) and 30 (green) m/s”.

| Caption 4 o :
Wisibility in wiewer 0 {7 O SR EEEEEE TS
Text 4 é 3 m “0 BN e e 0
=] 4] = | ?

#+ At time points 00:45, 00:50 and 00:55, the isosurfaces, one after the other, shall
be switched on: the purple isosurface (60 m/s), the blue one (40 m/s) and finally
the green one (30 m/s). Make sure that the Draw Style for the blue and green
isosurfaces is set to transparent.
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But in this way, only the outer isosurface will be visible during the animation. With
all three isosurfaces switched on, change the Draw Style of the outer green one
from shaded to transparent at time 01:00 and for the blue one at time 01:05. To
do this, you have to click the stopwatch left of the Draw Style in the Isosurface
Properties and choose Draw Style: style. In the Animation Producer event list,
change the draw styles from shaded to transparent. Keep the inner purple
isosurface opaque (shaded). Now, all three isosurfaces are visible at the same
time (nested).
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+ During time interval 01:10 to 01:40, you may now animate the first 124 time steps
representing January 2001. In the Animation Director set the Master Time Slider
to 01:10. Select the NetCDF-Control Properties and click on the stopwatch left of
Time and choose Time: value. Add another keyframe at 01:40 and set the second
value in the right keyframe of the NetCDF-Control entry of the Animation Director
to 124. For a better overview, it is possible to collapse the Animation Director
event list entries.
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+ The three Slices and the underlying Earth might bother you while watching the
jetstreams closely — so turn them off at time point 01:25 for the last part of your
animation. To turn off the Earth you have to select the stopwatch to the left of
Earth in the Earth Properties. Choose Visibility in viewer 0.
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+ Finally, play the animation in the Animation Director and check if everything works
as you wish.

Remark: One of the limitations of the Animation Director is that you should not delete
or rename any modules of your project after the Animation Director animation was
set up. Internally, Animation Director produces a script which contains the names of
all used modules. Even the deletion and re-insertion of a module with the same name
can lead to mismatches.
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At the times 01:15 and 01:40, your visualization should look similar to these figures:

Nested Isosurfaces at 60 (purple), 40 (blue) and 30 (green) m/s
06.01.2001 06:00

&

Nested Isosurfaces at 60 (purple), 40 (blue) and 30 (green) m/s
31.01.2001 18:00

S
| l\llL\\g\@mm\\\\W\

= In the Animation Director click on the Play Loop button to set the animation to a
repeat mode. An animation re-starting at the beginning automatically might be
useful for presentations at fairs or conference stands. But please remember to
reset the animation to Play Once mode before starting a video export. The Play
Swing button will endlessly run your animation back and forth.

= Save your project, including your Animation Director “choreography”, as
windspeeds_3D.hx.

This project stage can also be found in the tutorial folder
(AnimProd_windspeed_3Slices_3D.hx). If you want to export this animation to a
video file, continue in chapter 7.4.

7.4. Video Export (MovieMaker)

With Avizo, you can produce mpegl videos only — other video formats like mpeg2,
mpeg4, mov, and avi are not supported up to now. In principle, all videos are created
by the MovieMaker module. During the export, the animation is played step-by-step;
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snapshots of your current screen are taken automatically and concatenated one after
the other to the *.mpg video file.

Generally, many different digital video formats are commonly used. They differ e.g. in
the frame rate, the resolution, the bandwidth and the encoding algorithm. Depending
on the application (web, PowerPoint presentations, TV, cinema, podcast, etc.),
different requirements in respect to quality and file size have to be met. Although
mpegl is a relatively old standard with some limitations and, to be honest, not the
best codec quality, it has a great advantage for us: It runs basically on every PC and
can be imported into Microsoft’s PowerPoint.

For more information you might start with these links:

e http://en.wikipedia.org/wikiiMPEG-1

e http://www.paradiso-design.net/videostandards _en.html

e http://www.b-i-t-online.de/archiv/2000-01/nach2.htm (German only)
e http://www.biff-filmfestival.de/bildformate.html (German only)

Before creating a video, it is useful to turn your screensaver off (e.g. Linux:
Applications > Preferences > Screensaver) because the snapshot function of the
MovieMaker always takes a “photo” of the current screen, so after some time the
screensaver may override your animationand you will then have to start over from
scratch with your video export.

Unfortunately, you cannot work within other windows within the same X-Display (or
RGS Session) — you will have to keep the Avizo window open until the end of the
video export.

7.4.1. Videos of simple Time Animations

A simple time animation can be exported quickly without making a detour via the
Animation Director. Now you are going to do this to get the result of chapter 4.11.
You may preview the video you are producing here in a video player:
mov_current_Embossed_Slice_2D.mpg

+ Load the project TUT_current_Embossed_Slice 2D.hx from the tutorial folder.

+ In the Main Panel window, right-click the NetCDF-Control, then click Compute -
MovieMaker - Create.

+ In the Filename port of the MovieMaker Properties define a path and filename to
which the video shall be stored. You might call your video
current_Embossed_Slice.mpg.

+ Set the target screen resolution for your video. You can choose one of the
following ways:

o Click Custom in the Size port and enter a Resolution of e.g. X =768, Y =
576. This solution has two disadvantages: First, your layout will be different in
other resolutions and you cannot see the new layout in advance. Some
elements might get partly or completely lost, others will be too big or too small.

o Alternatively, you can change the viewer size by hand (drag & drop the viewer
sides) and hope to catch a width of 768 and a height of 576. Remark: You will
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have to activate another module in your Main Panel window and then go back
to the MovieMaker Properties to see which current resolution has changed,
because Avizo does not refresh the parameters on the fly.

0 As a third option, you can change the current resolution of your viewer by
typing the following command in the console:

viewer setSize 768 576

But this command will only work when the viewer is in top-level position. To
set your viewer in top-level position, click Edit > Preferences > Layout > Show
viewer in top-level window. But this might end up causing slightly different
values in the MovieMaker’s current resolution “because of the window
decoration and the window frame” (respective section of Avizo online help).

+ Now you only want to animate January to September, defined by the first 92 time
steps. In the NetCDF-Control Properties, right-click into the Time slider, click
Configure, and enter a Sub Max value of 92. When playing the animation now, it
only runs until Sep 1960.

+ Back in the MovieMaker’s Properties, set the Frame Rate to 25 frames per
second. 25 frames per second are fast enough to give the impression of fluent
motion.

+ Set the total number of Frames to 575
frames

. S€C__ _ 575 frames
timesteps

sec
so that your mpegl video gets a duration of 23 seconds:

92timesteps e 25

4

575 frames  92timesteps

o5 frames 4tlmesteps

sec sec

+ In this animation, there are only moderate changes from frame to frame. We have
used a fixed camera position and there are no drastic changes in the data from
time step to time step. Therefore you can take a compression Quality of 0.2 or
even less. The smaller the compression quality, the stronger the compression,
and the smaller the size of your resulting mpegl1 file.

+ Finally, in the Viewer port of the MovieMaker Properties, select AntiAlias1 as
standard. This parameter helps to reduce flickering. If your animation flickers
much — e.g. in case of camera movements — you should even choose AntiAlias3
or even AntiAlias4 here.

+ Click Apply to start the export.

= 23sec
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Properties g x|
4, (FovE MRS 8| ?

’; Info: Frames: 575 - Total time: 23.0 5 - Frame rate: 25 (fixed)

¥ Viewer: |Viewer0 j ‘Antimias 1 j

& File Formar: |MFEG rmovie =
?; Filename: |ker_current_Embossed_SIice_BD.mpg Browse

¥ Frames: ﬂ| A ﬂ|5?5 J
¥ Frame Rate: (25 ~
’; Quality: |' N ,TJ
T 1ype: |monoscopic j
& Formart: & RGE  RGBA
X Tiles: x |1 v 1
T Size: @ Viewer  360p ( 4B0p ¢ 720p ¢ 10B80p  Custom
& Resolution: ¥ |788 ¥ [s76
™ auto-refresh
Exercise:

A dataset with time stepping of 3 hours shall be exported to a video file for June —
with a frame rate of 25 frames per second playing one day in a second. How many
frames need to be chosen? What is the difference when you have 6 hourly data?
Answer

7.4.2. Videos of Complex Animations

This chapter shows how to export the animations that have been prepared with the
Animation Producer in chapter 8.

Export of AnimProd temp prec 2D.hx
Export of AnimProd _current Embossed Slice 2D.hx
Export of AnimProd windspeeds 3D.hx
Export of AnimProd_streamlines 3D.hx

Export of AnimProd_temp_prec_3D.hx

+ Load project AnimProd_prec_temp_2D.hx (File > Open Project).

+ If necessary, move the time slider to time 00:00.000.

+ Set the Viewer to XY View and click on recompute in the Camera Orbit module
*

In the Animation Director, click on the Movie Creation button ¥ . The panel
contents switch to Movie Creation which represents the MovieMaker module.

Enter prec_temp.mpg as Filename in Movie Creation.
Change the Resolution to 768 x.

+ Choose AntiAlias2 and a compression Quality of 0.5, since the visual content of
this video changes quickly.

+ Set the total number of Frames to 2300, so that your video gets a total length of
92 seconds. With 4 time steps/day, we get 4 * (30+31+31= 92 days) = 368 time
steps. In the resulting video, this yields 4 time steps per second.

-+
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+ Click Create Movie to create the video.

Animation Producer

W 4> @ @ozl [00:00.000 P
- S

Current Animation: |NewAnimati0n j F i  + Add special event,( ﬂ) -ﬂ-
N —g

Movie Creation

Info: Frames: 3000 - Total time: 120.0 = - Frame rate: 25 (fixed)

Viewer: [viewero x| [antisias2 x| >
File Format:  |MPEG movie ~ &
Filename: |4SIAVizo!Moviesfprec_temp.mpg.mpg Browse z: 2

Frames: ﬂ Aﬂ 2300| J

Frame Rate: |25 T

Quality: [r = 05 J

Type: |m0nosc0pic j

Format: # RGE  RGBA

Tiles: x |1 ¥ 1

Size: & Viewer © 360p C 480p ¢ 720p ¢ 1080p  Custom
Resolution: X |768 v |s76

? Create Movie ‘

Export of AnimProd_current_Embossed_Slice_2D.hx

+ Reload your project AnimProd_current Embossed_Slice_2D.hx (File > Open
Project).

+ Remove the orange boundary frame in the visualization by typing the following
command in the console:
“Height Map Slice” frame off
Hint: Even if you did this earlier in the exercise — you'll have to repeat it after re-
opening the project, since Avizo unfortunately does not save this command in the
script.

+ In the Animation Director module click on the Movie Creation button & )

4+ In Movie Creation enter the Filename
AnimProd_current_Embossed_Slice_2D.mpg

+ You might want to select the following parameters and click Create Movie.
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Animation Producer

¥@OP®® @ik [o0:00.000 £ PR
Current Animation: [NewAnimation v] B [u] [ + Add special EVEHtv] ':,‘ 111l

Movie Creation

Info: Frames: 1000 - Total time: 40.0 s - Frame rate: 25 (fixed)

Viewer: [Viewer 0 = l [AntiAIias Dl l b

File Format: | MpPEG movie 2
Filename: ‘rod_current_Embossed_Slice_2D.mpg
rames:  [4][F———[» 1000 ||

PN

Frame Rate: E

Quality: I T 0.4 D

Type: [monoscopic = l

Format: @ RGB RGBA

Tiles: X1 Y 1

Size: Viewer 360p 480p @ 720p 1080p Custom
Resolution: 1250 ¥ (720

Export of AnimProd_windspeed_3Slices_3D.hx

+ Reload your project AnimProd_windspeed_3Slices_3D.hx (File > Open Project).

In the Animation Director module, click on the Movie Creation button & .
In Movie Creation, enter the path and Filename windspeeds.mpg.

Define the following parameters and start the export by pressing the Create Movie
button.

- #

Animation Producer

CICIOICIO <) 00:00.000 1] (u—

.m ﬂ ITRRRNRRRRNNRE)

Current Anirnation: |NewAnimati0n j ¥ [ + Add special event,

Mowvie Creation
&

Info: Frarmes: 2500 - Total time: 100.0 s - Frame rate: 25 (fixed) 5 @

Viewer: |V\ewer0 j |AntiAIias2 j

File Format: [MPEG movie ] ®
Filename: |040451A\.rizo!Movies!windspeedslmpg Browse B f R
Frames: ﬂ#ﬂWJ @
Frame Rate: |25 ¥

Quality: [r ~ 05 J S

Type: |monoscopic j
Forrmat: & RGE  RGBA @
Tiles: x 1 ¥ 1 —
@
Size: # Viewer  380p  480p  720p ¢ 1080p O Customn S
Resolution: % | 768 v [578
S

? Create Mowvie »
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Export of AnimProd_streamlines_SeedSurface_3D.hx

*

*

Reload your project streamlines_SeedSurface_3D.hx or the example project
TUT_streamlines_SeedSurface_3D.hx (File > Open Project).

Before exporting a video from these streamlines, we should significantly reduce
the speed of the animated streamlines, because the frequency in which
screenshots are taken during the video export is much slower than the frequency
in which Avizo delivers picture updates of the streamline animations. To reduce
the speed of the streamlines, first type in your console:

“Illuminated Streamlines” setAnimationSpeed 1

Second, reduce the step size in  [Foserties
the Illuminated Streamlines % (), (Uminsted Sreamines ) [ a|
Properties to 0.0005. ¥ @. cotormap: [0 o I [ et
Additionally, you will have to PO wumtines: [0 _|
prolong the streamlines in the E g Lengrn :A ‘“’ﬁj
Seed Surface Properties 5 o | . A‘;_gy J
because they are extremely X seisee [ s
short now: & seea: .
I (i), options: P fade I lighting W ianimate,
Eoperties I @), Dist Res: [32 [32 [32
o — B @ oistribute:  [proportional ]
FO wumtines: [— 5[50 isplay Box: ctive isible ese
;T‘; S i A:ZOO j I 1. Display Box: [ Active [ Visibl Reset
F @ palance: | = [o |

’; @ Distribute:  |On Surface ¥

In the NetCDF-Control set a sub-range of 1 to 25 only.

Open the Animation Director by clicking on B ANMATION
Move the time slider to time 01:00.000. In the NetCDF-Control module, click on
the stopwatch symbol next to Time and select Time:value.

In the Animation Director time line, hover over the orange keyframe at 01:00.000
and set the second value to 25. Move the time slider back to 00:00.000 and check
if the second value of the keyframe is 1 (first time step).

In the Animation Director, click on the Movie Creation button ¥
In Movie Creation enter the path and FilenamestreamlineSeedSurface_25ts.mpg.

In Movie Creation select the following parameters and afterwards press Create
Movie. Your video will show animated streamlines of one time step and then
move on to the next time step (the streamlines one hour later):
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Animation Producer

W& > e @oz [o0:00.000 B W

Current Animation: |NewAnimation j ¥ [+ Add special event,| e ﬂ-

Mowvie Creation
@
Infa: Frames: 1500 - Total time: 60.0 s - Frame rate: 25 (fixed)

Viewer: [viewero ~»| |antimias3 <]

File Format: MPEG movie ~
Flename: [iesssireamiineSeedSurtace_25tsmpy  Browse
Frames: - | A P | 1500

Frame Rate: [25 T

Quality: [T ~ 06 J

Type: |m0noscopic j

Forrnat: # RGB ¢ RGBA

Tiles: x 1 v 1

Size: & Viewer © 360p © 480p  720p ¢ 1080p  Custom
Resolution: % [768 v |578

? Create Movie

+ Save the project as AnimProd_streamlines_SeedSurface_3D.hx in your personal
folder.

7.4.3. Playing back mpegl videos

There are two common ways of playing and presenting your mpeg1l videos:

a) Download the *.mpg file onto your local computer and play the file with a video
player like VLC Media Player, Windows Media Player or others.

b) Download the *.mpg file and include it in a PowerPoint presentation (Insert >
Video > From File).

Remark: Since older PowerPoint versions do NOT include the *.mpg file in the
*.ppt file but only link to the *.mpg video file, you must make sure that the
video file *.mpg is in the same folder as the *.ppt file. Remember to copy both
files when you give your talk from a different computer than yours.
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Annex

8.1. Answers

(1) Metadata with ncdump:

There are 6 variables in this NetCDF file including the surface temperature tsurf,
the precipitation precip, the 10m wind components ul0, v10, the vertically
integrated water vapour qvi and the mean sea level pressure slp.

The file spans 1460 time steps (see under dimensions), in hours since 1.1.2001 at
0:00 (see variables > double time (time) > units = “hours since 2001-01-01 0:00%).
Further down, under data > time, you can see that time is given in 6-hour time
steps until 8754 hours after the reference date, which is 31.12.2001 18:00. Thus,
the file exactly covers the entire year 2001.

The unit of variable gvi (vertically integrated water vapour) is kg/m2.

Under global attributes > history you can see that this NetCDF file has been
created by merging 6 individual variables (merge). Before, at least one of those
files was converted into relative time format (-r), its longitudes were reset from the
value range [0;360] to the value range [-180;180] (selindexbox), and the original
GRIB-Format was transformed into NetCDF file format (-f nc).

The NetCDF file ECHAM5 OM_A1B 2001 2D.nc does not contain a vertical
dimension (neither height levels nor pressure levels); all 6 variables are 2-
dimensional and time-dependent (latitude, longitude, time). The NetCDF file
ECHAM5_OM_A1B 2001_3D.nc, however, includes 17 vertical levels (see
dimensions), namely, the following pressure levels in hPa (there given in Pa):
1000, 925, 850, 775, 700, 600, 500, 400, 300, 250, 200, 150, 100, 70, 50, 30, 10.

(2) Metadata in Avizo:

There are 1460 time steps available (see time slider in the NetCDF-Control
Properties).

Min-Max values at the beginning are 221.787 and 313.941, over all time steps
193.649 and 331.441.

The grid is rectilinear.

Processing history, e.g. cdo commands used to produce this file: see in the
Parameter history in the NetCDF file module’s Data Parameter Editor.

Temperature data are given in Kelvin.

(3) Without Projection applied, the data is visualized in grid coordinates (192 x 96
grid points). As the ECHAM data was stored on a Gaussian grid (which approximates
to a cylindric equidistant grid in geographic coordinates), the Cylindric Equidistant
projection yields the same display as with no projection applied. For other grids such
as curvilinear grids, the difference is clearly visible.
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(4) The colormap temp2D.icol covers the temperatures over all time steps on the
earth’s surface. The colormap temp3D.icol shall map all time steps in 17 pressure
levels of troposphere and stratosphere, so that especially the Min value is much
lower.

Variable Farbmappe Global Data Window
Min Max

tsurf (2D dataset) temp2D.icol 193.649 331.441

t (3D dataset) temp3D.icol 170.174 326.664

(5) The trick is to first figure out how long the video should last when it is played
back. When a day should have the duration of one second, then 30 days (month of
June) will last for 30 seconds. If the video has a total length of 30 seconds and is
played back with 25 frames per second (= FrameRate): 25 * 30 = 750 Frames have
to be stored in the *.mpg file.

Avizo computes internally how to distribute the time steps to the frames exactly. For
a file with 3-hourly data, 8 time steps have to be distributed over 25 frames. So, the
data values always change after 3 (or 4) frames. If your dataset consists of 6-hourly
data, 4 time steps have to be distributed over 25 frames, so the values always
change after 6 (or 7) frames.
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8.2. Examples of data pre-processing

Open a new terminal on Mistral and change into the tutorial subdirectory containing
the pre-processing example files:
Iwork/kv0653/Tutorial_AvizoGreen/preprocessing

Example 1: Time unit, longitude range
According to chapter 2.2 type:
ncdump -c ex1l_relTime_lonRange.nc

This provides the following output (shortened at the end):

netcdf ex1l_relTime_lonRange {

dimensions:
lon = 192 ;
lat = 96 ;
lev = 17 ;
time = UNLIMITED ; // (124 currently)
variables:
double lon(lon) ;
lon:long_name = "longitude™ ;
lon:units = "degrees_east" ;
lon:standard_name = "longitude" ;
double lat(lat) ;
lat:long_name = "latitude" ;
lat:units = "'degrees_north" ;
lat:standard_name = "latitude" ;
double lev(lev) ;
lev:long_name = "‘pressure’ ;
lev:units = "Pa" ;

double time(time) ;
time:units = "day as %Y%mo%d.%F" ;
float t(time, lev, lat, lon) ;
t:long_name = "temperature" ;
tzunits = "K" ;
t:code = 130 ;
t:table = 128 ;
t:grid_type = "gaussian" ;

// global attributes:

:CDI = "Climate Data Interface version 1.2.1" ;

:Conventions = "CF-1.0" ;

history = "Wed Nov 26 09:57:42 2008: cdo seldate,2001-01-01,2001-01-
31 EH5_OM_A1B 1 _STP.nc EH5 _OM_A1B_1_STP_Jan.nc\n",

"Wed Nov 26 09:52:47 2008: cdo -f nc copy EH5_OM_A1B_1 STP.grb

EH5 OM_A1B_ 1 _STP.nc" ;

:source = "ECHAM5.2" ;

sinstitution = "Max-Planck-Institute for Meteorology" ;

:CDO = "Climate Data Operators version 1.2.1
(http://www.mpimet.mpg.de/cdo)" ;
data:

lon = 0, 1.875, 3.75, 5.625, 7.5, 9.375, 11.25, 13.125, 15, 16.875, 18.75,
20.625, 22.5, 24.375, 26.25, 28.125, 30, 31.875, 33.75, 35.625, 37.5,
39.375, 41.25, 43.125, 45, 46.875, 48.75, 50.625, 52.5, 54.375, 56.25,
58.125, 60, 61.875, 63.75, 65.625, 67.5, 69.375, 71.25, 73.125, 75,
76.875, 78.75, 80.625, 82.5, 84.375, 86.25, 88.125, 90, 91.875, 93.75,
95.625, 97.5, 99.375, 101.25, 103.125, 105, 106.875, 108.75, 110.625,
112.5, 114.375, 116.25, 118.125, 120, 121.875, 123.75, 125.625, 127.5,
129.375, 131.25, 133.125, 135, 136.875, 138.75, 140.625, 142.5, 44.375,
146.25, 148.125, 150, 151.875, 153.75, 155.625, 157.5, 159.375, 161.25,
163.125, 165, 166.875, 168.75, 170.625, 172.5, 174.375, 176.25, 78.125,
180, 181.875, 183.75, 185.625, 187.5, 189.375, 191.25, 193.125, 195,
196.875, 198.75, 200.625, 202.5, 204.375, 206.25, 208.125, 210, 11.875,
213.75, 215.625, 217.5, 219.375, 221.25, 223.125, 225, 226.875, 228.75,
230.625, 232.5, 234.375, 236.25, 238.125, 240, 241.875, 243.75, 45.625,
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247.5, 249.375, 251.25, 253.125, 255, 256.875, 258.75, 260.625, 262.5,
264.375, 266.25, 268.125, 270, 271.875, 273.75, 275.625, 277.5, 79.375,
281.25, 283.125, 285, 286.875, 288.75, 290.625, 292.5, 294_375, 296.25,
298.125, 300, 301.875, 303.75, 305.625, 307.5, 309.375, 311.25, 13.125,
315, 316.875, 318.75, 320.625, 322.5, 324.375, 326.25, 328.125, 330,
331.875, 333.75, 335.625, 337.5, 339.375, 341.25, 343.125, 345, 46.875,
348.75, 350.625, 352.5, 354.375, 356.25, 358.125 ;

lat = ..;

According to chapter 2.3 we’ll have to do two conversions:
a) Change the time format of the NetCDF file from absolute to relative time.
b) Change the value range of the longitudes from [0;360] to [-180;+180].

You can use cdo operator piping to do so:

cdo -r copy -selindexbox,97,96,1,96 ex1l relTime_lonRange.nc
avizol.nc
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Example 2: Hybrid levels

For the vertical axis of atmospheric models, Avizo supports height and pressure
levels. If the vertical axis of your data is described by hybrid model levels (terrain
following vertical coordinates at the bottom, pressure levels at the top, interpolated in
between), the data must be interpolated onto HEIGHT [m] or PRESSURE [Pa] levels
before reading it with Avizo. The number and values of those height or pressure
levels can be defined explicitly (plevels, hlevels). During this process you may
receive missing values (Grid cells with no data), e.g. in areas with mountains in case
of atmospheric data.

cdo mi2pl,plevels <inputfile> <outputfile>

cdo mi2hl ,hlevels <inputfile> <outputfile>
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Example 3: Ocean levels

Our third example file includes concentrations of phytoplankton, zooplankton and
nitrate in 24 ocean levels which have positive depths:

ncdump -c ex3_oceanLevels.nc

netcdf ex3_oceanLevels {
dimensions:
longitude = 88 ;
latitude = 82 ;
levels = 24 ;
time = UNLIMITED ; // (1 currently)

variables:

double longitude(longitude) ;
longitude:long_name = *Longitude’ ;
longitude:units = "degrees_east" ;
longitude:standard_name = "longitude™ ;

double latitude(latitude) ;
latitude:long_name = "Latitude" ;
latitude:units = "degrees_north" ;
latitude:standard_name = "latitude" ;

double levels(levels) ;
levels:long_name = "Level™ ;
levels:units = "meters" ;
levels:positive = "down™ ;

double time(time) ;
time:units = "days since 2004-01-01 00:00" ;

float phc(time, levels, latitude, longitude) ;
phc:long_name = "Phytoplankton' ;
phc:_FillValue = -9999.F ;

float zoc(time, levels, latitude, longitude) ;
zoc:long_name = "Zooplankton" ;
zoc:_Fillvalue = -9999.f ;

float n3n(time, levels, latitude, longitude) ;
n3n:long_name = "Nitrate" ;
n3n:_FillValue = -9999.F ;

// global attributes:

data:
longitude = ...
latitude = ...

levels = 10, 15, 20, 25, 30, 35, 40, 45, 50, 60, 75, 100, 150, 200, 300,
400, 500, 600, 700, 800, 1000, 2000, 3000, 4000 ;

time = 0 ;

}

According to the CD1.0 metadata convention [http://cf-pcmdi.linl.gov/documents/cf-
conventions/1.0/cf-conventions.pdf — page 14], the levels can have a positive sign
but will be interpreted as depths if the attribute “positive = "down™~ is added, as
we did in our example file ex3_oceanLevels.nc above.

axis_hame:units = "meters" ;
axis_name:positive = "'down' ;
Unfortunately, Avizo does not yet consider this in the current version, although it is

CF1.0 convention. Instead, we have to make sure that the ocean levels have
negative signs in order to visualize them below sea-surface.
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Open an editor (“gedit” for instance) and define a simple text file (here called
zaxis.txt) with a description of the new z-axis with negative height levels:

cat zaxis.txt

zaxistype = height
size = 24
levels = -10 -15 -20 -25 -30 -35 -40 -45 -50 -60 -75 -100

-150 -200 -300 -400 -500 -600 -700 -800 -1000 -2000 -3000
-4000

Then use the setzaxis command to assign this new z-axis to your ocean NetCDF file:

cdo setzaxis,zaxis.txt ex3_oceanLevels.nc avizo3.nc
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Example 4a/b: Time interpolation

You might look into the NetCDF files of this example with ncdump -c to view the time
variable data, but it is not very convenient to read. Time data is much easier to read
with cdo sinfo because all time steps are printed in “yyyy-MM-dd hh:mm” format,
then:

cdo sinfo ex4a_timelnt.nc

The last section of the output provides information on the time steps:

Time axis : 12 steps

RefTime = 1900-01-01 00:00 Units = days Calendar = STANDARD
YYYY-MM-DD hhzmm  YYYY-MM-DD hh:mm  YYYY-MM-DD hh:mm  YYYY-MM-DD hh:mm
2007-01-16 12:00 2007-02-15 00:00 2007-03-16 12:00 2007-04-16 00:00
2007-05-16 12:00 2007-06-16 00:00 2007-07-16 12:00 2007-08-16 12:00
2007-09-16 00:00 2007-10-16 12:00 2007-11-16 00:00 2007-12-16 12:00

The dataset obviously has 12 time steps with one time step for the mid of each
month in the year 2007. To smooth the animation we can interpolate on 10 time
steps per month with the following command:

cdo intntime,10 ex4a timelnt.nc avizoda.nc

The original times are preserved and 9 time steps are added between one time step
and the next. So, the output NetCDF file has 12 + 11*9 = 111 time steps. Note that
after the last original time step (mid of December), no further time steps are added:

cdo sinfo avizo4a.nc

Time axis : 111 steps
RefTime = 1900-01-01 00:00 Units = days Calendar = STANDARD

YYYY-MM-DD hhzmm  YYYY-MM-DD hh:mm  YYYY-MM-DD hh:mm  YYYY-MM-DD hh:mm
2007-01-16 12:00 2007-01-19 10:48 2007-01-22 09:36  2007-01-25 08:24
2007-01-28 07:12  2007-01-31 06:00 2007-02-03 04:48 2007-02-06 03:36
2007-02-09 02:24  2007-02-12 01:12 2007-02-15 00:00 2007-02-17 22:48
2007-02-20 21:36  2007-02-23 20:24  2007-02-26 19:12  2007-03-01 18:00
2007-03-04 16:48 2007-03-07 15:36  2007-03-10 14:24  2007-03-13 13:12
2007-03-16 12:00 2007-03-19 13:12 2007-03-22 14:24  2007-03-25 15:36
2007-03-28 16:48 2007-03-31 18:00 2007-04-03 19:12 2007-04-06 20:24
2007-04-09 21:36  2007-04-12 22:48 2007-04-16 00:00 2007-04-19 01:12
2007-04-22 02:24  2007-04-25 03:36  2007-04-28 04:48 2007-05-01 06:00
2007-05-04 07:12  2007-05-07 08:24  2007-05-10 09:36  2007-05-13 10:48
2007-05-16 12:00 2007-05-19 13:12 2007-05-22 14:24  2007-05-25 15:36
2007-05-28 16:48 2007-05-31 18:00 2007-06-03 19:12 2007-06-06 20:24
2007-06-09 21:36  2007-06-12 22:48 2007-06-16 00:00 2007-06-19 01:12
2007-06-22 02:24  2007-06-25 03:36 2007-06-28 04:48 2007-07-01 06:00
2007-07-04 07:12  2007-07-07 08:24  2007-07-10 09:36  2007-07-13 10:48
2007-07-16 12:00 2007-07-19 14:24  2007-07-22 16:48 2007-07-25 19:12
2007-07-28 21:36  2007-08-01 00:00 2007-08-04 02:24  2007-08-07 04:48
2007-08-10 07:12  2007-08-13 09:36 2007-08-16 12:00 2007-08-19 13:12
2007-08-22 14:24  2007-08-25 15:36 2007-08-28 16:48 2007-08-31 18:00
2007-09-03 19:12  2007-09-06 20:24  2007-09-09 21:36  2007-09-12 22:48
2007-09-16 00:00 2007-09-19 01:12 2007-09-22 02:24  2007-09-25 03:36
2007-09-28 04:48 2007-10-01 06:00 2007-10-04 07:12  2007-10-07 08:24
2007-10-10 09:36  2007-10-13 10:48 2007-10-16 12:00 2007-10-19 13:12
2007-10-22 14:24  2007-10-25 15:36  2007-10-28 16:48 2007-10-31 18:00
2007-11-03 19:12 2007-11-06 20:24  2007-11-09 21:36  2007-11-12 22:48
2007-11-16 00:00 2007-11-19 01:12 2007-11-22 02:24  2007-11-25 03:36
2007-11-28 04:48 2007-12-01 06:00 2007-12-04 07:12 2007-12-07 08:24
2007-12-10 09:36  2007-12-13 10:48 2007-12-16 12:00
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Remark: Technically, we could have used the operator inttime (instead of
intntime) as well to produce e.g. a daily dataset (cdo intntime,2007-01-
16,12:00,1day). But then we do not preserve the original time steps of all months.

Let's have a look at a second example. This time we have a 6-hourly dataset of
horizontal wind components u and v that we would like to interpolate to a 1-hourly
dataset.

cdo sinfo ex4b_timelnt.nc

Time axis : 124 steps
RefTime = 2001-01-01 00:00 Units = hours Calendar = STANDARD

YYYY-MM-DD hh:mm YYYY-MM-DD hh:mm YYYY-MM-DD hh:mm YYYY-MM-DD hh:mm
2001-01-01 00:00 2001-01-01 06:00 2001-01-01 12:00 2001-01-01 18:00
2001-01-02 00:00 2001-01-02 06:00 2001-01-02 12:00 2001-01-02 18:00
2001-01-03 00:00 2001-01-03 06:00 2001-01-03 12:00 2001-01-03 18:00
2001-01-04 00:00 2001-01-04 06:00 2001-01-04 12:00 2001-01-04 18:00
2001-01-05 00:00 2001-01-05 06:00 2001-01-05 12:00 2001-01-05 18:00
2001-01-06 00:00 2001-01-06 06:00 2001-01-06 12:00 2001-01-06 18:00
2001-01-07 00:00 2001-01-07 06:00 2001-01-07 12:00 2001-01-07 18:00
2001-01-08 00:00 2001-01-08 06:00 2001-01-08 12:00 2001-01-08 18:00
2001-01-09 00:00 2001-01-09 06:00 2001-01-09 12:00 2001-01-09 18:00
2001-01-10 00:00 2001-01-10 06:00 2001-01-10 12:00 2001-01-10 18:00
2001-01-11 00:00 2001-01-11 06:00 2001-01-11 12:00 2001-01-11 18:00
2001-01-12 00:00 2001-01-12 06:00 2001-01-12 12:00 2001-01-12 18:00
2001-01-13 00:00 2001-01-13 06:00 2001-01-13 12:00 2001-01-13 18:00
2001-01-14 00:00 2001-01-14 06:00 2001-01-14 12:00 2001-01-14 18:00
2001-01-15 00:00 2001-01-15 06:00 2001-01-15 12:00 2001-01-15 18:00
2001-01-16 00:00 2001-01-16 06:00 2001-01-16 12:00 2001-01-16 18:00
2001-01-17 00:00 2001-01-17 06:00 2001-01-17 12:00 2001-01-17 18:00
2001-01-18 00:00 2001-01-18 06:00 2001-01-18 12:00 2001-01-18 18:00
2001-01-19 00:00 2001-01-19 06:00 2001-01-19 12:00 2001-01-19 18:00
2001-01-20 00:00 2001-01-20 06:00 2001-01-20 12:00 2001-01-20 18:00
2001-01-21 00:00 2001-01-21 06:00 2001-01-21 12:00 2001-01-21 18:00
2001-01-22 00:00 2001-01-22 06:00 2001-01-22 12:00 2001-01-22 18:00
2001-01-23 00:00 2001-01-23 06:00 2001-01-23 12:00 2001-01-23 18:00
2001-01-24 00:00 2001-01-24 06:00 2001-01-24 12:00 2001-01-24 18:00
2001-01-25 00:00 2001-01-25 06:00 2001-01-25 12:00 2001-01-25 18:00
2001-01-26 00:00 2001-01-26 06:00 2001-01-26 12:00 2001-01-26 18:00
2001-01-27 00:00 2001-01-27 06:00 2001-01-27 12:00 2001-01-27 18:00
2001-01-28 00:00 2001-01-28 06:00 2001-01-28 12:00 2001-01-28 18:00
2001-01-29 00:00 2001-01-29 06:00 2001-01-29 12:00 2001-01-29 18:00
2001-01-30 00:00 2001-01-30 06:00 2001-01-30 12:00 2001-01-30 18:00
2001-01-31 00:00 2001-01-31 06:00 2001-01-31 12:00 2001-01-31 18:00

We can do the time interpolation in one of the following two ways (resulting in the
same output file):

cdo intntime,6 ex4b_timelnt.nc avizodb.nc

cdo inttime,2001-01-01,00:00,1lhour ex4b_timelnt.nc avizodb.nc
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Example 5: Horizontal grid interpolation onto the scalar grid

The NetCDF file ex5_vectorGrids.nc has a rectilinear grid with 1°x1° spatial
resolution. There are two longitudinal and two latitudinal dimensions defined (and two
depth dimensions which we will work on later — see example 6 for vertical grid
interpolation). The dimensions LONGITUDE_T and LATITUDE_T define the grid
center points — used for the scalar variable SALT for instance. The dimension
LONGITUDE_U is used for the u wind component defined at the left grid wall. The
dimension LATITUDE_V is used for the v wind component defined at the front grid
wall respectively.

ncdump -c ex5 vectorGrids.nc

netcdf ex5_vectorGrids {
dimensions:
LONGITUDE_T = 360 ;
LATITUDE_V = 160 ;
LATITUDE T = ;
LONGITUDE_U = 360 ;
DEPTH_T = 23 ;
DEPTH_W = 24 ;
variables:
double LONGITUDE_T(LONGITUDE_T) ;
LONGITUDE_T: Iong_name = "longitude™ ;
LONGITUDE_T:units = "degrees_east" ;
LONGITUDE_T:standard_name = "longitude" ;
double LATITUDE_V(LATITUDE_V)
LATITUDE_V: Iong_name = "latitude" ;
LATITUDE_V:units = "degrees_north" ;
LATITUDE_V:standard_name = “latitude" ;
double LATITUDE_T(LATITUDE_T)
LATITUDE_T: Iong_name = "latitude” ;
LATITUDE_T:units = “degrees_north" ;
LATITUDE_T:standard_name = “latitude" ;
double LONGITUDE_U(LONGITUDE_U) ;
LONGITUDE_U: Iong_name = "longitude” ;
LONGITUDE_U:units = "degrees_east" ;
LONGITUDE_U: standard name = "longitude" ;
double DEPTH_T(DEPTH T)
DEPTH_T:units = meters" N
double DEPTH_W(DEPTH W)
DEPTH W:units = “meters"” ;
float V(DEPTH_T, LATITUDE v, LONGITUDE 1) ;
V: Iong_name = "V VELOCITY" ;
Viunits = "m/sec” ;
V:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"™ ;
V:history = "From iter23"
V:_Fillvalue = -1_e+23f ;
float SALT(DEPTH_T, LATITUDE_T, LONGITUDE_T) ;
SALT: Iong_name = "SALINITY" ;
SALT:units = "PSU" ;
SALT: Iong_name mod "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE" ;
SALT:history = "From iter23"
SALT:_Fillvalue = -1_e+23F ;
float U(DEPTH_T, LATITUDE_T, LONGITUDE_U) ;
U:long_name = U VELOCITY" ;
U:units = "m/sec” ;
U:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE" ;
U:history = "From iter23"
U:_Fillvalue = -1_e+23F ;
float W(DEPTH_W, LATITUDE_T, LONGITUDE_T) ;
W:long_name = "W VELOCITY" ;
Wzunits = "m/sec” ;
W:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"™ ;
W:history = "From iter23"
W:_Fillvalue = -1_e+23f ;

// global attributes:

data:
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LONGITUDE
12.5,
24.5,
36.5,
48.5,
60.5,
72.5,
84.5,
96.5,
107.5,
117.5,
127.5,
137.5,
147.5,
157.5,
167.5,
177.5,
187.5,
197.5,
207.5,
217.5,
227.5,
237.5,
247.5,
257.5,
267.5,
277.5,
287.5,
297.5,
307.5,
317.5,
327.5,
337.5,
347.5,
357.5,

13.5,
25.5,
37.5,
49.5,
61.5,
73.5,
85.5,
97.5,

T=20

OCONOOUITWN O

98.5,
108.5, 109.5
118.5, 119.5
128.5,
138.5,
148.5,
158.5,
168.5,
178.5,
188.5,
198.5,
208.5,
218.5,
228.5,
238.5,
248.5,
258.5,
268.5,
278.5,
288.5,
298.5,
308.5,
318.5,
328.5,
338.5,
348.5,

358.5, 359.5

129

5.5, 6.5, 7.
18.5, 19.5,
30.5, 31.
42.5, 43.
54.5, 55.5,
66.5, 67.5,
78.5, 79.5,
90.5, 91.5,

5
S,
5
5

112.5, 113.5,
122.5, 123.5,
132.5, 133.5,
142.5, 143.5,
152.5, 153.5,
162.5, 163.5,
172.5, 173.5,
182.5, 183.5,
192.5, 193.5,
202.5, 203.5,
212.5, 213.5,
222.5, 223.5,
232.5, 233.5,
242.5, 243.5,
252.5, 253.5,
262.5, 263.5,
272.5, 273.5,
282.5, 283.5,
292.5, 293.5,
302.5, 303.5,
312.5, 313.5,
322.5, 323.5,
332.5, 333.5,
342.5, 343.5,
352.5, 353.5,

5
2
32.
44 .
5
6
8
9

, 8.5,
0.5, 21.5,
2.5, 33.5,
4.5, 45.5,
6.5, 57.5,
8.5, 69.5,
0.5, 81.5,
2.5, 93.5,

114.5, 115.5,
124.5, 125.5,
134.5, 135.5,
144 .5, 145.5,
154.5, 155.5,
164.5, 165.5,
174.5, 175.5,
184.5, 185.5,
194.5, 195.5,
204.5, 205.5,
214.5, 215.5,
2245, 225.5,
234.5, 235.5,
2445, 245.5,
254.5, 255.5,
264.5, 265.5,
274.5, 275.5,
284.5, 285.5,
294.5, 295.5,
304.5, 305.5,
314.5, 315.5,
324.5, 325.5,
334.5, 335.5,
3445, 345.5,
354.5, 355.5,

S,
S,
5,
S,
S,
S,
5,

23.5,
35.5,
47.5,
59.5,
71.5,
83.5,
95.5,
106.5
116.5,
126.5,
136.5,
146.5,
156.5,
166.5,
176.5,
186.5,
196.5,
206.5,
216.5,
226.5,
236.5,
246.5,
256.5,
266.5,
276.5,
286.5,
296.5,
306.5,
316.5,
326.5,
336.5,
346.5,
356.5,

9.5, 10.5, 11.5,
22.
34.
46.
58.
70.
82.
- 94.
5, 102.5, 103.5, 104.5, 105.5,

LATITUDE_V =
-68, -67,
-54, -53,
-40, -39,

-80,
-66,
-52,
-38,

-79,
-65,
-51,
-37,

-78,
-64,
-50,
-36,

=75,
-61,
-47,
-33,

-74,
-60,
-46,
-32,

-73,
-59,
-45,
-31, -30, -29, -28, -27,

-26, -25, -24, -23, -22, -19, -18, -17, -16, -15, -14, -13,

-12, -11, -10, -9, -8, —7 —6 -4, -3, —2 —1 o0, 1, 2, 3, 4 5, 6,
7, 8, 9, 10, 11 12 13 14 15 16 17 18 19 20 21, 22 23 24, 25
26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43,
44, 45, 46, 47, 48, 49, 50, 51, 52, 53, 54, 55, 56, 57, 58, 59, 60, 61,
62, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75, 76, 77, 78, 79

-72,
-58,
44,

-71,
-57,
-43,

-70,
-56,
-42,

-69,
-55,
-41,

LATITUDE_T = -79.5, -78.5, -77.5, -76.5, -75.5, -74.5, -73.5, -72.5, -71.5,
-70.5, -69.5, -68.5, -67.5, -66.5, -65.5, -64.5, -63.5, -62.5, -61.5,
-60.5, -59.5, -58.5, -57.5, -56.5, -55.5, -54.5, -53.5, -52.5, -51.5,
-50.5, -49.5, -48.5, -47.5, -46.5, -45.5, -44.5, -43.5, -42.5, -41.5,
-40.5, -39.5, -38.5, -37.5, -36.5, -35.5, -34.5, -33.5, -32.5, -31.5,
-30.5, -29.5, -28.5, -27.5, -26.5, -25.5, -24.5, -23.5, -22.5, -21.5,
-20.5, -19.5, -18.5, -17.5, -16.5, -15.5, -14.5, -13.5, -12.5, -11.5,
-10.5, -9.5, -8.5, -7.5, -6.5, -5.5, -4.5, -3.5, -2.5, -1.5, -0.5, 0.5,
1.5, 2.5, 3.5, 4.5, 5.5, 6.5, 7.5, 8.5, 9.5, 10.5, 11.5, 12.5, 13.5,
14.5, 15.5, 16.5, 17.5, 18.5, 19.5, 20.5, 21.5, 22.5, 23.5, 24.5, 25.5,
26.5, 27.5, 28.5, 29.5, 30.5, 31.5, 32.5, 33.5, 34.5, 35.5, 36.5, 37.5,
38.5, 39.5, 40.5, 41.5, 42.5, 43.5, 44.5, 45.5, 46.5, 47.5, 48.5, 49.5,
50.5, 51.5, 52.5, 53.5, 54.5, 55.5, 56.5, 57.5, 58.5, 59.5, 60.5, 61.5,
62.5, 63.5, 64.5, 65.5, 66.5, 67.5, 68.5, 69.5, 70.5, 71.5, 72.5, 73.5,
74.5, 75.5, 76.5, 77.5, 78.5, 79.5 ;

LONGITUDE U = 0O, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17,

, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35,
36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52, 53,
54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69, 70, 71,
72, 73, 74, 75, 76, 77, 78, 79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89,
90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100, 101, 102, 103, 104, 105,
106, 107, 108, 109, 110, 111, 112, 113, 114, 115, 116, 117, 118, 119,
120, 121, 122, 123, 124, 125, 126, 127, 128, 129, 130, 131, 132, 133,
134, 135, 136, 137, 138, 139, 140, 141, 142, 143, 144, 145, 146, 147,
148, 149, 150, 151, 152, 153, 154, 155, 156, 157, 158, 159, 160, 161,
162, 163, 164, 165, 166, 167, 168, 169, 170, 171, 172, 173, 174, 175,
ive6, 177, 178, 179, 180, 181, 182, 183, 184, 185, 186, 187, 188, 189,
190, 191, 192, 193, 194, 195, 196, 197, 198, 199, 200, 201, 202, 203,
204, 205, 206, 207, 208, 209, 210, 211, 212, 213, 214, 215, 216, 217,
218, 219, 220, 221, 222, 223, 224, 225, 226, 227, 228, 229, 230, 231,
232, 233, 234, 235, 236, 237, 238, 239, 240, 241, 242, 243, 244, 245,
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246, 247, 248, 249, 250, 251, 252, 253, 254, 255, 256, 257, 258, 259,
260, 261, 262, 263, 264, 265, 266, 267, 268, 269, 270, 271, 272, 273,
274, 275, 276, 277, 278, 279, 280, 281, 282, 283, 284, 285, 286, 287,
288, 289, 290, 291, 292, 293, 294, 295, 296, 297, 298, 299, 300, 301,
302, 303, 304, 305, 306, 307, 308, 309, 310, 311, 312, 313, 314, 315,
316, 317, 318, 319, 320, 321, 322, 323, 324, 325, 326, 327, 328, 329,
330, 331, 332, 333, 334, 335, 336, 337, 338, 339, 340, 341, 342, 343,
344, 345, 346, 347, 348, 349, 350, 351, 352, 353, 354, 355, 356, 357,
358, 359 ;

DEPTH_T = 5, 15, 27.5, 45, 65, 87.5, 117.5, 160, 222.5, 310, 435, 610,
847.5, 1160, 1542.5, 1975, 2450, 2950, 3450, 3950, 4450, 4950, 5450 ;

DEPTH_W = 0, 10, 20, 35, 55, 75, 100, 135, 185, 260, 360, 510, 710, 985,
1335, 1750, 2200, 2700, 3200, 3700, 4200, 4700, 5200, 5700 ;
}

To interpolate U and V onto the scalar grid you might first extract the variable SALT
to use this separate NetCDF file as a grid description file:

cdo selname,SALT ex5 vectorGrids.nc SALT.nc

cdo remapbil,SALT.nc ex5 vectorGrids.nc scalarGrid_UV.nc

ncdump -h scalarGrid_UV.nc shows the result:

netcdf scalarGrid_UV {
dimensions:
LONGITUDE_T = 360 ;
LATITUDE_T = 160 ;
DEPTH_T = 23 ;
DEPTH_W = 24 ;
variables:
double LONGITUDE_T(LONGITUDE_T) ;
LONGITUDE_T:standard_| name = "longitude™ ;
LONGITUDE_T: long_ name = Iongitude"
LONGITUDE_T: unlts = degrees_east" ;
LONGITUDE_T:axis = "X"
double LATITUDE_T(LATITUDE_ T)
LATITUDE_T:standard_ name = "latitude"
LATITUDE_T: Iong name = "latitude" ;
LATITUDE_T: unlts = "degrees_north"
LATITUDE_T:axis = "Y' ;
double DEPTH_T(DEPTH T)
DEPTH_T: unlts = meters" N
DEPTH T:axis = "Z"
double DEPTH_ _W(DEPTH W)
DEPTH_W: unlts = meters
DEPTH W:axis = "Z"
float V(DEPTH_T, LATITUDE T LONGITUDE_T) ;
V: Iong_name = "V VELOCITY" ;
V:units = "m/sec" ;
V:_Fillvalue = -1._.e+23f ;
V:missing_value = -1.e+23f ;
V:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"™ ;
V:history = "From iter23" ;
float SALT(DEPTH_T, LATITUDE_T, LONGITUDE_T) ;
SALT:long_name = "SALINITY" ;
SALT:units = "PSU" ;
SALT:_Fillvalue = -1.e+23F ;
SALT:missing_value = -1_e+23F ;
SALT:Iong_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"
SALT:history = "From iter23" ;
float U(DEPTH T, LATITUDE T, LONGITUDE_T) ;
Iong_name = U VELOCITY" ;

Uzunits = "m/sec" ;
U:_Fillvalue = -1_e+23F ;
U:missing_value = -1.e+23F ;

U:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE" ;
U:history = "From iter23" ;
float W(DEPTH_W, LATITUDE_T, LONGITUDE_T) ;
W:long_name = "W VELOCITY" ;
W:zunits = "m/sec" ;

Avizo Green 9.0.1 — Tutorial V2.0 DKRZ / CIiSAP Climate Visualization Lab



131

W:_Fillvalue = -1._.e+23f ;

W:missing_value = -1.e+23f ;

W:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"™ ;
W:history = "From iter23" ;
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Example 6: Vertical level interpolation

The example NetCDF file here is the result of the section with example 5 where we
did the horizontal grid interpolation. The file still has two depth dimensions:
DEPTH_T for the cell centers of the scalar variables and DEPTH_W for bottom cell
wall where the vector component W is originally defined.

ncdump -c ex6_vertint.nc (shortened output listed)

netcdf ex6_vertint {
dimensions:
LONGITUDE_T = 360 ;

LATITUDE_T = 160 ;

DEPTH T = 23 ;
DEPTH W = 24 ;
variables:

double LONGITUDE_T(LONGITUDE_T) ;
LONGITUDE_T: long_name = "longitude" ;
LONGITUDE_T:units = "degrees_east" ;
LONGITUDE_T:standard_name = "longitude" ;
double LATITUDE_T(LATITUDE_T) ;
LATITUDE_T:long_name = "latitude” ;
LATITUDE_T:units = "degrees_north" ;
LATITUDE_T:standard_name = "latitude" ;
double DEPTH_T(DEPTH_T) ;
DEPTH_T:units = "meters" ;
double DEPTH_W(DEPTH_W) ;
DEPTH_W:units = "meters" ;
float V(DEPTH_T, LATITUDE_T, LONGITUDE T) ;
V:long_name = "V VELOCITY" ;
V:zunits = "m/sec" ;
V:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE" ;
V:history = "From iter23" ;
V:_Fillvalue = -1.e+23f ;
float SALT(DEPTH_T, LATITUDE_T, LONGITUDE_T) ;
SALT:long_name = "SALINITY" ;
SALT:units = "PSU" ;
SALT:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE" ;
SALT:history = "From iter23" ;
SALT:_Fillvalue = -1.e+23F ;
float U(DEPTH_T, LATITUDE_T, LONGITUDE_T) ;
U:long_name = "U VELOCITY" ;
Uzunits = "m/sec"” ;
U:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"
Uzhistory = "From iter23" ;
U:_Fillvalue = -1.e+23F ;
float W(DEPTH_W, LATITUDE_T, LONGITUDE_T) ;
W:long_name = "W VELOCITY" ;
Wzunits = "m/sec" ;
W:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"
W:history = "From iter23" ;
W:_Fillvalue = -1.e+23f ;

// global attributes:

data:

DEPTH_T = 5, 15, 27.5, 45, 65, 87.5, 117.5, 160, 222.5, 310, 435, 610,
847.5, 1160, 1542.5, 1975, 2450, 2950, 3450, 3950, 4450, 4950, 5450 ;

DEPTH_W = 0, 10, 20, 35, 55, 75, 100, 135, 185, 260, 360, 510, 710, 985,
1335, 1750, 2200, 2700, 3200, 3700, 4200, 4700, 5200, 5700 ;
}

Avizo Green 9.0.1 — Tutorial V2.0 DKRZ / CIiSAP Climate Visualization Lab



133

- Step 1: To interpolate the vertical velocity W onto the cell centers you will have to
list the DEPTH_T levels together with the intlevel command, applied only to variable
W:

cdo intlevel,5,15,27.5,45,65,87.5,117.5,160,222.5,310,435,610,
847.5,1160,1542_.5,1975,2450,2950, 3450,3950,4450,4950,5450 —selvar,W
ex6_vertint.nc out6.nc

ncdump —c out6.nc (shortened output listed)

netcdf out6 {
dimensions:
LONGITUDE_T = 360 ;
LATITUDE_T = 160 ;
DEPTH_W = 23 ;
variables:
double LONGITUDE_T(LONGITUDE_T) ;
LONGITUDE_T:standard_| name = "longitude"
LONGITUDE_T: long_ name = Iongitude"
LONGITUDE_T: unlts = "degrees_east"
LONGITUDE_T:axis = "X"
double LATITUDE T(LATITUDE_ T)
LATITUDE_T:standard name = "latitude”
LATITUDE_T: Iong_name = Iatltude"
LATITUDE_T: unlts = "degrees_north"
LATITUDE T:axis = "Y" ;
double DEPTH_W(DEPTH_W) ;
DEPTH_W: Iong_name = "generic"”
DEPTH_W: unlts = meters"
DEPTH_W:axis = "Z"
float W(DEPTH_W, LATITUDE T LONGITUDE_T) ;
W: Iong_name = "W VELOCITY" ;

W:units = "m/sec" ;
W:_Fillvalue = -1._e+23f ;
W:missing_value = -1.e+23f ;

W:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"
W:history = "From iter23"

// global attributes:

data:

DEPTH_W = 5, 15, 27.5, 45, 65, 87.5, 117.5, 160, 222.5, 310, 435, 610,
847.5, 1160, 1542.5, 1975, 2450, 2950, 3450, 3950, 4450, 4950, 5450 ;
}

- Step 2: Since intlevel results in a dimension that is still called “DEPTH_W” with the
attribute long_name = ,generic”, we have to adjust these to our demands. This can
be done with the help of the ncrename (-d to rename dimensions or —v to rename
variables) and ncatted —a (attribute editor to add, delete or modify attribute values)
commands of the NetCDF Operators (nco), which can be used after typing module
load nco in the console:

ncrename -d DEPTH_W,DEPTH_T out6.nc
ncrename -v DEPTH_W,DEPTH T out6.nc

ncatted -a long_name,DEPTH_T,m,c,height™ out6.nc
ncatted -a standard_name,DEPTH_T,c,c,height™ out6.nc

-> Step 3: Finally, we can merge the new variable W of the file out6.nc with the other
variables of our original input file ex6_vertint.nc (reduced by the old W variable
version). For this purpose we extract variables U, SALT and V and write them to a
new file noW.nc using the CDO command selvar:
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cdo selvar,U,SALT,V ex6_vertlnt.nc noW.nc

Using ncdump on data files out6.nc and noW.nc we find that the attributes of
DEPTH_T are not yet identical. To merge the data files successfully, we need to
apply the following ncatted commands to noW.nc:

ncatted -a long_name,DEPTH T,c,c,"height’™ noW.nc
ncatted -a standard_name,DEPTH T,c,c,height™ noW.nc

To merge the files, then type:

cdo merge noW.nc out6.nc out6_final.nc

ncdump -c out6_final.nc yields (output shortened):

netcdf out6_final {
dimensions:
LONGITUDE_T = 360 ;
LATITUDE_T = 160 ;
DEPTH_T = 23 ;
variables:
double LONGITUDE_T(LONGITUDE_T) ;
LONGITUDE_T:standard name = "longitude"
LONGITUDE_T: Iong_name = "longitude™ ;
LONGITUDE_T: unlts = degrees_east" ;
LONGITUDE_T:axis = "X"
double LATITUDE_ T(LATITUDE_ T)
LATITUDE_T:standard_ name = "latitude" ;
LATITUDE_T:long_ name = "latitude"”
LATITUDE T:units = "“degrees_north" ;
LATITUDE_T:axis = "Y' ;
double DEPTH_T(DEPTH_T) ;
DEPTH_T:standard name = "height"
DEPTH_T: Iong_name = "height" ;
DEPTH_T:units = "meters"”
DEPTH_T: pOS|t|ve = "up" ;
DEPTH T:axis = "Z"
float V(DEPTH T, LATITUDE T LONGITUDE_T) ;
Iong_name = "V VELOCITY" ;

V:units = "m/sec" ;
V:_Fillvalue = -1.e+23f ;
V:missing_value = -1_e+23f ;

V:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"
V:history = "From iter23" ;
float SALT(DEPTH_T, LATITUDE_T, LONGITUDE_T)
SALT:long_name = "SALINITY" ;
SALT:units = "PSU" ;
SALT:_Fillvalue = -1_e+23F ;
SALT:missing_value = -1.e+23F ;
SALT:Iong_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE" ;
SALT:history = "From iter23" ;
float U(DEPTH T, LATITUDE T, LONGITUDE_T) ;
Iong_name = U VELOCITY"

U:units = "m/sec" ;
U:_Fillvalue = -1.e+23F ;
U:missing_value = -1_e+23F ;

U:Iong_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"
Uzhistory = "From iter23" ;
float W(DEPTH_T, LATITUDE T, LONGITUDE_T) ;
W: Iong_name = "W VELOCITY" ;
W:units = "m/sec" ;
W:_Fillvalue = -1._.e+23f ;
W:missing_value = -1.e+23f ;
W:long_name_mod = "T=01-JAN-1952 05:45:31-DEC-2001 17:45@AVE"™ ;
W:history = "From iter23"

// global attributes:

:CDI = "Climate Data Interface version 1.7.0
(http://mpimet.mpg.de/cdi)"
:Conventions = "CF-1.0" ;

history = "Mon Feb 06 14:57:11 2017: cdo merge noW.nc out6.nc
out6_final .nc\n",
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"Mon Feb 6 14:55:02 2017: ncatted -a
standard_name,DEPTH_T,c,c,height out6.nc\n",

“"Mon Feb 6 14:48:35 2017: ncatted -a
standard_name,DEPTH_T,m,c,height out6.nc\n",

“"Mon Feb 6 14:48:23 2017: ncatted -a
long_name,DEPTH_T,m,c,height out6.nc\n",

"Mon Feb 6 14:48:01 2017: ncrename -v DEPTH_W,DEPTH_T
out6.nc\n",

"Mon Feb 6 14:47:53 2017: ncrename -d DEPTH_W,DEPTH_T
out6.nc\n",

"Mon Feb 06 14:44:08 2017: cdo
intlevel,5,15,27.5,45,65,87.5,117.5,160,222.5,310,435,610,847.5,1160,1542.5,1975,24
50,2950, 3450,3950,4450,4950,5450 -selvar,W scalargrid_UV.nc out6.nc\n",

"Mon Feb 06 13:46:41 2017: cdo remapbil ,SALT.nc
/work/kv0653/Tutorial_AvizoGreen/preprocessing/ex5_vectorGrids.nc
scalargrid_UV.nc\n",

"Wed Nov 26 17:10:56 2008: cdo selname,U,V,W,SALT iter23m.cdf
../Tutorial_AvizoGreenPack/preprocessing/example5b.nc\n",

"FERRET V5.70 19-Dec-05" ;

:CDO = "Climate Data Operators version 1.7.0
(http://mpimet._mpg.de/cdo)" ;
data:

DEPTH_T = 5, 15, 27.5, 45, 65, 87.5, 117.5, 160, 222.5, 310, 435, 610,
847.5, 1160, 1542.5, 1975, 2450, 2950, 3450, 3950, 4450, 4950, 5450 ;
}

-> Step 4: The longitudes of this data set range from 0 to 360°. In order to visualize
the data in Avizo, we need longitudes ranging from -180 to 180°:

cdo selindexbox,181,180,1,160 out6_ final.nc out6_final 180.nc
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Example 7: MPI-OM workflow including scalar grid interpolation and
grid rotation

We use the MPI-OM ocean model to show the whole workflow of vertical and
horizontal grid interpolation to the scalar grid and grid rotation. The input NetCDF file
is called ex7_mpiom_grl5.nc.

The vector components and scalar variables are all stored with the same fictive lon /
lat values. For visualization and previous transformations we need the MPI-OM
GR15 grid definitions that can be found in two different longitudinal ranges in the
following folders:

a) longitude range [0°;360°] in
/pool/data/MP10M/GR15

b) longitude range [-180°;+180°] in the /preprocessing tutorial subfolder.

In each folder you'll find the following three grid definitions:

GR15u.nc Grid of zonal vector component
GR15v.nc Grid of meridional vector component
GR15s.nc Grid of scalar variables (cell centre points)

- Step 1: Interpolation of vertical velocity WO

Select the variable WO and set all missing values to 0.0 (land areas
in each level).

cdo selvar,W0 -setmisstoc,0.0 ex7_mpiom_grl5.nc grl5 WO.nc

Perform vertical interpolation to the scalar levels (on which the horizontal vector
components u and v are defined, too).

cdo intlevel,6,17,27,37,47,57,69,83,100,123,150,183,220,263,
310,363,420,485,560,645,740,845,960,1085,1220,1365,1525,1700,
1885,2080,2290,2525,2785,3070,3395,3770,4195,4670,5170,5720
grl5 WO.nc grl5 WO _s.nc

Assign scalar grid in longitude range [-180°;+180°] contained in the /preprocessing
subfolder, since this is necessary for visualization with Avizo.

cdo setgrid,GR15s.nc -setmisstoc,0.0 grl5 WO_s.nc grl5 WO _sG.nc

- Step 2: Interpolation of horizontal velocities UKO, VKE and grid rotation

Select the zonal vector component UKO and the meridional vector component VKE
each with its individual grid. Grid longitude range [0°;360°] is used because the finally
piped operator mrotuvb only works with these longitudes. The operator mrotuvb
does the horizontal interpolation as well as the rotation. The output NetCDF file
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ukovke nswe.nc contains both variables, UKO and VKE, both in North-South-West-
East (_nswe) coordinates.

cdo mrotuvb -setgrid,/pool/data/MPIOM/GR15/GR15u.nc
-selvar ,UKO ex7_mpiom _grl5.nc

-setgrid, /pool/data/MP10M/GR15/GR15v.nc

-selvar,VKE ex7_mpiom_grl5.nc ukovke nswe.nc

For visualization with Avizo we need the longitude range [-180°;+180°] again.

cdo setgrid,GR15s.nc -setmisstoc,0.0 ukovke nswe.nc ukovke_nsweG.nc

- Step 3: Scalar mask creation

Due to the interpolation processes, we have “lost” the top data level in step 1 as well
as data lines along the ocean-land mask in step 2. These “lost” ocean cells have
been set to 0.0 like all other land-missing values. To localize the original land-missing
values and to be able to reset their 0.0 values to missing values we have to create a
scalar mask. The zeros in the “lost” ocean cells we maintained then, since we need
the same missing value mask for all three vector components in Avizo. We could
build a mask of the lowest common grid of the three vector components. But instead
we prefer to use a scalar mask to be able to colorize the vector arrows, streamlines,
or trajectories with a second scalar variable in Avizo. To colorize the vector with an
additional scalar variable, all vector components and the scalar variable have to have
the very same missing value mask — which should then be the scalar mask.

To create this mask, we first select the very first time step from our input NetCDF file
ex7_mpiom_gril5.nc. Secondly, we select a scalar variable - we use SAO (salinity)
here because it does not have any values of 0.0. Thirdly, we define the scalar grid in
longitude range [-180°;+180°], which is needed for visualization in Avizo. Fourthly
and fifthly, we set this scalar grid file to 1.0 for all cells with a non-missing value and
to 0.0 for all cells with a missing value. Finally, we rename the variable from SAO to
mask_s.

cdo setname,mask_s -setmisstoc,0.0 -ifthenc,l1. -setgrid,GR15s.nc
-selvar,SAO -seltimestep,l ex7_mpiom_grl5.nc GR15 MASK S.nc

- Step 4: Mask application on UKO, VKE, WO

The mask, as created in step 3, is now used on the variables UKO and VKE, in their
results of step 2, and WO, in the result of step 1. The results of steps 1 and 2 are
kept unchanged for all scalar cells (mask = 1.0) and are set to missing for all “non-
scalar” cells (mask = 0.0).

cdo ifthen GR15 MASK S.nc -selvar,UKO ukovke nsweG.nc
grl5_UKO_ROT_SPV.nc

cdo ifthen GR15 MASK S.nc -selvar,VKE ukovke nsweG.nc
grl5 VKE_ROT_SPV.nc

cdo ifthen GR15 MASK S.nc grl5 WO sG.nc grl5 WO sG_SPV.nc
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-> Step 5: Merging of UKO, VKE, WO
cdo -r merge grl5 UKO_ROT_SPV.nc grl5_VKE_ROT_SPV.nc
grl5 WO _sG_SPV.nc grl5 uvw _vis.nc

-> Step 6: Inverting the z-axis for ocean data

Avizo interprets positive height or depth values as height above sea level. To
visualize ocean data, we therefore need to invert the z axis using the following
command.

cdo —r setzaxis,zaxis DepthNeg.txt grl5 uvw vis.nc
grl5 uvw_vis_zax.nc

with zaxis_DepthNeg.txt containing

#

# zaxislD O

#

zaxistype : depth below sea

size 40

name > depth

longname : depth below sea level

units Im

levels > -6. -17. -27. -37. -47. -57. -69. -83. -100. -123. -150.

-183. -220. -263. -310. -363.

-420. -485. -560. -645. -740. -845. -960. -1085. -1220.
-1365. -1525. -1700. -1885.

-2080. -2290. -2525. -2785. -3070. -3395. -3770. -4195.
-4670. -5170. -5720.

In Avizo, this data can, e.g., be visualized as llluminated Streamlines. - You might be

interested in seeding streamlines only in regions of high current speed by extracting
a seed surface from a current speed isosurface.

- Step 7: Interpolation to a regular grid (optional)

Some Avizo visualization modules such as Surface LIC do not work on curvilinear
grids. If you are planning to use these, you need to interpolate the data to a regular
grid in longitude range [-180°;+180°]. Please note that the Vectors Slice module is a
bit buggy with regard to this data and is not recommendable here.

To prevent cdo remapbil from producing artifacts with missing values, you need to
set the environment variable REMAP_EXTRAPOLATE to on. Depending on the shell
you are using, type

export REMAP_EXTRAPOLATE=0n (for bash)

or

setenv REMAP_EXTRAPOLATE on (for csh, tcsh)

before you do the remapping.
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cdo remapbil,r360x180 grl5 uvw_vis_zax.nc grl5 uvw_vis_r360_zax.nc

cdo setmisstoc,0.0 grl5 uvw_vis r360 zax.nc
grl5 uvw vis_r360_spv_zax.nc

cdo selindexbox,181,180,1,180 grl5 uvw_vis_r360_spv_zax.nc
grl5 uvw_vis_r360_spvl_zax.nc
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Example 8: Vertical velocity units

In this example the vertical velocity is given in Pa/s, but we need it in m/s to load u, v
and w with the same units as a 3D vector into Avizo.

ncdump -h ex8 wuUnit.nc

netcdf ex8_wuUnit {

dimensions:
lon = 192 ;
lat = 96 ;
lev = 17 ;
time = UNLIMITED ; // (124 currently)
variables:
double lon(lon) ;
lon:long_name = "longitude" ;
lon:units = "degrees_east" ;
lon:standard_name = "longitude" ;
double lat(lat) ;
lat:long_name = "latitude" ;
lat:units = "'degrees_north" ;
lat:standard_name = "latitude" ;
double lev(lev) ;
lev:long_name = "‘pressure’ ;
lev:units = "Pa" ;

double time(time) ;
time:units = "hours since 2001-01-01 00:00" ;
float aps(time, lat, lon) ;
aps:long_name = "surface pressure" ;
aps:units = "Pa" ;
aps:code = 134 ;
aps:table = 128 ;

aps:grid_type = "gaussian" ;

float q(time, lev, lat, lon) ;
g:long_name = "specific humidity" ;
gq:units = "kg/kg" ;
g:code = 133 ;

q:table = 128 ;
q:grid_type = "‘gaussian’ ;
float t(time, lev, lat, lon) ;

t:long_name = "temperature' ;
tiunits = "K" ;
t:code = 130 ;

t:table = 128 ;
t:grid_type = "‘gaussian’ ;
float u(time, lev, lat, lon) ;
u:long_name = "u-velocity" ;
utunits = "m/s" ;
u:code = 131 ;
u:table = 128 ;
u:grid_type = "gaussian' ;
float v(time, lev, lat, lon) ;
:long_name = "v-velocity" ;
units = "m/s" ;
:code = 132 ;
stable = 128 ;
sgrid_type = "‘gaussian’ ;
float omega(time, lev, lat, lon)
omega: long_name = "vertical velocity" ;
omega:units = "Pa/s" ;
omega:code = 135 ;
omega:table = 128 ;
omega:grid_type = "gaussian’ ;

<<<<<

// global attributes: --- 3}

We can use the cdo operator vertwind to convert the vertical velocity omega (in Pa/s)
into the vertical velocity W (in m/s). All variables which are necessary for this
conversion (t, g, asp, omega) are already included in ex8_wUnit.nc and have the
correct units and code numbers.
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Note that the operator vertwind needs these exact code numbers as attributes. If
your data set doesn’t have any code attributes you can include them with the help of
the attribute editor of the NetCDF operators (nco) in advance (ncatted —a code, ...),
see link in chapter 2.1).

cdo vertwind ex8 wUnit.nc W_mps.nc

Finally, you can merge the variable W with the original dataset because you need all
the wind components in the same NetCDF file in order to load the wind as a 3D
vector into Avizo:

cdo merge ex8_wUnit.nc W_mps.nc avizo8.nc
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Example 9: Horizontal grid interpolation to a rectilinear grid

The NetCDF file of this example has a curvilinear grid (dimensions x and y, variables
lon and lat providing the transformation from x/y to lon/lat) with wind stress tau vector
components from the MITgcm model.

ncdump -h ex9_curvGrid.nc

netcdf ex9 _curvGrid {

dimensions:
X = 750 ;
y = 864 ;
nv = 4 ;
time = UNLIMITED ; // (10 currently)
variables:
double lon(y, x) ;
lon:long_name = "longitude™ ;
lon:units = "degrees" ;
lon:standard_name = "grid_longitude" ;
lon:bounds = "lon_bounds" ;

double lon_bounds(y, X, nv) ;
double lat(y, X) ;

lat:long_name = "latitude" ;
lat:units = "degrees" ;
lat:standard_name = "grid_latitude" ;
lat:bounds = "lat_bounds" ;

double lat_bounds(y, X, nv) ;
double time(time) ;
time:units = "days since 1901-01-15 00:00" ;
float TAUX(time, y, X) ;
TAUX:long_name = ""zonal wind stress" ;
TAUX:coordinates = "lon lat" ;
TAUX:history = "From data8" ;
TAUX:_FillValue = -1.e+34f ;
float TAUY(time, vy, X) ;
TAUY:long_name = "meridional wind stress" ;
TAUY:coordinates = "lon lat" ;
TAUY:history = "From data8" ;
TAUY:_FillvValue = -1.e+34f ;

This curvilinear grid shall be interpolated onto a rectilinear grid (0.25° x 0.25° spatial
resolution = 1440 x 720 grid cells) in order to be able to use the full capacities of the
Avizo Green:

cdo remapbil,rl440x720 ex9 curvGrid.nc rectiGrid.nc

For proper visualization in Avizo, be sure to set missing values to zero using the
commands cdo setmisstoc and to change the longitude range to = 180°using cdo
selindexbox.
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8.3. Listing of Tutorial Projects

Chapter Filename of Avizo Project Filename of exported Video
/work/kv0653/Tutorial_AvizoGreen/ /work/kv0653/Tutorial_AvizoGreen/videos/...

3 TUT_GettingStarted.hx

4.3 TUT_temp_2D.hx

45 TUT_temp_layout_2D.hx

4.7 TUT_temp_prec_2D.hx

4.8 TUT_temp_slp_2D.hx

4.9 TUT_temp_slp_Earth_2D.hx

411 TUT_current_Embossed_Slice_2D.hx mov_current_Embossed_Slice_2D.mpg

412 TUT_MITgem_Height_Map_Slice.hx

4.13 TUT_temp_movSlice_3D.hx

4.16 TUT_windspeed_3Slices_3D.hx

417 TUT_relhum_lsosurface_3D.hx

4.18 TUT_relhum_Isosurface_ColorTemp_3D.hx

4.19 TUT_windspeed_IsosurfNest_3D.hx

4.20 TUT_windspeed_Annolsocontour_3D.hx

421 TUT_relhum_volren_3D.hx

51 TUT_temp_slp_uv_2D.hx
TUT_temp_slp_uvCol_2D.hx

5.2 TUT_slp_lIsocontour_Slice_LIC.hx

5.3 TUT_LIC_windmag_2D.hx

5.4 TUT_LIC_slp_2D.hx V_LIC_slp.mpg

6.1 TUT_vectorArrows_3D.hx V_vectorArrows.mpg

6.2 TUT_streamlines_3D.hx

6.3 TUT_streamlines_SeedSurface_3D.hx V_streamlineSeedSurface_25ts.mpg

6.4 TUT_trajectories_3D.hx V_trajectories.mpg
TUT_trajectories_3D_Trj.hx

7.1 AnimProd_temp_prec_2D.hx prec_temp_2D.mpg

7.2 AnimProd_current_Embossed_Slice_2D.hx AnimProd_current_Embossed_Slice_2D.mpg

7.3 AnimProd_windspeed_3Slices_3D.hx V_windspeeds.mpg

mov_windspeed_3Slices_3D.mpg
7.4 AnimProd_streamlines_SeedSurface_3D.hx V_streamlineSeedSurface_25ts.mpg

In the videos folder you will find further interesting videos that were produced with the
Avizo Animation Director and Movie Maker (and some have been post-processed
with Adobe Premiere Pro, a powerful video editing software).
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